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Safety Guidelines

> PP

This manual contains notices you have to observe in order to ensure your personal safety, as well as to
prevent damage to property. The notices referring to your personal safety are highlighted in the manual
by a safety alert symbol, notices referring to property damage only have no safety alert symbol. The
notices shown below are graded according to the degree of danger.

Danger
indicates that death or severe personal injury will result if proper precautions are not taken.

Warning

indicates that death or severe personal injury may result if proper precautions are not taken.

Caution
with a safety alert symbol indicates that minor personal injury can result if proper precautions are not
taken.

Caution
without a safety alert symbol indicates that property damage can result if proper precautions are not
taken.

Notice
indicates that an unintended result or situation can occur if the corresponding notice is not taken into
account.

If more than one degree of danger is present, the warning notice representing the highest degree of
danger will be used. A notice warning of injury to persons with a safety alert symbol may also include a
warning relating to property damage.

Qualified Personnel

The device/system may only be set up and used in conjunction with this documentation. Commissioning
and operation of a device/system may only be performed by qualified personnel. Within the context of
the safety notices in this documentation qualified persons are defined as persons who are authorized to
commission, ground and label devices, systems and circuits in accordance with established safety
practices and standards.

Prescribed Usage

/N

Trademarks

Note the following:

Warning

This device and its components may only be used for the applications described in the catalog or the
technical description, and only in connection with devices or components from other manufacturers
which have been approved or recommended by Siemens.

Correct, reliable operation of the product requires proper transport, storage, positioning and assembly
as well as careful operation and maintenance.

All names identified by ® are registered trademarks of the Siemens AG.
The remaining trademarks in this publication may be trademarks whose use by third parties for their
own purposes could violate the rights of the owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and
software described. Since variance cannot be precluded entirely, we cannot guarantee full consistency.
However, the information in this publication is reviewed regularly and any necessary corrections are
included in subsequent editions.
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Preface

Purpose of the Manual
This manual describes the vision sensors SIMATIC VS 130-2 and
VS 130-2vcr. It helps to install, commission and operate the sensors.

The documentation addresses personnel concerned with the engineering,
commissioning and service of automation systems and visualization equipment.

Guide

The manual contains the following guides which provide quick access to the
specific information you need:

e The manual opens with a complete directory.

e The manual closes with a detailed index for quick access to the information
you require.

Further information

An installation and wiring manual is included in paper form.

On your CD you will find the "Getting Started" guide for initial commissioning of
your SIMATIC VS 130-2 or VS 130-2vcr vision sensor.

Further support

If you have any questions concerning the use of products which are not answered
in this manual, please contact your local Siemens partner at your Siemens office.

You can find your local partner at:

http://www.siemens.com/automation/partner

You can find a guide to the technical documentation on offer for the individual
SIMATIC products and systems at:

http://www.siemens.de/simatic-tech-doku-portal

You can find the catalog and online ordering systems at:

http://mall.automation.siemens.com/

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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Training center
To help you to learn about the vision sensors SIMATIC VS 130-2 and

VS 130-2vcr and the S7 automation system, we provide a range of training
courses. Please contact your regional training center or the central training center
in Nuremberg, Germany.

Telephone: +49 (911) 895-3200.

Internet:  http://www.sitrain.com

Technical support

How to reach technical support for all A&D products

With the Support Request form on the Web:
http://www.siemens.de/automation/support-request

Telephone: + 49 180 5050 222
Fax: + 49 180 5050 223

Further information about our technical support is available in the Internet at
http://www.siemens.com/automation/service

Service & Support on the Internet

The Siemens Service & Support team provides you with comprehensive additional
information on SIMATIC products in its online Internet services.

http://www.siemens.com/automation/service&support

There you can find:

Current product information and downloads which you may find useful for your
product.

The documents you require, using our Service & Support search engine.
A forum where users and experts from all over the world exchange ideas
Your local partner for Automation & Drives.

Information about onsite services, repairs, spare parts. Lots more is available
to you on our "Service* pages.

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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1 Product Overview

1.1 Product Description

The Vision Sensor SIMATIC VS 130-2 is a code reader for data matrix codes of the
type ECC200 (with the exception of the types "Structured Append" and

"Reader Programming Code") and the codes PDF417 and QR (with the exception
of the types "ECI Code", "Byte Code", "Kanji Code", "Structured Append" and
"FNC1 Code"). The code type is detected during training and adjustment and
during training is saved as a code property.

The Vision Sensor VS 130-2vcr is Vericode reader.

You can use these readers to read the coded labeling of products and then pass
the read code to a PLC or a computer.

The SIMATIC VS 130-2/VS 130-2vcr operates with overhead lighting. The object is
lit from above with the supplied ring flash. With the lamp multiplexer accessory, it is
possible to select one of up to 4 lamps for the lighting.

The Vision Sensor SIMATIC VS 130-2/VS 130-2vcr is available in the following
models:

e SIMATIC VS130-2 for large code areas
(order number of the full package: 6GF1 130-1BA with 2.5 m cable length and
6GF1 130-1BA01 with 10 m cable length)

e SIMATIC VS130-2 for small code areas
(order number of the full package: 6GF1 130-2BA with 2.5 m cable length and
6GF1 130-2BA01 with 10 m cable length)

¢ SIMATIC VS130-2 for very small code areas
(order number of the full package: 6GF1 130-4BA with 2.5 m cable length and
6GF1 130-4BA01 with 10 m cable length)

e SIMATIC VS130-2 for variable code areas (order number of the basic package:
6GF1 130-3BC with 2.5 m cable length and 6GF1 130-3BC01 with 10 m cable
length) if you use the C- or CS-mount lenses (includes the high-resolution
sensor)

e SIMATIC VS130-2 for variable code areas
(order number of the basic package: 6GF1 130-3BB with 2.5 m cable length
and 6GF1 130-3BB01 at 10 m cable length), if you are using C or CS-mount
lenses and want to use the lens protective housing (6GF9 002-7AA01).

e SIMATIC VS 130-2vcr (Vericode reader) for variable code areas (order number
of the basic package: 6GF1 130-3BB02)

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
A5E00475759-01 1-1



Product Overview

Reading, matching or verifying code

SIMATIC VS 130-2/VS 130-2vcr can read codes, match the entire code or part of it
with a trained code and relate (verify) the quality values of the currently read code
to the quality values of a trained code.

The entire read character string or only part of it (in other words, filtered) can be
output. When it is output, further characters can de appended at the start or end as
a prefix or suffix.

The SIMATIC VS 130-2/VS 130-2vcr can operate both in standalone mode to
make good/bad decisions or as part of a control system to pass on the read codes
for further processing.

Performance Features

¢ Reliable reading of data matrix codes or Vericodes even under difficult
conditions (for example, for oil-smeared or needle-punched codes)

e Reading printed or lasered codes of the type PDF417 and QR on a
homogeneous background

e Overhead ring flash with VS 130-2
e Activation of up to 4 lamps using a special lamp multiplexer

e Linking of several trained codes that do not necessarily belong to the same
code type to form a code set with the VS 130-2

e ltis possible to specify a region of interest with the VS 130-2

e Fully Web-based user interface

e When using data matrix codes, up to 20 codes can be read per second
e With Vericodes up to 5 code readings per second

e Calculating quality characteristics

e Extensive operator control and monitoring functions even in the processing
mode

e Wide-ranging diagnostics and logging functions: Error image memory and
event logging

o Firmware update over the user interface

e Control over digital I/O, trigger signal and also over RS-232 interface of an
RS-232 Ethernet converter or TCP server

e Acquiring the code without a trigger signal ("Continuous" mode)

e Event output over PROFIBUS DP, PROFINET 1/0, RS-232 interface of an
RS-232 Ethernet converter, and TCP connection to PC

You will find the Technical Specifications of SIMATIC VS 130-2/VS 130-2vcr in the
appendix.

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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Code Properties

To improve clarity, the following terms are used in the table below:

e Variant 1: SIMATIC VS 130-2 for "large code areas" (6GF1 130-1BA and
6GF1 130-1BAO1 with sensor head 6GF2 002-8DA01)

e Variant 2: SIMATIC VS 130-2 for "small code areas" (6GF1 130-2BA and
6GF1 130-2BA01 with sensor head 6GF2 002-8EA01)

e Variant 3: SIMATIC VS 130-2 for "very small code areas" (6GF1 130-4BA and
6GF1 130-4BA01 with sensor head 6GF2 002-8FA01)

e Variant 4: C/CS Mount (6GF1 130-3BB and 6GF1 130-3BB01 with sensor
head 6GF2 002-8CB)

e Variant 5: C/CS Mount (6GF1 130-3BC and 6GF1 130-3BC01 with sensor
head 6GF2 002-8GB)

e Variant 6: C/CS Mount (6GF1 130-3BB02 with sensor head 6GF2 002-8CB) for
acquiring Vericodes

Properties

Configuration 1

Configuration 2

Configuration 3

Configuration 4
and
Configuration 6

Configuration 5

lens

CCD resolution |0,11 mm/pixel 0,06 mm/pixel |0.032 mm/pixel |Image width / Image width /
640 pixels 1024 pixels

Minimum dot size|0,6 mm 0,35 mm 0,16 mm Image width / Image width /

(edge length) 120 pixels 200 pixels

Maximum dot 3,5 mm 2mm 1 mm Image width / Image width /

size (edge 22 pixels 35 pixels

length)

Minimum code 10 *10 10 *10 10 *10 10 *10 10 *10

dimension

(rows * columns)

Maximum code |48 *48 48 *48 48 *48 72*72 " 72*72 "

dimension

(rows * columns)

Clearance 100 mm 90 mm 75 mm Depending on  |Depending on

sensor front edge lens lens

- test object

Image field 75 mm * 57 mm {45 mm * 34 mm {20 mm * 15 mm |depending on depending on

lens

1)

at the edges.

With large code dimensions such as 72*72, make sure that the lens used does not cause any distortion

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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Product Overview

1.2

1-4

Components

The complete Vision Sensor SIMATIC VS 130-2/VS 130-2vcr consists of the
following:

Sensor head with CCD sensor chip (CCD = Charge Coupled Device) for
sensing the code

LED overhead lighting unit, red, degree of protection IP65 as ring flash
(order number 6GF9 004-8BA01; only with VS 130-2)

Processing unit for code processing, output of results, PROFIBUS DP and
PROFINET I/O communication and parameter assignment

Cables to connect the individual components

Installation instructions for installing and wiring the
SIMATIC VS 130-2/VS 130-2vcr

CD with:

This manual SIMATIC VS 130-2/VS 130-2vcr (German, English, French,
Spanish, Italian for VS 130-2, German and English for VS 130-2vcr)

Online help (interfacing the Com Server of W&T, establishing the
connection, setup support)

Getting Started
Installation Instructions
Compact Com Server manual from W&T

The installation manual SIMATIC S7-300 Automation System, Hardware
and Installation

Getting Started Collection for PROFINET I/O
PROFINET System Manual, System Description

PROFINET I0 from PROFIBUS DP to PROFINET |0 Programming
Manual

PROFINET |0 Structure of the Diagnostic Data Records Product
Information

The device master data file SIEM8111.GSD and the corresponding bitmap
file VS1X0__N.DIB (for PROFIBUS DP)

the GSD file GSDML-V1.0-Siemens-VS130-2-20041021.xml (General
Station Description) and the bitmap file vs100.bmp (for PROFINET 1/O)

Three sample programs (connecting the VS 130-2 to a SIMATIC controller
using FB79, output of the read code to a PC or a PG, archiving diagnostic
information on a PC or PG)

Overview of the complete package

Note

If you want to use C or CS-mount sensors under IP65 conditions, use the lens
protective housing (6GF9 002-7AAQ01).

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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Product Overview

1.3 Processing Configuration

~ Sensor head with
ring flash

Yy L Light barrier
Object with 4 i
Code J

The objects with the code are fed past the sensor head with a suitable conveyor.
They must be located fully within the sensor field of view when being read.
In the training mode, the character content of the code is saved.

In the processing mode, the current code is read and, if required, compared with
the saved content of the trained code. The digital output signals are set according
to the read result: READ (code was localized and decoded), MATCH (code
matches the trained code), N_OK (code was not legible).

The read result is output over PROFIBUS DP, PROFINET IO or over the RS-232
interface of an RS-232 Ethernet interface converter or over a TCP server
depending on the parameter settings.

Triggering
To read the code, you must make sure that the code is completely within in the
sensor field of view and clearly visible.

The code is captured at the trigger time. In this case, you generate an exact and
debounced trigger signal at the trigger time, for example with a laser light barrier.

As an alternative, you can record the code without a trigger signal (trigger source
"endless"). In this case the code is output again only when there is a code change.
This is required, for example, with rotating parts if the exact position of the code is
not known.

You can check your settings with the setup support of the VS 130-2/VS 130-2vcr.

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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1.4 Important Requirements for Installation

The following requirements must be met:

e The code must be clearly visible:
- There should be as few reflections as possible in the code field.
- The code field should be uniformly illuminated without shadows.
- All parts of the code should be sharply printed.

e The sensor can be up to 40° from the vertical.

o The distance between the code and the image edge should be at least two dot
widths.

1.5 Applications

Below, you will see several examples of data matrix codes, QR, PDF417 and
Vericodes:

e Printed data matrix code

.y

YTV TETTRCTEA
L.f.ﬂa.i‘ [:J ]2| JH

e Lasered data matrix code (plastic surface)

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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e Lasered data matrix code (pcb)

e Punched data matrix code

¢ Needle punched data matrix code

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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e Printed QR code

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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1.6 The lamp multiplexer accessory

If there are varying lighting conditions in the vicinity of the sensor head, it is
sometimes advisable to work with different lamps at different times. You can
therefore connect up to 4 flash lamps to the Vision Sensor VS 130-2/VS 130-2vcr
using he lamp multiplexer (6GF9 002-7BA).

Note

The lamp multiplexer can only be used if you have set the multilight mode. If you
not activate the multilight mode, you must connect your lamp directly to the
processing unit.

The lamp multiplexer is shown in the figure below.

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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Connecting the lamp multiplexer

You connect to the processing unit as follows: Connect a lighting cable
(6GF9 002-8CE) to the LAMP socket of the processing unit and to the input socket
LIN. of the lamp multiplexer.

Connect each of the maximum four lamps to the lamp multiplexer over a lighting
cable. Lamp 1 is assigned to socket L1, lamp 2 to socket L2 etc.

Connect the socket connector "DI/DO" of the processing unit to the left-hand plug
connector "DI/DQO" of the lamp multiplexer with the supplied special cable. You can
connect a digital communication cable (6GF9 002-8CB) to the right-hand plug
connector "DI/DO". Please remember that you must not then use the MATCH and
NOK signals. These are used to select a lamp.

Note

If you connect the lamp multiplexer with connected lamps to a
VS 130-2/VS 130-2vcr while this is operating, this can lead to the processing unit
resetting itself in some situations.

Installing the lamp multiplexer

You have the following installation options:
¢ Wall-mounting using the two holes at the upper end of the lamp multiplexer

¢ Installation on a standard rail: In this case, screw the supplied rail adapter to
the back of the lamp multiplexer.

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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1.7 Requirements for Codes and Legibility

1.71 What is Required of Data Matrix and Vericodes?

General Requirements for Data Matrix and Vericodes to Ensure Readability

VS 130-2 can read data matrix codes with properties corresponding to those
published in the standard for data matrix codes. In many ways, VS 130-2 reacts
tolerantly even when certain basic properties are absent and is capable of dealing
with difficulties that are not specified in the standard.

As a result, VS 130-2 and VS 130-2vcr have a very wide range of application in
normal situations, a fact reflected in the following broad limits:

e |t can read codes in which directly adjacent code points have a minimum
distance of only 5 pixels and up to a maximum distance of 35 pixels.

e The deviation of the sensor axis from the vertical can be between 0 ° und 40 °.

e The code field can approach the edge of the image up to a distance equivalent
to twice the code point diameter.

e The dominant polarity of the code points compared with the background is
required uniformly for all points (as it was during the training procedure). Slight
shadows or shiny areas are tolerated.

e The ratio of the distance to the closest neighbor and the diameter of any code
point can be between 2 and 0.8.

e Although code points must be printed according to a regular square grid
pattern, individual points can be displaced from their ideal position by up to 1/3
of the grid unit. Even slight parallelogram-shaped distortion is tolerated.

o With large-image but small-dimensioned codes, slight curves in the printed
material surface are tolerated. With high-value codes (for example, more than
14 x 14) or a strongly inclined sensor axis, curves are not allowed.

e Large tolerance of background disturbances that cannot be described
quantitatively

e Large tolerance of poor contrast conditions

e Due to the limited image resolution, codes with a maximum code dimension of
72x72 can be read.

In terms of these limit characteristics and when using minimum read rates due to
the requirements of the application (can be set with the "Cycletimelimit" parameter)
the tolerances are generally restricted, in some cases in stages, or other conditions
come into play. The limits described below are intended mainly as guidelines since
the actual conditions in a real application cannot be assessed accurately in
advance. It is therefore conceivable that higher read rates can be achieved even if
individual conditions are not fully adhered to.

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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Processing Method for Reliable Reading of Difficult Data Matrix Codes and

Vericodes

Settings:
e Speed = low
e Exposure = Manual or Auto V1 or Auto

The self-adapting recognition method of VS 130-2/VS 130-2vcr allows the most
difficult codes to be read reliably. The most reliable detection is reached by

VS 130-2/VS 130-2vcr when you make adequate time available for adaption by
setting a high cycle time limit.

The recognition method is designed for a variety of practical situations in which
various aspects of the read configuration cannot be considered ideal. For example:

¢ Any alignment and position of the code in the image
e Reading codes even when dots overlap or are largely isolated
e Reading codes recorded mirror-inverted

e Tolerance of distortion, due for example to inclined installation of the image
sensor (view angle down to a lower limit of approximately 50° to the printed
surface)

¢ Resistant to similar-looking foreign objects in the area of the code

e Resistant to interference patterns (grooves, granularity) in the area of the code
e Good tolerance of contrast fluctuations

¢ Good range of imaging size from 5 to 35 pixels per dot

Rectangular or square codes (with data matrix codes with maximum dimensions of
72 x 72 dots) can be read, whereby the brightness polarity (bright on dark or dark
on bright) is unimportant.

If individual conditions are particularly favorable and stable in a concrete situation
(and therefore less effort is required for internal adaption), the read rate of

VS 130-2/VS 130-2vcr can reach a peak of 20 per second. You can influence this
by setting the "Speed" and "Cycle time limit" parameters as described below.
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Processing Method for Fast Reading of Data Matrix Codes and Vericodes with a
Guaranteed Read Rate up to 5Hz

Settings:
e Speed = medium
e Exposure:

- =Manual: guaranteed read rate of 5 Hz

- = Auto V1 and Auto: guaranteed read rate of 3.3 Hz
These read rates are achieved under the following conditions:
e The code dimension must not be greater than 40 x 40 dots.

e The code must be positioned so that there is always a clearance of at least 3
dots to the edge of the image.

e The code should not make contact with any other objects in the image (keep
the quiet zone free!)

e To allow the code to be found quickly, there must be no other objects (bus
structures count here as well) in the image with enclosed rectangle and of a
comparable size to the trained code. (See also the two following figures.)

e The minimum dot size is 5 pixels per dot without restrictions.
e The view angle must be greater than 70°.

The following figure shows you an illegal constellation for guaranteed read rates:
Two neighboring objects in the image have a rectangular border of a size similar to
that of the code.
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The following figure shows you a legal constellation for guaranteed read rates: All
neighboring objects are clearly of a different size from the code. In this case,
rotation of the code from exposure to exposure would be acceptable since there is
no rectangle of another object that is compatible with the largest possible rectangle
around the code.

Note
Operating and monitoring via the setup support can lead to longer cycle times.

Processing Method for Fast Reading of Data Matrix Codes with a Guaranteed
Read Rate of 20Hz

Settings:

Speed = high

Exposure = manual (due to the short processing times, automatic exposure is
not possible with this method.)

These read rates are achieved under the following conditions:

The illumination must be stable enough so that automatic shutter control is not
necessary.

The code dimension must not be greater than 20 x 20 dots.

Since the image is recorded "undersampled”, the dots of the code must have a
minimum size of 10 pixels

The code must be positioned in the sensor image so that there is always a
clearance of at least 3 dots to the edge of the image.

The code must not make contact with any other objects in the image, the quiet
zone must be kept free.

To allow the code to be found quickly, there must be no other objects (bus
structures count here as well) in the image with enclosed rectangle and of a
comparable size to the trained code. (See also the two following figures.)

The diameter of the dots must be uniform over the entire code field. The
contrast between dots and the background must be approximately the same
over the entire code field.
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The image background must have a homogeneous brightness (no textures
such as stripes or grooves etc.).

The view angle of the sensor to the printed surface must be approaching
vertical (80 to 90 degrees).

Note
Operating and monitoring via the setup support can lead to longer cycle times.

1.7.2 Requirements for QR codes

General Requirements for QR Codes and Legibility

The requirements are as follows:

It can read codes in which directly adjacent code points have a minimum
distance of 5 pixels and up to a maximum distance of 35 pixels.

The view angle of the sensor to the surface must be between 70 ° and 90 °.
The diameter of the dots must be uniform over the entire code field.

The contrast between dots and the background must be approximately the
same over the entire code field.

The image background must have a homogeneous brightness (no textures
such as stripes or grooves etc.).

The following code types are not supported: Micro QR code, Macro QR code

Due to the limited image resolution, the maximum code dimension 89x89 (for
all sensor heads except 6GF2002-8GB) or 133x133 (for sensor head
6GF2002-8GB) can be read.
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Requirements for QR codes for fast reading with guaranteed read rates up to
5 Hz (for all sensor heads except 6GF2002-8GB)

e The code dimension must not exceed 37 x 37.

e To allow the code to be found quickly, there must be no other objects (bus
structures count here as well) in the image with enclosed rectangle and of a
comparable size to the trained code.

e The code must be positioned in the sensor image so that there is always a
clearance of at least 3 dots to the edge of the image.

e The code should not make contact with any other objects in the image (keep
the quiet zone free: 4 dots).

e The dots of the code must have a minimum size of 10 pixels.

e The view angle of the sensor to the printed surface must be approaching
vertical (80 to 90 °).

e The code must not be mirrored compared with the trained code.
e The polarity must be the same as in the trained code.

e The code must have the same dimension as the trained code.

Characteristics of QR code
¢ Any alignment of the code in the image
e Up to 5 code readings per second
e Reading inverted code images
e Calculation of quality characteristics according to the AIM specification

e Display of the surrounding rectangle around the code position and code mid
point

o Display of the roll angle and tilt angle
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1.7.3 Requirements for PDF417 codes

General Requirements for PDF417 Codes and Legibility

The requirements are as follows:

Codes with a bar width of at least 3 pixels and in which the height of a single
row of symbols is at least 9 pixels can be read.

The width of the black and white bars must be uniform over the entire code
field.

The view angle of the sensor to the surface must be greater than 70 °.

The code should not make contact with any other objects in the image (keep
the quiet zone free: twice the column width).

Within the code, the ratio of contrast (difference between black and white) to
noise should be at least three and should be very similar over the entire code
field.

The image background must have a homogeneous brightness (no textures
such as stripes or grooves etc.).

The code must be positioned in the sensor image so that the entire code
(including start and stop pattern) always has a clearance of at least 3 pixels to
the edge of the image.

The error correction codes (the lower part of the bar code) must not be
covered.

The following code types are not supported: Truncated PDF417,
Macro PDF417, Micro PDF417

At the minimum bar width, each symbol column requires 51 pixels. Along with
the four start and stop patterns, the width of the code with n code columns is:
Width = 51 * (n + 4) pixels. Due to the limited image resolution, codes with up
to a maximum of 40 code rows and up to a maximum of 6 code columns (for all
sensor heads except 6GF2002-8GB) or up to 60 code rows and up to 12 code
columns (for sensor head 6GF2002-8GB) can be read.
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Requirements for PDF417 codes for fast reading with guaranteed read rates up
to 5 Hz (for all sensor heads except 6GF2002-8GB)

e The view angle of the sensor to the printed surface must be approaching
vertical (view angle 80 to 90 °).

e To allow the code to be found quickly, there must be no other objects (bus
structures count here as well) in the image with enclosed rectangle and of a
comparable size to the trained code.

e The code dimension must not be greater than 20 rows and 2 columns.
e The bar width must be at least 6 pixels.

e The height of individual symbol rows must be at least 18 pixels.

e There must be no disturbances or overlaps within the code.

e The PDF417 error correction level must be at least 1.

e The polarity must be the same as in the trained code.

Characteristics of the PDF417 code
e Any alignment of the code in the image
e Up to 5 code readings per second
¢ Reading inverted code images
e Calculating the contrast quality characteristic
e Calculating the unused error correction

e Display of the surrounding rectangle around the code position and code mid
point
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2 System Integration

21 Design
Processing Unit PCIPG for
o 5 setup support
Power A
Supply E b Ethernet (direct
oQ or over network

Automation system

PS [cPU

(]

PROFIBUS DP

# Sensor head

| I Ring flash

A
< Light barrier

with code

Conveying unit

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
A5E00475759-01

2-1



System Integration

2.2 Application Examples

221 Reading codes or checking quality in stand-alone mode with
output over Ethernet

Processing Unit

@ o
Power ~
Supply E GvD
oo
PC/PG for setup
support and
_ code output
a
Ethernet (direct
or over network

‘ Sensor head

Fastening
bracket

: | Ring flash
A

Light barrier

with code y Conveying unit

VS 130-2/VS 130-2vcr reads the codes and outputs them to a PC/PG. The PC or
PG can be connected to the processing unit directly by a crossover cable or over a

network connection.
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222 Reading Codes or Quality in Stand-alone Mode with Output over
RS-232
Intranet/
Internet PC/PG for setup
Processing Unit (e.g. switch) support
Power
Supply
H PC/IPG
Com Server for output
from W&T 3
_é_ Sensor head
[ I Ring flash
Light barrier

Object
with code

—

Conveying unit

Conveying unit —»

The code is output over the RS-232 port of the Com server from WuT. The PC or
PG for setup support is connected to the processing unit over a network (intranet or

Internet).
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223 Reading Codes or Quality in a PROFIBUS Environment

Processing Unit

g ©
T

Power
Supply

or over network |\

Automation system
l PSCPY

il

PROFIBUS DB
H%ﬂ Sensor head
O Fastening
bracket
E—L
4

Light barrier
Object
with code 1@ - Conveying unit

|

PC/PG for setup
|:| Qc'b Ethernet (direct support
E oo

PC/IPG
for output

_

A PC/PG intended solely for setup is connected over the Ethernet port. Via

PROFIBUS, there is a connection to a PLC and to another PC/PG.

VS 130-2/VS 130-2vcr is controlled over PROFIBUS by the automation system and
the codes output to this automation system or PC/PG once again over PROFIBUS.
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224 Reading Codes or Quality in a PROFINET Environment

Processing Unit Switch
2 @ oy
PC/PG for setup
Power X support
Supply E [ ]
U oo
Automation system
PSCPY
Sensor head
O Fastening
bracket
E— UL
4
Light barrier
Object
with code I@ - Conveying unit
|

A PC/PG dedicated for setup is connected over the Ethernet (TCP/IP). There is
also a connection to a PROFINET-capable automation system over the Ethernet.

VS 130-2/VS 130-2vcr is controlled over PROFINET by the automation system.
The code is also output over PROFINET to the automation system.
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225 Reading codes or checking quality in a PROFINET environment
and outputting over Ethernet

Processing Unit Switch
J @ ™y
Power PC/PG for setup
rt
Supply E |:| 030 Suppo
oo
U PC/PG
for output
Automation system
Sensor head PSP
O Fastening
bracket [
E—
Light barrier
Object
with code ‘@ Conveying unit
|

Two PCs or PGs are connected over Ethernet (TCP/IP):
e One is used for setup.

e The other is used to output the read codes.

Note

It is also possible to connect only one PC/PG over Ethernet (TCP/IP). In this case,
the same machine is used for setup and for code output.

A connection to a PROFINET-capable automation system remains over Ethernet.
VS 130-2/VS 130-2vcr is controlled over PROFINET by the automation system.

2.2.6 Mixed operation

In addition to the connection options listed in the sections Reading Codes or
Quality in Stand-alone Mode and over Ethernet to Reading Codes or Checking
Quality in a PROFINET Environment and Outputting over Ethernet, mixed modes
are also possible, for example control over PROFIBUS DP and result output over
RS-232.
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Installation

3.1 Installing Components for VS 130-2
Step Activity
1A

Arrange the sensor head so that reflections are kept to a minimum. The angle of its central
axis should be typically 15° from vertical (angle a) (permitted range of angles for data matrix
and Vericode: 0 < a <40°, for QR and PDF417 code: 0 < a < 30°).

Sensor head

Ring flash

f
I_l_\ Test object code
| | Conveying unit
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Step Activity

1b If there is still too much reflection at an angle of 15°, select an arrangement in which the
sensor head and the ring flash are not concentric.

Note:

The mechanism for mounting the ring flash is not supplied with the product.

If the ring flash does not meet your requirements, please contact your sales partner who will
be able to recommend other suppliers of lighting for the VS 130-2C.

fam)
,J:_
l.?i
Fastening [
bracket 1
@, Sensor head
Ring flash
Test object code
[
I |
1c With both arrangements, maintain a clearance between the end of the sensor head and the

code to be read that is suitable for the lens you are using.
Caution:

If you have a large code area and the sensor is inclined at a large angle to the code area and
there is only a short distance between the sensor and code area, this can lead to image
distortion and diminished recognition performance.

2 Install the processing unit so that it is easily accessible for the operator.

Install the external triggering unit, for example a light barrier.

Start the setup support on the PG/PC, and switch the processing unit to the Adjust mode. You

then see an image as seen by the sensor head.

e Check the trigger signal. by selecting the "Trg. only" check box in the "Read settings"
group of the "Adjust" task. Check whether VS 130-2 can read the codes with the sensor
head and ring flash in the current position. If necessary, correct the trigger point and/or
position of the sensor head.

e  Select suitable values for the shutter speed and brightness. The image should not be too
bright.

Caution: If Exposure is set to Auto V1 or Auto, the code must remain fully in the image for at
least 100 ms.

As soon as after "Recognition” the message "Successfully finished" appears, the code has
been successfully decoded. You will see the result of the read in the "Result" box.
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3.2 Wiring Components

Connect the processing unit with the other components using the connectors on
the front panel.

Port Pin Assignment of the Processing Unit

A Attention

Do not connect or disconnect cables when the power supply is on.

Apart from the Ethernet cable, the cables are supplied with the product (See
Components of the Product).

A Warning

Grounding the VS 130-2/VS 130-2vcr cancels the ungrounded installation of the
power unit used to operate the VS 130-2/VS 130-2vcr.

SRHNOE

Connector Connector |[Type Number [Cable Cross |Type
Label of pins |Section
Functional earth - Screw terminal - - -
Power supply IN 24V DC [Circular connector M12 |4 0.56 mm? Pin
lllumination Unit LAMP Circular connector M12 4 0.23 mm? Socket
Sensor head SENSOR HD D-sub * 26 0.09 mm? Socket
(shielded cable)
/0 DI/DO D-sub 15 0.14 mm? Socket
PROFIBUS DP DP D-sub 9 - Socket
Ethernet Ethernet RJ45 8 - Socket
*  The supplied ferrite ring must be fixed to the sensor cable (approx. 50 mm from connector to
evaluation unit).

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
A5E00475759-01 3-3



Installation

Step Activity

1 Read the guidelines for preventing electrical interference (see/ Guidelines for Preventing
Electrical Interference).

2 Connect the processing unit to the sensor head and the lighting unit with the cables.

3 If you do not evaluate the result bits READ, MATCH, N_OK over PROFIBUS DP: Connect the
digital outputs READ, MATCH, N_OK as described in/ Control Signals.

4 Connect the trigger signal via the TRG digital input.

5 If you intend to control the SIMATICVS 130-2/VS 130-2vcr with a PLC, connect the other digital
inputs and outputs as described in|Control Signals.

6 Connect functional ground of the processing unit to chassis ground (diameter of the ring: (M5,
cable cross section 1.5 mmz).

7 Connect the processing unit to the 24 V power supply (2 A).

8 Connect the PC/PG to the processing unit via Ethernet.

3-4

Note
The DC load power supply must meet the following requirements:
Only low voltage less than or equal to 24 V DC safely isolated from the power

supply network must be used for the load current supply. Safe isolation can be
implemented, for example, by adhering to the specifications

1. VDE 0100-410 / HD 384-4-41 S2 / IEC 60364-4-41
(functional low voltage with safe isolation) or

2. VDE 0805/ EN 60950 / IEC 60950
(as safety extra-low voltage SELV) or VDE 0106 Part 101.

Note

The supply chassis of the I/O and CPU must be connected to the supply chassis of
the processing unit.
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3.3

Guidelines on Interference-Proof Installation

To avoid interference, you must shield your system. Low-frequency (LF) and high-
frequency (HF) interference signals can result in an incorrect response if the
system is badly grounded or not shielded.

Interference signals can be caused, for example, by switching relays or contactors
(high rates of change in current or voltage, HF interference signals) or by different
ground potentials between two parts of a system (LF interference signals).

Using / Installing Interference-Proof Cable

3.4

e Always use the included patch cord to connect the sensor head.
¢ All plug-in connections must be secured by screws or a locking mechanism.

e Signal lines must not run parallel to power cables. A separate cable channel
must be used with a minimum clearance of 50 cm from power cables.

Note

For more detailed information, refer to the installation manual SIMATIC S7-300
Programmable Controller, Hardware and Installation in the section on "Wiring".

Guidelines for Installing PROFIBUS DP or
PROFINET I/O

If you are using PROFIBUS DP or PROFINET 1/O (to control the device and/or to
transfer the results) the installation and configuration guidelines must be kept to.
You will find this information in the installation manual SIMATIC S7-300
Programmable Controller, Hardware and Installation.
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4 Commissioning

4.1 Introduction
You can operate the Vision Sensor SIMATIC VS 130-2/VS 130-2vcr interactively or
controlled by signals:

¢ In this chapter, you will learn about interactive operation using the operator
control and display field of the evaluation unit.

e The section Process interfacing explains the options open to you for signal-
controlled operation.

Note

The setup support for VS 130-2/VS 130-2vcr is described in detail in the Online
Help for Setup Support.

4.2 Turning on the Device

Turn on the power on the processing unit. The texts "Booting... SIMATIC V ..." and
then "Firmware Version V..." with the current firmware version appear on the
display.

The VS 130-2 or VS 130-2vcr then runs the following tests:
e Test of the sensor head
e Test of the stored settings and code data

o If applicable, check whether data can be exchanged from and to PROFIBUS
(this check is made if you have selected "DP" for one or more of the following
signal paths: Output of the result string, feeding the trigger signal to the
processing unit, signal path for DISA, SELO, SEL1, SEL2, SEL3, TRN, RES,
IN_OP, TRD, RDY, READ, MATCH, N_OK).

e Test of the Ethernet connection

e If applicable, check for the connection to PROFINET and to Ethernet RS-232
converter or TCP server and to the PC/PG on which diagnostic information will
be stored (over TCP/IP)
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4-2

If there are no errors in the self-test, either the ADJUST menu or the RUN menu or
the STOP menu is displayed depending on the status when you last shut down.

e "ADJUST" menu:

Adjust
Read v A

OK:Menu

¢ "RUN" menu:

=C01 RUN v

=SERIE 7
OK:Menu

e "STOP" menu level

> Adjust
Connect
Train
! OK

Note

Apart from controlling from the processing unit, you can also control

VS 130-2/VS 130-2vcr with the setup support, see Operating using the

Setup Support.
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4.3 Control and Display Panel

The operator is guided by menus in the display panel.

e The menu items appear in the first three lines of the display panel. The cursor
">" points to the selected menu item.

CO1RUN v <| Q D
=SERIET
OK:Menu v

¢ In the fourth line of the display panel, you can see which buttons of the control
panel are currently available (OK, ESC, A, ¥, 4 ). Using the buttons of the
control panel, you can navigate within menus and from one menu to another:

- With the arrow buttons "A" and "V¥", you can move the cursor up and down
and select the menu command you require.

- With the "OK" button, you confirm your selection and move on to the next
step.

- With the "ESC" button, you open the previous menu.

Description of the LEDs

LEDs Function
SF Group error
POWER Power supply turned on
TRAINED Trained:
e InRun:

from: Selected code has not been trained
On: Selected code has been trained

e In Training (TRN=1):

from: Training active

On: Acknowledgment signal (RDY=0)

READY Ready:
o from: Device startup or SIMATIC VS 130-2/VS 130-2vcr in Stop
e  On: SIMATIC VS130-2/VS 130-2vcr in run

READ Evaluation result: Code was localized and decoded.
MATCH Evaluation result: Code matches learned code.
N_OK e Code was not legible.

BF Bus error on PROFIBUS or PROFINET
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Setting the number values
You select the places of a value with the arrow buttons " 4" and "#".
You change the value of a place in the number with the arrow buttons "A" and "V¥".

The speed at which the numeric value changes depends on how long you press
the arrow buttons. As soon as you release the arrow buttons, the rate of change
returns to the slowest level again.
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4.4 Adjusting the Sensor with the Setup Support

Before you commission the SIMATIC VS 130-2/VS 130-2vcr, you must adjust the
sensor head correctly. using a Web-based setup support. You then see an image
as seen by the sensor head. For more detailed information on the setup support,
refer to the online help.

Step | Activity

1 1. Switch on the PC or PG with the Internet Explorer.
2. Turn on the processing unit.

3. Establish the TCP/IP connection between the processing unit and the PC/PG. You can
either do this directly with a crossover cable or by including the processing unit in an existing
network. Both options are described in detail in the online help.

4. Enter the address of the processing unit the Internet Explorer.

Result:

Once the setup support has started, the sensor field of view is displayed on your PC/PG monitor.
The displayed image is updated several times per second.

2 Adjusting the Sensor
1. Bring the code into the image.

2. Set a sharp image by adjusting the distance between the end of the sensor head and the
code correctly.

3. Correct the shutter speed and the brightness if necessary or use one of the automatic
modes (Auto V1 or Auto).

Minimize reflected light by viewing the code at a slight angle.
Activate the "Triggered only" check box to test the trigger signal and the trigger settings
(trigger source).

6. Tune further settings as required.

Note:
If you have too many errors, clean the lens and diffuser with a lint-free cloth.

e Secure the sensor and then check the correct sensor position.

o Make other parameter settings.

e  Check the read result.

e Set the parameters to specify the process interface.

e Train the codes, if already known.

e Change to the processing mode (RUN).

O|lo|N|oO|jO |~ W

Analyze any errors that may occur.
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5.1

5.2

Operator Input

Overview

There are two basic ways of controlling the VS 130-2/VS 130-2vcr:
e Using the Setup Support
e Using the Processing Unit

With a few exceptions, you can set all the parameters with either method. This is
illustrated based on the example of the "IP Mode" parameter:

¢ In the setup support, you will find this parameter in the "Connections" task in
the "Interfaces" tab in the "Ethernet" group in the "IP Mode" drop-down list box.

e On the processing unit, it is available at the ADJUST menu level (Connect >
Ports > Ethernet > IP Mode).

Working with the Processing Unit

The display of the processing unit is used to display the currently read code and to
navigate through the menus and make entries.

Example of the display of a code:

C 01 RUN

=SERIES 7
OK:Menu

Note

In processing mode, it is not the currently read code that is displayed on the
processing unit when verifying but the string "Verifying=" followed by 4 quality
grades. These belong to the following quality characteristics: 1. Grade belongs to
the quality characteristic symbol contrast, 2. grade belongs to the quality
characteristic print growth, 3. grade belongs to the quality characteristic axial non-
uniformity, 4. grade belongs to the quality characteristic unused error correction.

There are three menu levels:

¢ RUN
o Adjust
e STOP
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The following table contains the menus of the RUN menu level.

Menu Meaning

Code Select the code number

STOP Processing and change to the STOP menu level

Info Information function

ResetStat |Reset all statistical information (identical parameter to ResetStat in the
Options>Decode menu)

Unless a temporary PROFIBUS DP or PROFINET IO error has occurred
(see Error Messages), the "Info" menu appears as follows:

Il C 01 MATCH
Off

110+ QK

01 READS
3226

=09 ,907%

210 1 oK

C 01 N_OK

-3
(093N
310 1 0
I
01 MATCH
3226
O U907
440 T QK
|
CO0Cor
Coye letine
=043 e

510 1 QK

GOl Cyele C Cyele
l'oo 5ot oo Shot
={} {0,000
Ga/l0 1 —0K Glyl10 —§ 0K

01 Trig. C 01 Trig.
Tows Fast Too Fast

=0} O1,000%
Talllh 30K TH0—1 QK

0 Min.

v etine
GLT e

S0 1T 0K

|

0] Max.
Cye etime
G0 s

9410 |I QR

Manual [P:

192, 168,
(42

K10 T 0K
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If one or more PROFIBUS DP or PROFINET IO errors have occurred

(see|Error Messages), the "Info" menu appears as follows:

(41"

i 01 MATCH
O

111 4+ QK

01 READS
3226

=08,907%

211 1 oK

Transient
Errors

-1

1P Ok

COTN_DOK

=083
411 1 OK

C 00 MATCH
=3226

O 0T,
511 1 oK

Co0
{T}tbthw
=G43 e
511 1 0K

0l Oyl
I Shert

0
Talll $—0H

C 0l Cyele
Too 3hort

0, D00
A1 ~1 oK

C 01 Trig.
T Fast

-0
a1l 0N

C 01 Trig.
Too Fast
1.000%,

11+ Ok

00 Min.
oy letinm:
=T e

@1 1 OK

C00 Max.
Cye Etine
630 s

111 |¥ ],

Marual [P:

102 168,
042

1411 T Ok
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The following table lists the menus of the ADJUST menu level.

Menu Meaning

STOP Exits the ADJUST menu level
If you have made changes in the Adjust menu, you can save or discard them.
The processing unit changes to the STOP mode.

Adapt (only with Exposure = Manual) exposure adaptation

Trigger [Trg.only An image is captured only on the trigger signal.
Auto (default) The images are acquired continuously.

Delay Specification of a maximum speed: Time by which the trigger signal will be
delayed (identical parameter to Delay in the Options>Integrate>Trigger menu)
Default: 0 ms

Distort Correction of the image distortion caused by the lens
Default:

e Sensor head 6GF2 002-8DA01: 130
e Sensor head 6GF2 002-8EA01: 50
e Sensor head 6GF2 002-8FA01: 0

e Sensor head 6GF2 002-8CB: 0

e Sensor head 6GF2 002-8GB: 0

LightSrc. |Specifies a light source (only in multilight mode)

The menus of the STOP menu level are listed in the following table.

Menu Meaning

Adjust Changes to the setup mode

Connect |Sets global connection parameters (interfaces, integration, result string)

Train Train a code

RUN Start evaluation of a code

Options | Sets global device parameters (decoding, illumination and image capture,
diagnostics)

Maintain |Delete trained codes and reset all parameters to their default values

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
5-4 A5E00475759-01



Operator Input

The following four schematics provide you with an overview of all the parameters of
the VS 130-2 that can be set in the Connect and Options menus.

}——/oiDo Pulsetime

i

Connect 1 —{Ports

—[DP (not when | Address
IP-Mode= PNIQO)

Timeout
Pulsetime
Swap
Devname

i

IIPNIO (only when
IP-Mode= PNIO)

i

Timeout

DHCP

Pulsetime

Manual

Swap

DHCPSERV

—Ethernet F————IP Mode —L—[pn0 ]

—— IP Address (cannot be changed when IP-Mode=DHGP)|

] IP Mask (not enabled when IP-Mode=DHCP) |

—| Gateway (not enalbed when IP-Mode=DHCP) |

—Result f—T—1DP or PNIO

— Control

DP or PNIO

— Diaglmage None
Arch/MMI
L DiagReport None
Arch/MMI

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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—{TCP/IRS232 |——{IPAddress |
——farcMMI_——{IP Address_|
—[ntegrate  |——Trigger  |———{Source TCP/RS232_|
__[String (only when Source=TCP/RS232) |
Delay
—{String F——]poPorPnio |
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of |
String ——{Fiter Option o
StartPos (if Option=Position) |
Length (if Option=Position) |
Separator (if Option=ID) |
D (if Option=ID) |
—Format j———string |
—{Messages Read Err |
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|Options — Decode [-—{ResetStat |
{Task F—{Read |
e
— (if Task= Option Match
Match) — StartPos (if Malch=Position) |
—{ Length (if Match=Position) |
—{ Separator (if Match=ID) |
L{1D (if Match=1D) \
—Speed ——{High |
L[Cycletime | ~Low |
—{ Light F1Typre R |
I Exposure  ——{Manual |
Auto
I Shutter, if Exposure= Manual |
| Brightness, if Exposure=Manual |
—{ MaxShutt, if Exposure=Auto |
— MaxBright, if Exposure=Aufo |
| ShuttOff, if Exposure=Auto und ShuttOff=ON |
—{ Diagnose || Logging }——{Images }——{Buffer —{Ring ]
L sk
—{Reasons [Trigger |
Train
— Record Image
__[SaveNext [On |
—{Report ——{Buffer \—[| Ring |
—{Timebase I—I:: PC | ] Entries (only when SaveNext=0Off) |
SNTP | Clear \
L— SNTP IP (only when Timebase=SNTP) |

{Monitor

- Update }—[ on
Off
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5-8

L{ Extras F——Light F—T—{Multilight On |

—1 Source, if Multilight=0n

— Use RO, if Exposure=Auto On
Off
—| ShuttOff, if Exposure=Auto
—{Multicode ©n | of |
—{Codesets  |—1—{Set 1 |
Set 14
—{Speed Up |—1—]Use Rol On |
Sequence First |
Second
Third
Dimension trained
[dynamic |
— Polarity trained
dynamic
— View trained
dynamic

—]Filter trained

— RO, if Use ROI=On

Width
Top
Height

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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The following three schematics provide you with an overview of all the parameters
of the VS 130-2vcr that can be set in the Connect and Options menus.

Connect I——|Pbrts |——| DVDO |—|Pulsetime ‘ DHCP
——IP Address (cannot be chanded when IP-Mode=DHGP) |
—IP Mask {not enabled when IP-Mode=DHCP) |
——{Gateway (not enabled when IP-Mode=DHCP) |
TCP/RS232 IP Address

— IP Port |

— Integrate —T—{Trigger F—
—1 String (only when Source=TCP/RS232) |

—[string |

—|String |——| Filter I—
| StartPos (if Option=Fosition) |
— Length (if Option=Position) |
— Separator (if Option=ID) |
— ID (if Option=ID) |

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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|Options ———Decode | ——[ResetStat |
—{Task ——Read |

Viatoh —Averity |
1 (if Task= {Option [——Match All
Match) —{StartPos (if Match=Position) Position
— Length (if Match=Position) ID

— Separator (if Match=ID)
1D (if Match=1D)

— Speed F—T—1High
Medium
—[Cycletime | “—|Low

—VCompress |—1—|None

——{VLicense !—E: Key |

Check F———valid |
T e i e 5 |
—{Exposure  |—— Manual |

— Shutter, if Exposure=Manual |
— Brightness, if Exposure=Manual |
—1 MaxShutt, if Exposure=Auto |
MaxBright, if Exposure=Auto
ShuttOff, if Exposure=Auto

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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Diagnose | Logging |1 Images |— —Buffer

—{Reasons

—Record Image

Report Buffer Ring |
M—E PC
snTP ]

——{SNTP IP (only when Timebase=SNTP) |

— Monitor —— Update }—E Oon |
off ]
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The following table describes all the parameters of the Connect menu.

Parameter Path Possible Default setting Meaning
Values

Ports

Pulsetime Ports>DI/DO 510999 30 Pulse time of the digital outputs
READ, MATCH, N_OK in ms on the
DI/DO interface

Address Ports>DP 110 125 7 Address on PROFIBUS DP

(not active, if

IP Mode =

PNIO)

(only for

VS 130-2)

Timeout Ports>DP 100 to 2000 500 Handshake monitoring time in ms

(not active, if

IP Mode =

PNIO)

(only for

VS 130-2)

Pulsetime Ports>DP 5 to 999 30 Pulse time of the digital outputs

(not active, if READ, MATCH, N_OK in ms when

IP Mode = output is over PROFIBUS DP

PNIO)

(only for

VS 130-2)

Swap Ports>DP S7, No S7 Specifies the byte order for data

(not active, if types with a width of 16 bits or more:

IP Mode = 1. S7: big endian

PNIO) 2. No: little endian

(only for

VS 130-2)

Devname Ports>PNIO String (0 to 9, A |VS 130-2 Name of the device on PROFINET

(not active, if toZ,atoz,".", Note: PROFINET is not case

IP Mode = "-"). The string sensitive

PNIO) must match the

(only for conventions of

VS 130-2) the domain

name system.

Timeout Ports>PNIO 100 to 2000 500 Handshake monitoring time in ms

(not active, if

IP Mode =

PNIO)

(only for

VS 130-2)

Pulsetime Ports>PNIO 510999 30 Pulse time of the digital outputs

(not active, if READ, MATCH, N_OK in ms when

IP Mode = output is over PROFIBUS I/O

PNIO) Note: For the pulse time, select a

(only for higher value than for the update time

VS 130-2) of the PROFINET 10 system in HW
Config

5-12
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Parameter Path Possible Default setting Meaning
Values
Swap Ports>PNIO S7 S7 Specifies the byte order for data
(not active, if no types with a width of 16 bits or more:
IP Mode = e S7: big endian
PNIO) e No: little endian
(only for
VS 130-2)
IP mode Ports>Ethernet |DHCP DHCP Assignment of the IP address to the
Manual processing unit in the network:
DHCPSERV e DHCP: Automatic (DHCP =
PNIO (only for Dynamic Host Configuration
VS 130-2) Protocol)
e Manual: Manual
e DHCPSERV: The processing
unit can assign an IP address to
a PC connected by a crossover
cable if the PC obtains its IP
address automatically (DHCP
client).
¢ PNIO: Automatic by the 1/0
controller
IPAddress Ports>Ethernet |xxx.xxx.xxx.xxx [192.168.0.42 IP address of the processing unit
(not (xxx=0 to 255) (An IP address consists of four
modifiable, if numbers separated by periods with
IP Mode = each number being in a range from 0
DHCP) to 255.)
IP Mask Ports>Ethernet |255.255.xxx.yyy |255.255.255.0 The subnet mask indicates which
(not active, if part of the IP address specifies the
IP Mode = network and which part specifies the
DHCP) processing unit:
For xxx.yyy, binary requires that the
left part be made up of ones without
a gap and the right part be made up
of zeros without a gap. Example:
11111111.10100000 is not
permitted.
Note also: yyy <= 254
Gateway Ports>Ethernet |xxx.xxx.xxx.xxx |192.168.000.255 |IP Address: IP address of the
(not active, if (xxx=0 to 255) network node that can establish
IP Mode = connections outside of the current
DHCP) subnet
MAC Info Ports>Ethernet |Cannot be Device- The MAC address (Media Access
modified dependent Control) is the hardware address of
each network device and is used to
identify the device uniquely in the
network.
IPAddress Ports> XXX.XXX.XXX.XXX [192.168.000.043 |IP address of the Ethernet RS-232
TCP/RS-232 (xxx=0 to 255) converter or of the PC/PG on which
a TCP server runs.
IP Port Ports> device-specific |8000 RS-232 port of the Ethernet RS-232
TCP/RS-232 converter or IP port of the PC/PG on
which a TCP server runs

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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Parameter

Path

Possible
Values

Default setting

Meaning

Timeout

Ports>
TCP/RS-232

0 to 3600

0: There is no transfer of cyclic
monitoring frames to determine
whether the connection still
exists between the processing
unit and the Ethernet RS-232
converter or the PC/PG on
which a TCP server runs.
Otherwise: Time in seconds
after which a monitoring frame is
sent to determine whether the
connection still exists between
the processing unit and the
Ethernet RS-232 converter or
the PC/PG on which a TCP
server runs. The check is
implemented by sending the
"Idling string" ("Connections"
dialog "Part 3/3. Result and
String") to the recipient at the
intervals set with the parameter.
If the check fails, an error is
output (only when the
processing unit is in RUN or
Train) and the connection is
reestablished.

IPAddress

(only for
VS 130-2)

Ports>
Arch/MMI

XXX XXX XXX XXX
(xxx=0 to 255)

192.168.000.045

IP address of the server for
diagnostic information

Port

(only for
VS 130-2)

Ports>
Arch/MMI

Device-specific

8765

Corresponding port of this server

Timeout

(only for
VS 130-2)

Ports>
Arch/MMI

0 to 3600

0: There is no transfer of cyclic
monitoring frames to check the
connection between processing
unit and server.

Otherwise: Time in seconds
after which a monitoring frame is
sent to check the connection
between processing unit and
server. If the server does not
respond to this frame within the
monitoring time, an error is
output (only when the
processing unit is in RUN or
Train) and the connection is
reestablished.

5-14
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Parameter Path Possible Default setting Meaning
Values
Integrate
Source Integrate> Endless DI/DO Here, you set the port over which the
Trigger DI/DO trigger signal is sent to the
DP or PNIO processing unit.
(only for
VS 130-2)
TCP/RS-232
String Integrate> ASCII M If the string specified here is sent
(only if Trigger characters over the RS-232 port of an RS-232
Source= Ethernet converter or a TCP server,
TCP/RS- the processing unit generates a
232) trigger signal.
Delay Integrate> 0 to 9999 ms 0ms Here, you specify the time by which
Trigger the trigger signal will be delayed in
ms (ldentical parameter to Delay in
the Adjust menu).
String Integrate DP or PNIO None Here, you enter the port over which
(only for the result string is output.
VS 130-2)
TCP/RS-232
None
Result Integrate DP or PNIO DI/DO Here, you specify the port over which
(only for the result bits OK, N_OK, READ,
VS 130-2) and MATCH are output.
DI/DO
None
Control Integrate DP or PNIO DI/DO Here you specify the port for the
(only for DISA, SELO, SEL1, SEL2, SEL3,
VS 130-2) TRN, RES, IN_OP, TRD, RDY
DI/DO signals.
Diagimage |Integrate None None Here, you specify whether the
(only for Arch/MMI currently captured image will be sent
VS 130-2) to a server when an error occurs.
DiagReport |Integrate None None Here, you specify whether the
(only for Arch/MMI corresponding data record will be
VS 130-2) sent to a server when an error
occurs.
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Parameter Path Possible Default setting Meaning
Values
String
option String>Filter Off Off e  Off: No character in the read
Position codes is suppressed. Nor are
ID any characters added.

e Position: Only part of the string
of the read codes is taken into
account. You specify this part
with the StartPos and Length
parameters.

e ID: Only parts of the string of
the read codes are taken into
account. You specify which
parts using the Separator and ID
parameters.

StartPos String>Filter >=1 1 Position, starting at which the

(only if characters of a part string are output.

String>

Filter

>Option=

Position)

Length String>Filter >=1 1 The part string consists of as many

(only if characters as you specify here.

String>

Filter

>Option=

Position)

Separator String>Filter ASCII + Separators

(only if characters

String>

Filter>

Option=ID)

ID String>Filter ASCII - The substring start is identified by

(only if characters the ID. If several sequences are

String> identified by the ID, only the first one

Filter> is used.

Option=ID)

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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Parameter

Path

Possible
Values

Default setting

Meaning

Format

String

See "Meaning"

%s

Content and format of the string to

be output

The string can be a maximum of 100

bytes long and consists of any

combination of the following
elements:

e Characters whose ASCII
equivalent is between 01H and
FFH (%% causes a percentage
character to be displayed)

e Formatting instructions for
output of variables

A formatting instruction has the

following structure:

% [number of places] variable

{selection of variables}

Here, square brackets mean the

information is optional Braces mean

that the exactly one value must be
selected from within the braces The
following formatting instructions are
possible:

e  %s

e %[03]ag{0]1|2|3}

o %Q{0|1]|2|3|4}

e %[03]p{0[1|2}

e %[{04|05}]c

e  %u

e  %U

e %l

ReadErr

String

>

Messages

See "Meaning"

Read Err (%s)

Content and format of the string to

be output with read errors

The string can be a maximum of 100

bytes long and consists of any

combination of the following
elements:

e Characters whose ASCII
equivalent is between 01H and
FFH (%% causes a percentage
character to be displayed)

e Formatting instructions for
output of variables

The following formatting instructions

are possible:

e  %s

e  %cC

"%s" stands for the textual

description of the probable cause of

the error in English, "%c" for a

decimal number with the same

information

FilterErr

String

>

Messages

Freely
selectable
character string

Filter error

Text for the situation when the
values for StartPos or ID for the
current part do not occur in the read
code

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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Parameter

Path

Possible
Values

Default setting

Meaning

MatchErr

String>
Messages

See "Meaning"

Match error (%s)

Content and format of the string to

be output with a match error

The string can be a maximum of 100

bytes long and consists of any

combination of the following
elements:

e Characters whose ASCII
equivalent is between 01H and
FFH (%% causes a percentage
character to be displayed)

e Formatting instruction for output
of variables

The following formatting instruction is

possible:

e %s (result string)

FormatErr

String>
Messages

Freely
selectable
character
string

Format error

Text for errors occurring in the
"Format" parameter

Idle Str.

String

Freely
selectable
character
string

\r\n

String to determine whether the
connection still exists between the
processing unit and the Ethernet RS-
232 converter or the PC/PG on
which a TCP server runs. It is
transferred cyclically. Select this so
that it can be clearly distinguished
from the result string by the recipient.

The string can be a maximum of 100
bytes long.
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The following table describes all the parameters of the Options menu.

(only if Decode>
Task=Match and
Decode> Match>
Option>
Match=ID)

Parameter Path Possible Default setting Meaning
Values
Decode
ResetStat Decode - - Resets all the statistical information
(identical parameter to ResetStat in
the RUN menu)
Task Decode Read READ Here, you set the task you want to
Match execute with VS 130-2/VS 130-2vcr:
Verify e Read: Read codes
e Match: Compare the entire code
or parts of it with a trained code
e Verify: The quality values of the
currently read code to which the
quality codes of a trained code
relate
MATCH Decode> |All All e All: All the characters of the
(only if Decode> Match> Position codes are compared with all the
Task= Option ID characters of the trained code.
Match) e Position: The string resulting
from "StartPos" and "Length" is
compared.
e D : The string resulting from
"Separator" and "ID" is
compared.
Speed Decode High Low Here, you specify the processing
Medium method and duration of decoding.
Low
StartPos Decode> |>=1 1 The first character from the
(only if Decode> Match reference string is entered here.
Task=Match and
Decode> Match>
Option>
Match= Position)
Length Decode> |[>=1 1 The length of the reference string is
(only if Decode> Match entered here.
Task=Match and
Decode> Match>
Option>
Match= Position)
Separator Decode> |ASCII + The substring extends as far as the
(only if Decode> Match characters first separator from the "Separators”
Task=Match and input box to occur or to the end of
Decode> Match> the code if there are no separators
Option> from the "Separators" box.
Match=ID)
ID Decode> |ASCII - Here, you enter the Match ID with
Match characters which the part string will be started.
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Parameter Path Possible Default setting Meaning
Values
Cycletime Decode 30 (75 with 2000 ms Here, you enter the upper limit for
high- the processing time.
resolution
sensor) to
9999 ms
VCompress Decode None, None Here, you set the character set that
(only for Numeric, was used in the Vericode to be read,
VS 130-2vcr) Alphanum to allow data compression if
necessary:
e None: Maximum character set
Every character requires 8 bits.
e  Alphanum: Only upper case
letters, numbers and a few
special characters are used.
Every character requires 6 bits.
e Numeric: Only numbers are
used. Every character requires 4
bits.
Key (only if Decode |Decode> |Cannot be Device- Displays the license key (8
>License >Demo VLicense |modified dependent hexadecimal numbers)
=0ff)
(only for
VS 130-2vcr)
Check Decode> |Valid, Invalid |- Displays the status of the license
(only for VLicense key.
VS 130-2ver) e Valid: Valid Vericode license
e Invalid: Invalid Vericode license
LIGHT
Type LIGHT IR Red Here, you enter the type of
Red illumination being used.
Other
Exposure LIGHT Manual Auto Here, you set the shutter control:
ﬁuto Vi e Manual: Manual
uto e  Auto: Automatic
e Auto V1: Automatic as in
VS 130-2 V1.x (compatibility
mode)
Shutter LIGHT 1 to 20000 ps (200 ps Enter the shutter speed of the sensor
(only when In ps.
Exposure=
Manual)
Brightness LIGHT 10 to 500 200 Here, you set the brightness.
(only when
Exposure=
Manual)
MaxShutt. LIGHT 5 to 20000 10 000 Upper limit for the shutter speed of
(only when the sensor in s
Exposure=
Auto)
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Parameter Path Possible Default setting Meaning
Values
MaxBright LIGHT 10 to 500 500 Upper limit for the brightness
(only when
Exposure=
Auto)
ShuttOff LIGHT -10000 to 0 s Enter the value here by which the
(for VS 130-2ver: 10000 us automatically calculated shutter time
only when will be changed.
Exposure= Note: The maximum exposure time
Auto is not exceeded.
for VS 130-2:
only when
Exposure=
Auto and ShuttOff-
Flag= On)
Diagnostics
Buffer Diagnose> |Ring, Stack Ring e Type of image buffer:-
Logging> e Ring: When the buffer contains
Images 50 entries, entries 1,2 ... are
overwritten.

e  Stack: When the buffer contains
50 entries, no further entries are
made.

Reasons Diagnose> |Trigger, NOK, [N_OK, Read und |Here, you specify what causes an
Logging> |Read, Match, |Train image to be saved.
Images No Match,
Train
Record Diagnose> |Image, +/-1 |Image e Image: If one or more of the
Logging> |[Image causes listed above occurs, the
Images current image is saved.

e +/-1Image: Not only the current
image but also the previous and
next image are saved.

Save Next Diagnose> |On, Off Off e On: The image belonging to the

(only for Logging> next NOK event is saved

VS 130-2) Images permanently in the EPROM.

Buffer Diagnose> |Ring, Stack Ring e Ring: When the diagnostic
Logging> buffer contains 15000 entries,
Report entries 1,2 ... are overwritten.

e  Stack: When the diagnostic
buffer contains 15000 entries,
no further entries are made.
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Parameter Path Possible Default setting Meaning
Values
Save Next Diagnose> |On, Off Off As soon as the function is enabled,
(only for Logging> as many diagnostic entries as you
VS 130-2) Report> specify in "Entries" are saved in the
Permanent EPROM. Existing entries are deleted
when you switch over to On. If the
diagnostic buffer in the EPROM
reaches the number of permanently
storable diagnostic data records, no
further entries are made.
Note: Deleting takes several
seconds.
Entries Diagnose> (10 to 2000 2000 Number diagnostic data records that
(only for Logging> can be stored on the EPROM
VS 130-2) Report>
Permanent
Clear Diagnose> |- - Delete all the diagnostic entries
(only for Logging> stored on the EPROM
VS 130-2) Report> Note: Deleting takes several
Permanent seconds.
Timebase Diagnose> |[PC, SNTP PC/ Here, you specify the source for the
Logging time stamp of the diagnostic events.
SNTP IP Diagnose> | xxx.xxx.xxx.xxx (192.168.000.044 |IP address of the SNTP server
(Only when Logging | (xxx=0 to 255)
Timebase= SNTP)
Update Diagnose> |On On Here, you specify whether images
Monitor Off and the events are saved in
processing mode and whether a live
image is displayed:
¢ On:Images and events are
saved, live image
e Off: Images and events are not
saved, no live image
Extras (only for VS 130-2)
Multi Extras> On, Off Off ¢ On: Mode in which you specify
Light the lamp to be used for lighting.
In this mode, the result bits
cannot be output over the DI/DO
interface.
The information on which lamp
to use is stored along with the
code data.
When reading without previous
training (Code number=Auto),
the lamp currently set in the
parameters will be used.
LightSrc. Extras> Lampt, ... Lamp1 Default lamp to be used for the
(Only if Multi= On) | Light Lamp4 image capture
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Parameter Path Possible Default setting Meaning
Values

Use ROI Extras> On, Off Off ¢ On: In automatic shutter control,

(only if Exposure= Light to calculate the optimum lighting

Auto) parameters, not the entire image
area but only the selected
region of interest is used.

e  Off: In automatic shutter control,
to calculate the optimum lighting
parameters, the entire image
area is used.

ShuttOff Extras> On, Off On ShuttOff-Flag:

(only if Exposure= Light e  On: The automatically

Auto) calculated shutter speed is
corrected by the ShuttOff value.

o  Off: . The automatically
calculated shutter speed is not
corrected.

Multicode Extras On, Off Off e  On: Mode in which several
images are captured and
processed per trigger. You
specify how many images are
captured and the trained codes
with which they are compared
using the "Code sets"
parameter.

o  Off: Mode in which exactly one
image is captured and
processed per trigger.

Set 1, ... Extras> Multiple Code setn From the currently active code set,

Set 14 Codesets |selection of contains only the processing unit takes the

(only if Multicode= codes 1to 14 |code n information on the settings for

On) (maximum 5) acquiring the images on the first

trigger and the trained codes with

which they will be compared. (If a

code set contains n images, n

images will be acquired in

succession.)

Note: At each further trigger, the

processing unit starts at the image of

the code that was last read
successfully. If no code can be read,
the current decoding order is
maintained.

Use ROI Extras> On, Off Off e  On: During image processing,

SpeedUp the processing unit does not use

the entire image area but only
the selected region of interest
(ROI).

e  Off: During image processing,
the processing unit uses the
entire image area

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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Parameter Path Possible Default setting Meaning
Values
Polarity Extras> trained, Dynamic Polarity (data matrix codes only):
SpeedUp |dynamic e trained: The processing unit

does not check whether bright
and dark dots are swapped over
in the read code compared with
the trained code.

e dynamic: The processing unit
checks whether bright and dark
dots are swapped over in the
read code compared with the
trained code.

Dimension Extras> trained, trained Number of dots (data matrix codes
SpeedUp |dynamic only):

e trained: The processing unit
does not decode the read code
if the number of dots is different
from the trained code.

e dynamic: The processing unit
decodes the trained code even if
the number of dots is different
from the trained code.

View Extras> trained, Dynamic Reflection (data matrix codes only):
SpeedUp  |dynamic e trained: The processing unit
does not check whether the
read code is mirrored compared
with the trained code.

e dynamic: The processing unit
checks whether the read code is
mirrored compared with the
trained code.

Filter Extras> trained, trained e trained: The processing unit
SpeedUp |dynamic does not use all filter adaption
options and therefore achieves
a read result faster (including
NOK).

e dynamic: This setting improves
reading reliability with
particularly bad code qualities,
for example on metallic
surfaces.

This parameter has no effect on

PDF417 code.

First Extras> DMC, QR, DMC Code type that the processing unit
SpeedUp> |PDF417 first tries to decode when training,
Sequence when reading without prior training
and during setup.
Second Extras> DMC, QR, None Code type that the processing unit
SpeedUp> |PDF417, tries to decode second when
Sequence |None training, when reading without prior
training and during setup.

5-24
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(only if Use ROI=
On)

Parameter Path Possible Default setting Meaning
Values
Third Extras> DMC, QR, None Code type that the processing unit
SpeedUp> |PDF417, tries to decode third when training,
Sequence |None when reading without prior training
and during setup.
Left Extras> 0,0% to 70,0 |5,0 % Left edge of the region of interest
(only if Use ROI=  |RO! % (specified relative to the width of the
On) acquired image)
Width Extras> 30,0 % to 90,0 % Width of the region of interest
(only if Use ROI=  |ROI 100,0 % (relative to the width of the acquired
On) image)
Top Extras> 0,0% to 70,0 |5,0 % Upper edge of the region of interest
(only if Use ROI= ROI % (specified relative to the height of the
On) acquired image)
Height Extras> 30,0 % to 90,0 % Height of the region of interest
ROI 100,0 % (relative to the height of the acquired

image)

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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5.3 Working with the Setup Support

To make use of the setup support of SIMATIC VS 130-2/VS 130-2vcr, the following
requirements must be met:

e PC/PG with the Microsoft Windows XP Professional operating system with
Internet Explorer 6.0 and Microsoft Java VM or Sun Java VM (see also
www.java.sun.com/J2SE) version J2SE 1.3.1 or J2SE 1.4.2_06 or J2SE 5.0

¢ Intel or compatible processor, minimum Pentium 133 MHz

e Graphics card/monitor with at least 65536 colors and a resolution of at least
640*480 pixels(The pages of the setup support are optimized for 65536 colors
and a resolution of 1024*768 pixels.)

e Ethernet port with up to 100 Mbps (protocol: TCP/IP)

To work with the setup support on the processing unit, you must establish a
connection from your Web browser (for example Internet Explorer) for setup
support. How to establish a connection is described in detail in the online help in
Establishing Connections.

Note

The online help is available on the CD. This ensures that you can refer to the
information even without the setup support (i.e. offline).

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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As an example, you can see the "Adjust Sensor’ dialog below.

SIEMENS Vision Sensor SIMATIC VS 130-2

Job: Adjust Sensor WEB
Adustment Instructions: -
K L B AR RR AR TR N1 KRR RAARRRARRRRARRERARRRRARRRRARRRRARRARARRRRARRRRANA}
Connections | 1. Focus image = - °
. 2. Set exact triggering 200— =
Training | 3. Werify read result = =
4. Optimize read quality = 3
M 5. Save seftings with Annhy' =l 00— = Dot size:
Optians | Current image 3 c smallest
Infarmation | Recognition:  Successfully 0 E F _l._
Maintain | finished 3 3
ston | Read settings = E_ largest:
Exposure: IAuto Ylil -00-= = _
Current Status Max.shutter sp. |1DDDD ﬂus —E E—
Max. brightness: ISDD ﬂ 200— =
. :I _III:']IIIIIIIIIIIII trrrprerrpreerpeereprerepreerprenee IIIII: I_Fu”Size
Shuttersp. offset: ID =i [ R L L N R e e e L EE L R
£ =l E T -300 =200 =100 u] 100 200 300
H Current image: 403
Trg. anl
L ¥ Result: Quality: Grade Value
Man tigger. _lnite | 72640338 WDB1714561F0637541 Distance to barder E
Trigger delay: ID ms BOB37A92 S20JAP 00,0 22T151 Symhol contrast A 0.75
—_— Gl |5— M|ln. dotdistance A 9.37
Frint growth A 0146
E——p Freeze I Min. dot distance: 9.37 Unused error correction A 1.0

Home Apply | Help |

@ Siemens LG 2005, All rights reserved/Slle Rechte vorbehaten.

Note

If the DISA bit is set, in other words, when VS 130-2/VS 130-2vcr is controlled by a
programmable controller, you must log on at the processing unit as follows:

1. Make sure that only one PC accesses the processing unit (red lock with
green D).

2. Place the mouse pointer on the currently logged-on user (top right) and click.
This brings you to the "Options Part 3/4: Security".

3. Logon as a user ("User1" or "Service") who is allowed to take control of the
VS 130-2/VS 130-2vcr ("Take control" check box selected). Remember,
however, that logging on accesses control of the VS 130-2/VS 130-2vcr by the
programmable controller (only relevant for functions that require the DISA bit,
for example, change codes and train code).

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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5.31 Starting Setup Support in the Web Browser

If the connection between PC/PG and processing unit is established, you can
access the setup support by starting the Internet Explorer and entering the IP
address of the processing unit in the "Address" input box and calling it with "Enter".

The startup page of the setup support appears in the Internet Explorer:

S'EMENS -+ siemens.com

Starseits m Service&Suppoatt (Internet

Vision Sensor VS 1302

SIMATIC VS 130-2 Network-
Identification:
MAC-Address:
08:00:0E:71:8E:38
IP-Address:
192.168.0.42

ffix, DHCP-SERVER)

e Adjust Sensor - the first thing to do!
Web-based setup and control.
Or monitor live image only

o Live Image for browsers
with javascript

o Live Image for PDA
with Macromedia Flash

« Documentation
Flease see the CD shipped with this product for
more information.

» Browser Check
Check if your browser is configured correctly for
Web-based setup and control

@ Siemens AG 2005, Al right=s reserved.

The VS 130-2/VS 130-2vcr automatically blocks operator control on the processing
unit. The following message appears on the display of the VS 130-2/VS 130-2vcr:
"Settings controlled by Web" (depending on the mode a different text is displayed
instead of "Settings").

With "Adjust Sensor", you display the user interface of the VS 130-2/VS 130-2vcr.

If the processing unit is currently running a self-test, the "Self-test" page opens
instead of the user interface.

The index finger symbol and the "active" ">" symbols indicate which step of the
self-test is currently being performed. At the same time you will also see a text with
information on the current step in the lower part of the page. This also explains the
meaning of the buttons you can use to intervene in the self-test.

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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5.3.2 User interface of the VS 130-2/VS 130-2vcr

When you open the user interface, the page opens that corresponds to the current
operating state of the processing unit. If, for example, the processing unit is in Stop
mode, the page below opens:

SIEMENS Vision Sensor SIMATIC VS 130-2

Job: Stop Sensor WEB

Adjustment

i

Cannections

_ Training_ | Current status of processing unit:
Run |
Options | Stop
Infarmatian |
aintain |
Stop |

Current Status

:’:!!I-a--

Enilish

Home Help |

@ Siemens &G 2005, Al rights reservedislle Rechte vorbehaten,

Task

At the left-hand edge of the user interface, you will see the list of jobs in the form of
buttons. The appropriate job is activated depending on the previous operating state
of the processing unit. You can change between jobs using the buttons.

Traffic Light

Below the buttons, there is a traffic light with which you can see the operating state
of the processing unit at a glance. The traffic light can have the following states:

e Green: Processing mode with output of the result string
e Yellow: STOP including adjustment and training

e Red: Fault

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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Error Display

If an error occurs, the traffic light changes to red and the corresponding error
message, the meaning of the error and ways to eliminate the error are displayed. In
"Error output" in the online help, you will find a list with the meaning of the error
messages and instructions on how to remedy the problem.

Acknowledge the error by clicking the "Acknowledge" button. By acknowledging the
error, the user interface can change automatically to the current status of the
processing unit after the error has been eliminated.

Changing the language setting

WEB

Help

5-30

At the bottom left, you will see a drop-down list box for language selection. You can
change the language setting for the entire user interface at any time.

At the upper right, you can see the currently logged-on user. By clicking on the
user name, you open the "Options Part 3/5: Security".

At the bottom right, you will see a "Help" button with which you can call up online
help at any time. The relevant help text of the online help opens depending on the
currently open dialog.

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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5.3.3

Job:

Adjustment
Connections

Training

dll

A
=
=

Options
Infarmation

Maintain

Ll

Stop

Current Status

Bdf

T
e

sh

Home

Adjust Sensor

In this dialog, you make the settings for the correct adjustment of the sensor head.

SIEMENS Vision Sensor SIMATIC VS 130-2

Adjust Sensor WEB
!ns':troiﬂlso:’:ﬁage = _:|||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||__
2. Set exact triggering 200— = °
3. Verify read result = =
4. Optimize read guality = =
5. Save seftings with Apply' ;l 00— = Dot size:
Current image 3 3 smallest
Recognition: Successfully § g _l._
finished o =
Read settings 3 2 largest:
Exposure: IAuto vlil 00— = _
Max.shutter sp.; |1DDDD ﬂus —z E
Max. brightness: ISDD ﬁl 200= -
- :I _I II?IIIIIIIIIIIIII trrrprerrpreerpeereprerepreerprenee IIIII: |_FU||SiZE
Shuttersp. offzet: ID =1L [ R L L e R N e e L EE L R
F =l b 7 -300 -200 -100 o 00 200 300
Current image: 403
Trg. onl
g Y Result: Quality: Grade Value
Man. trigger: Initiate )
= 4| 22640338 WDB1714561F0637541 Distance to horder B a0
Trigger delay: ID ms BOG37592 520JAP 00,0 22T141 Syrnbal contrast A 0.75
. . Min. dot distance A 9.37
Distartion: |5
Frint growth A 0.146
Freeze I Min. dot distance: 9.37 Unused errar carrection & 1.0

Apply |

Help |

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr

Instructions

@ Siemens AG 2005. Al rights reservedisle Rechte vorbehalten.

At the top left of the dialog, a static text is displayed providing brief instructions on

adjusting the sensor.

Current image

If "Recognition" is set, the status of image recognition is displayed:

e "Successfully finished" in blue text if the currently read code could be decoded
Only the images that the VS 130-2/VS130-2vc is attempting to process are
displayed. The images are displayed with a green border (indicates detected
code). The results box, the display of the minimum dot distance, and the boxes
with the five poorest quality characteristics are enabled. The last image
process and the results string remain displayed until the processing unit sends
the next results string or the recognition status changes to "Running".

e "Running" in red text if the currently read code could not be decoded at the first
attempt. In this case, VS 130-2/VS 130-2vcr makes further attempts to decode
(relearn). The images are displayed without a border. The results box, the
display of the minimum dot distance, the boxes with the five poorest quality
characteristics, and the corresponding labels are grayed out.

A5E00475759-01
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Read Settings

Here, you enter the parameters for image processing. The possible values and the
meaning of the parameters are described in the online help. You can open the
online help with the "Help" button (bottom right in the dialog).

With the "Freeze/Edit ROI" button or "Live Image" button, you can perform the
following actions:

e Change the region of interest
The region of interest is the area in which the VS 130-2/VS 130-2vcr reads
data such as data matrix codes. In the preview, this area is displayed with a
red box if "Speedup" "Use ROI" = On is activated in Part 5 of the "Options"
dialog or Exposure = Auto and Autom. Exposure >Use ROI = On is activated. If
you click on the Freeze/Edit ROI button, the image is frozen and you can adapt
the size of the region of interest in the preview.

e Freezing the current image
You can freeze the current image if the region of interest is not used and no
live image is displayed.

o Displaying the live image.

Note

The labeling changes depending on what you activated and the labeling matches
the job you change to.

Image display

Below the image display, there is a diskette symbol with which you can capture an
image with the VS 130-2/VS 130-2vcr and save the image in BMP format.

The following elements are displayed to the right of the image display:

e Green symbol on black background:
Sign of life for the connection between setup support and the sensor. The
green symbol is of variable size.

o Display of the dot size (not for PDF417 codes):
Display of the smallest and largest possible dots that can be decoded with the
existing equipment.

e "Full size" check box
A horizontal and vertical scrollbar is displayed at the lower edge of the image.

e "Currentimage":
The consecutive number of the currently displayed image is displayed.

Result

If a code was successfully decoded, the last read code or the modified result string
is displayed in the result field in the image preview. If the code could not be
decoded, this box is grayed out.

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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Quality / Grade / Value

If a code was correctly read (Recognition: "successfully finished"), the quality
characteristics that caused the most problems in reading the code with the current
setup are displayed here. By eliminating these problems, you can improve the read
reliability of the VS 130-2/VS 130-2vcr.

The quality grade has the range of values A, B, C, D, F, where A is the best and F
the poorest quality

The displayed characteristics are shown in the following colors:
e Petrol for grade A

e Cyanforgrades B, CorD

e Red for grade F

You will find descriptions of the quality characteristics and the corresponding value
ranges in the online help that you can call with the "Help" button.

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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5.34 Connections
SIEMENS Vision Sensor SIMATIC VS 130-2
Job: Connections Part 1/3: Ports WEB
Adjustment |
Connectionsl Forts ‘ ‘ Integration ‘ ‘ Result & String |
Ttaining | — Ethernet — PROFIBUS DP
Run | IP mode; Address: I?
Options | IP address: 192 .[1a8 .|n .|42 Timeout: 500 ms
Information | Subnet mask; |255 288 .|255 .|n Pulse time: |3D ms
Maintain | Gateway: |192 J1se .|n 255 Swap: |sw -]
Stop |
— PROFINET 10 — TCPRS232
Current Status Devicenarme: |vs130-2 IP address: 192 .|168 .ID .|43
Timeout: 400 ms Fort: 8000
FPulsetime: ISD ms Timeout: ID SEC.
Swap: IST 'I
— Archiving/MMI
— DIDO
IP address: 192 |68 .ID .|45
Fulse time: IBD ms
Fart: 8764
Timeout: I'ID SBC.
L.
English -
Home Back Next ARRly _ Hen |

@ Siemens A% 2005, All rights reserveditlle Rechte vorbehaten.

5-34

The Connections dialog is made up of the following three parts:
e Part 1/3: Ports

e Part 2/3: Integration
e Part 3/3: Result & String

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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Part 1/3: Ports

Here, you either specify or set parameters for the ports. Part 1/3: Ports includes the
following group fields:

Ethernet
Here, you set the parameters for the Ethernet port.

PROFINET IO

Here, you set the parameters for the PROFINET 1O port. These input boxes
are enabled when you select "PROFINET mode" in the "IP Mode" drop-down
list box.

DI/DO
Here, you set the switching duration of the digital outputs READ, MATCH,
N_OK.

PROFIBUS DP

Here, you set the parameters for the PROFIBUS DP port. These input boxes
are enabled when you select "DHCP" or "Manual" or "DHCP Server" in the "IP
Mode" drop-down list box.

TCP/RS-232

Here, you set the parameters for an Ethernet RS-232 converter connected to
the Ethernet port of the processing unit or for the PC/PG on which the TCP
server runs.

Archiving/MMI

Here, you specify the address of a server to which you send images and / or
data records for diagnostics and a monitoring time after which connection
establishment is checked again to determine whether the connection exists
between the processing unit and server following a failed connection
establishment.

Note

You will find a detailed description of the parameters the possible values in the
online help that you can call with the "Help" button.

With the "Next" button, you change to the next part of the "Connections" dialog.

The "Apply" button is enabled only when you have changed settings. When you
click on one of these buttons, all the parameters of the current dialog are saved.
The dialog remains open.

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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Part 2/3: Integration

Here, you specify the path over which signals are sent to the processing unit and
over which path the result string is output.

You will find a detailed description of the possible settings in the online help that
you can call with the "Help" button.

Note

You cannot set every combination of settings for String, Result and Control. If a
combination is not permitted, (for example Text = PROFIBUS DP and Control =
DI/DO), an error message to this effect is displayed in the lower part of the dialog.

Part 3/3: Result & String

5-36

Here, you specify whether and how result string or filtered text sections, quality
values, positions etc. are output over the RS-232 port of an Ethernet RS-232
converter or over DP or to a TCP server. You can also specify which text appears
on the display of the processing unit if an error occurs.

In the "Result String" group box, you specify whether all characters of the read
code are output or only a substring (according to the filter settings of ID or
Position). With the "Format string" input box, you can also specify the content and
the format of the string to be output. How to make these settings is described in the
online help that you can call with the "Help" button.

In the "Error messages" group box, you specify which text is output on the display
of the processing unit and over Ethernet or DP if the relevant error occurs. You can
select any string to be output by entering the required text in the relevant input box.

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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5.3.5 Train

SIEMENS Vision Sensor SIMATIC VS 130-2

Job: Train Code

Part 1/2: Prepare and start

WEB

Adjustment | Mote:
Connections |

Training is required for quality control
and code matching.

Training is useful when no
processing time is available during
the transition from processing mode.

Run |
Options |

Infarmation

aintain |
Stop |

Current Status

L

[~
=
[=]

-100

200

_|||||||||||||||||||||||||||||||||||||||||||||||||||||||||I|||||||_

100 Dot size:

simallest:

I

largest:

m

[~ Full size

o
IREARRRRARRRA RN AR R IRRR A RRERARRRRARTRRINRT!

300 -200 -100 u] 100 200 300
Current image: 40

[~ Usethis image

Start training

- —

English - Mon trained. Click on 'Start Training' to start.

Home

Help |

@ Siemens AG 2005, All rights reserveditlle Rechte vorbehaten.

If you want to compare read codes with each other or use the

VS 130-2/VS 130-2vcr for quality control, you can train codes that can be used for
a comparison. The last transferred image is displayed in the preview. With the
diskette symbol, you can save the current image in BMP format.

"Use this image" Option Button

If this option is selected, the currently displayed image will be used for code
training. The preview only shows the image last acquired when the check box was

activated.

If this option is not selected, the next triggered image will be used for code training
after you click the "Start Training" button.

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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"Start Training" Button

Clicking this button starts the training of the code. After successful training, you
move on to Part 2 of the dialog "Train Code".

The following is displayed in this dialog:
e The image of the acquired code
e Below this, the result in the form of a string and

e The exposure time, brightness and quality of the code (quality grade from A =
best quality to F = worst quality).

To save the code, enter a number between 1 and 14 in "Code number" and click
"Save". Under "Saved codes", you can see which code numbers are already being
used. You can overwrite existing codes by entering the corresponding code
number.

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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(3}

3.6 Evaluating

SIEMENS Vision Sensor SIMATIC VS 130-2

Jobh: Processing Mode WEB
;djumr:em gﬂ:?r;gthetransitiunmprocessingA N YRR AN ER AR KXR R ERRRA RN R KRR ARRRA ARRRARR AR ARRRARRRRAN]
onnhections | E —
— mode the ¥5130-2 needs adaption 200— = .
Training tirme to adjustto the code. You can = =
Run | avoid this by saving a code inthe = =
Training' section and then 00— = Dot size:
Options | selecting it here hefore beginning Ll 3 = -
= = smallest:
Infarmation | Select code 3 3 -l‘-
haintain | Code nurnber: |1 vl D_E —
Sto | . 1 E 3 largest:
: Siard | 00— = _
Current Status 3 3
— Info: Code numhber 1 [1/4] 3 =
200 =
Reads: 413 EDer =
|I|IIII|IIII|IIII|IIII|IIII|IIII|IIII|IIII|IIII|IIII|IIII|IIII|I_
100.000% 0 200 - ] 100 200 300
NOK: 0 i Current image: 413
0.000%
Result: Quality: Grade Yalue
Match: off
22640338WDB1714561FOG37541 Owerall: A
BO0637592 520JAF 00,0 227141 Symbaol contrast A 0.78
e Print grawth A 0175
Axial non-unifarmity A 0.006
= i | 3 | it | i | Resetl Show:  |Allimages =l | Urwsederorcomection A 0.900
|Eng|ish vl
Home Help |

@ Siemens A% 2002, All rights reserveditlle Rechte vorbehalten,

In this dialog box, you can start the processing mode. The codes are read and, if
applicable, checked to find out whether they match a trained code or whether they
contain one or more predefined strings. Depending on whether or not you use
multicode (see Options, Part 5 : Extras), you can use individual codes (if Multicode
> Use = Off) or code sets (if Multicode > Use = On).

Select code / Select code set

Here, you enter the number of a previously trained code or code set that you want
to compare with a current code. The following values are available here:

e The numbers of all codes / code sets that have already been trained

o "Auto", if you set the value "Read" as job in the "Job" drop-down list box in
"Options" in Part 1/5: Decoder.
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5.3.7

SIEMENS

Job:

Adjustment
Connections
Training
Run
Options
Infarmation
Maintain

Stop

ALl

Current Status

Options
Vision Sensor SIMATIC VS 130-2
Options Part 1/5: Decoder WEB
Decoder ‘ ‘ Lighting & Acquisition ‘ ‘ Security ‘ ‘ Diagn. & Monitaring ‘ ‘ Extras
—Decode .

=

Task: Read - \}i‘)

Match: All - T

roduction:
Start position: 1 1. Select which task ¥S130-2 should perform
) ,7 2.0ptional for the task "Match”: select how the match should

Length: L be performed.

Separators: + 3.Set the necessary speed.
4.Use the cycle time limit to set the maximum available

ID: evaluation time.
Info:

Speed: Lawy - The speed setting determines how fast the evaluation is.
You can find more information on the requirements regarding

Cycle tirme limit: 2000 ms reliable reading for the *Medium' and *High' settings in the
online help.

|Eng|ish vl

Home

All settings except for Task are copied into the trained code
on Training.

=

Back Me: Apply

Help |

@ Siemens A% 2002, All rights reserveditlle Rechte vorbehalten,

The "Options" dialog is made up of the following five parts:

Part 1/5: Decoder

Part 2/5: Lighting & Acquisition.
Part 3/5: Security

Part 4/5: Diagn. & Monitoring
Part 5/5: Extras

Part 1/5: Decoder

In the "Decoder" group box, you specify the job you want to perform with the

VS 130-2/VS 130-2vcr: Read, Match or Verify. With the match function, the entire
code or parts of it is compared with a trained code, with the Verify function, the
quality values of the currently read code are related to the quality values of a
trained code. You also specify the reading speed and set the maximum processing
time with the cycle time limit.

5-40
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Part 2/5: Lighting & Acquisition.
In the "Lighting" group box, you set the type of lamp you are using.

In the "Acquisition" group box, you enter the type of lighting control and set the
exposure time, the brightness, the light source and, if necessary, the shutter speed
offset. You will find further information in the online help that you can call with the
"Help" button.

Part 3/5: Security

In this tab, the administrator must also specify which user is permitted to execute
which tasks and can, when necessary, change the passwords of the users.

Users can also log on under their names with the appropriate password. Below the
"User" table, you can see the role for which you are currently logged on. In the "Log
on" group box, you can change this role by selecting a role from the "User" drop-
down list box and logging on with the correct password.

Part 4/5: Diagn. & Monitoring
In this tab, you specify the information to be stored for diagnostic purposes.

In "Image" in the "Logging" group box, you specify which pictures will be stored and
in which form on the processing unit. In "Report", you specify the form in which
diagnostic events will be stored on the processing unit.

In the "Time base" group box, you specify whether the time stamp of the diagnostic
events is provided by the PC or by an SNTP server of the network. If you select
SNTP as the source, you must also specify the IP address of the server.

In the "Monitoring" group box, you specify whether a live image is displayed in
processing mode.

In the "Persistence" group box, you specify which diagnostic information you want
to store permanently on the EPROM.

If the "Save NOK image" check box is enabled, the image of the next NOK signal is
stored. If an image is already stored, it is overwritten when this function is selected.
If the "Save diag. entries" check box is enabled, the number of diagnostic entries
you specify in the input box will be entered in the EPROM. Existing entries are
deleted when you switch over to On. If the diagnostic buffer in the EPROM reaches
the number of permanently storable diagnostic data records, no further entries are
made.
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Part 5/5: Extras (only for VS 130-2)

5-42

Lighting & Acquisition.

The multilight function is only possible if you have connected a multiplexer and
more than one lamp. Enable the "Multilight" function in the "Lighting and
Acquisition" group box to be able to select the lamp used for the image capture
from the setup support. When using the multilight function, only one of the lamps
you select from the drop-down list box is ever active. In this mode, the result bits
cannot be output over the DI/DO interface.

Under "Autom. Exposure", you can decide whether the entire image area or a
smaller area (region of interest) is used to calculate the optimum exposure
parameters. You can change this region of interest by changing to the "Adjustment"
dialog and moving or scaling (only possible when "Freeze/ROI" mode is activated)
the red frame in the preview window.

With "Use shuttersp. offset", you decide whether or not the automatically calculated
exposure time is corrected by the value of the shutter speed offset (Part 2 of the
"Options" dialog).

Acceleration

In the "Speedup" group box, you make the settings to speed up image processing.
This is effective only when Speed = low (see Part 1 of the "Options" dialog).

You have the following options:

e Use ROI": The region of interest set in the "Adjustment” dialog is used in the
image processing.

e "Decoder order": Here, you specify the order of the code types in which the
processing unit attempts to decode a code when training, when reading
(without prior training) and in adjustment mode.

e With data matrix codes, there are the speedup parameters Polarity, Dimension
and View that can each have the value "trained" or "dynamic":

- Polarity:
When Polarity = "trained" is set, the processing unit does not decode the
read code if bright and dark dots are swapped over compared with the
trained code. When Polarity = "dynamic" is set, the processing unit
decodes the read code even if bright and dark dots are swapped over
compared with the trained code.

- Dimension:
If Dimension = "trained", the processing unit does not decode the read
code if the number of dots is different from the trained code. If Dimension =
"dynamic", the processing unit decodes the read code even if the number
of dots is different from the trained code.

- View:
If View = "trained" is set , the processing unit does not decode the read
code if it is mirrored compared with the trained code. If View = "dynamic" is
set , the processing unit decodes the read code even if it is mirrored
compared with the trained code.
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Multicode

The "Multicode" mode allows you to capture and evaluate several images at the
same time with one trigger. To use this function, choose a code set number (1-14)
in the "Code set" drop-down list box and select the codes to be included in the
code set in "Contains codes". Based on the code set, the processing unit obtains
the settings with which the images will be captured at the first trigger and the
trained codes with which they will be compared.

At each further trigger, the processing unit starts at the image of the code that was
last read successfully. If no code can be read, the current decoding order is
maintained.

Note

If a code set contains a code number under which no code was previously trained,
you cannot use this code set for evaluation. With the "Info" job, you can see the
code number under which trained codes are stored in Part 2/4: Code(s).
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5.3.8 Info
SIEMENS Vision Sensor SIMATIC VS 130-2
Job: Information Part 1/5: Statistics WEB

Adjustment |
Connections | Statistics ‘ | Codes ‘ ‘ Diagnostics | ‘ Evaluation | ‘ Device Info
Training | Current code: 1
Run |
OyilETE | Read statistics Quality statistics
i Reads: 477 Code X pos. 32 clality A 477
haintain | 100.000% Code ¥ pos: 4 100.000%
&l NOK: 0 Roll angle: -82° Quality B: 0

Current Status 0.000% Wiewr angle: a0 0.000%
Match: Off Min. dot distance: 9.3393 Cluality C: 0
- Trigger too fast: 1} 0.000%
0.000% Guality D: 1}
Cycle time: 238ms Trigger Interval: 00:00:00.543 0.000%
Min.: 229ms Mit.: 00:00:00.542 Cluality F: 0
LEES 449ms M. 00:00:00.659 0.000%
Too short: 1]
0.000% Resetstatisies |

Home BHack: et Help |

@ Siemens AG 2005, All rights reserveditlle Rechte vorbehaten.

The Info dialog is made up of the following five parts:
e Part 1/5: Statistics.

e Part 2/5: Code(s)

e Part 3/5: Diagnostics

e Part 4/5: Analysis

e Part 5/5: Device Info
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Part 1/5: Statistics

In this part of the dialog, you can see statistical values relating to the reading of the
codes and the read quality. You will find a description of the displayed information
in the online help that you can call with the "Help" button.

If you have disabled the Multicode mode (see Part 5 of the Options dialog), you
enter information here out the currently used code.

If the Multicode mode is enabled, a drop-down list box is displayed. In the drop-
down list box, you can decide whether the statistics of the entire code set or the
statistics of a specific code is displayed.

If you simply want the statistics of the OK reads of a certain code, select the code
number of the relevant set from the drop-down list box. With this setting, the "*"
symbol is displayed at several positions.

You can clear the statistics with the "Reset statistics" button if you have
management permissions (see Options Part 3/4: Security). The statistics are reset
automatically when you change the code.

Information Part 2/5: Code(s)

In this part of the dialog, you see the exposure and properties of a trained code or
the settings of code to be read along with the image and the result string.

In "Select code”, you can specify the number of the trained code whose properties
you want to display.

In the "Training Information™ group box, the shutter speed, if applicable the shutter
speed offset, and the brightness with which the image was acquired during training
of the code are displayed.

The "Quality" group box displays all the quality characteristics of the trained code.
The quality is specified as a quality grade (A = best to F = worst quality) and
specified in an absolute value.

By clicking on the "Runtime >" button, you open the page displaying the settings of
a code to be read.
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Information Part 3/5: Diagnostics
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Images

In "Images", you can see the number of images currently in the image buffer.
If you click the "Reset" button, you delete all images in the image buffer.
Clicking the "Open" button opens a web page with all the images of the image
buffer. If you click on one of these images, the image is magnified.

Clicking the "Save" button opens a web page with all the images of the image
buffer. You can save this Web page in various formats on your computer.

Data record

The "Data records" group box displays the number of diagnostic events currently in
the events buffer.

With the check box under "Content", you specify which information you want to
display about the diagnostic events in the buffer:

e Error: Information on the occurrence and acknowledgment (manual or
automatic) of errors

e Decode: Evaluation result

¢ Image: Information on the image capture, for example shutter speed,
brightness

e States: Mode change (change to RUN, ADJUST, Self-test, etc.)

e Controller: Change of control of the processing unit (control by keyboard,
WEB, CPU)

o Diagnostics: Changes that affect diagnostics, for example changing the
diagnostic options, fetching a time stamp from an SNTP server

By clicking the "Reset" button, you delete all the entries in the event buffer
including the entries relating to temporary PROFIBUS DP or PROFINET IO errors.

If you click on the "Save as CSV" button, a dialog opens in which you can store the
events currently selected under "Content" as a csv file.

Clicking the "Open&Save" button opens a web page with all the events of the
events buffer. You can save this Web page in various formats on your computer.

Persistent data records

Clicking the "Open & Save" button opens a web page with all the diagnostic entries
saved permanently on the processing unit. You can save this Web page on your
computer.

If you click on the "Save as CSV" button, a dialog opens in which you can save the
diagnostic events permanently stored on the processing unit as a csv file.
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Information Part 4/5: Analysis

If the processing unit is in STOP mode, in this part of the dialog for the VS 130-2
you can display the last processed image, a persistently stored image or an image
in the diagnostic buffer along with its additional information.

You can also start an evaluation attempt for the displayed image. If processing is
successful, the detected code type and the result string are displayed. With a data
matrix code, you obtain further information on the total number of dots, the correct
and corrected dots and on the surrounding rectangles of objects detected in the
image.

Information Part 5/5: Device Info

This part of the dialog provides you with information on the processing unit, the
firmware, the sensor and the software.
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5.3.9 Maintain

Maintain code(s)

In this group box, you can deleted trained codes by selecting the relevant code
number from the drop-down list box and clicking on "Delete".

When you click the "Reset" button next to "Factory settings:" you reset all
parameters to their default values. The trained codes are also deleted.

Maintain processing unit

The "Save/Restore" button opens a Web page where you can save trained codes
and parameter assignments or load them on the processing unit again.

Note

When you load a code on the processing unit, the parameters saved with the code
are also loaded and therefore valid.

The "Firmware update" button opens a Web page where you can update the
firmware.

Note

If you control the VS 130-2/VS 130-2vcr from an automation system, make sure
that the DISA bit is not set during the firmware update. This prevents a
programmable controller from changing the processing unit to RUN.

5.3.10 Stop

When you call this dialog, you change the processing unit to STOP mode.
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54 Operator Control over Personal Digital Assistant (PDA)

541 Prerequisites

To be able to operate the Vision Sensor SIMATIC VS 130-2/VS 130-2vcr over a
PDA, the following requirements must be met:

e  WLAN-compliant PDA with the Windows Mobile 2003 operating system, for
example, Fujitsu-Siemens Pocket LOOX 610

e Macromedia Flash Player 6 is installed on the PDA

o Established connection between the PDA and the processing unit over a
WLAN router
How you establish this connection is described in Establishing a connection
between PDA and processing unit.

We recommend a work memory of 128 Mbytes or larger.

5.4.2 Establishing a Connection between PDA and Processing Unit

To establish a connection between PDA and processing unit, follow the steps
outlined below:

1. Install and configure your WLAN router.
You require an Ethernet connection between your PC and the router (for example,
Siemens Gigaset SE505 dsl/cable). Configure the router as DHCP server and, if
necessary, change its IP address. To set the configuration, you work in the user
interface of the router over a JAVA-compliant browser by entering the preset IP
address.

2. Configure the processing unit as a DHCP client.
You do this in the Connect> Ports> Ethernet> IP Mode menu by setting "DHCP".

3. Connect the WLAN router to the processing unit over an Ethernet cable and turn
the processing unit on. Then check the IP address assigned to the processing unit
by the router in the Connect> Ports> Ethernet> IP Address menu.

4. Enable Wireless LAN on your PDA.
Depending on the PDA, you will either have to install a wireless network adapter
or simply enable the Wireless LAN integrated on the PDA.
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5.4.3
1.
2.
5.4.4
Overview
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Starting or stopping setup support from the PDA

It is assumed that the connection between PDA and processing unit is established.
Proceed as follows:

Start the Internet Explorer on the PDA, enter the IP address in the "Address" input
box and then press "Enter".
The start page of the setup support appears.

Click on "Live image for PDA".
The user interface of the PDA for the VS 130-2/VS 130-2vcr appears.

Note

If you have started the user interface of the PDA, you can only run the setup
support from a PC/PG in read-only mode.

If you want to terminate the connection to the processing unit, turn off the PDA.
Closing the Internet Explorer does not terminate the connection.

User interface of the PDA

The user interface consists of the following elements:
e Liveimage
e Text display row

e Operator input row with the mode button, the "Trg" trigger button (VS 130-2vcr
only) and the code selection.

Note

If there is a connection between the Web browser of a PC and the processing unit
or the VS 130-2/VS 130-2vcr is being controlled by an automation system, all
buttons are disabled and "(Read Only Mode)" is displayed in the text display row.
As long as no physical connection can be established to the processing unit,
"Connecting..." is displayed.

The labeling of the buttons and their function depend on the current status of the
VS 130-2/VS 130-2vcr. This also applies to the strings of the text display row. This
is explained in detail below.
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Mode button

Current status of the |Label of the Mode |Meaning

Vision Sensor button

RUN -> Adjust Changes to the adjustment mode

Adjust -> Run Changes to the processing mode

STOP -> Adjust Changes to the adjustment mode

Train -> Adjust Changes to the adjustment mode

Error Acknowledge error |Acknowledges the error and exits the error
status

"Trg" trigger button

This button exists only with the VS 130-2vcr. It is enabled only when the
processing unit is in RUN.

If you click on this button, you simulate an external trigger signal.

Code selection

Using the "<" and ">" buttons, select a trained code with the settings you want to
use for the image processing.

Code selection is enabled only in the adjustment mode.

Text display row

Current status of the |Content of the text display row

Vision Sensor

RUN "Run:" + result string or "ReadErr (Nothing found)"
Adjust "Adjust: live" or "Adjust: read"

STOP "Stop"

Train "Stop”

Error "Error:" + Error number
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The text display in the Adjustment status of the Vision Sensor has the following
meaning:

"Adjust: live": No code could be decoded yet (corresponds to "Recognition:

running" on the setup support).

"Adjust: read": No currently read code could be decoded (corresponds to
"Recognition: successfully finished" on the setup support).

If an error occurs, an error number is output here. You will find the meaning in

the following table.

No. |Description Possible Remedies
0 The connected sensor type is Connect a sensor supported by
not supported. VS 130-2/VS 130-2vcr.
1 No sensor connected. Connect the sensor to the processing unit
correctly.
2 DISA changed at an invalid time |Check the sequence of applied signals. Start the
(during training) training again.
3 During training, the correct Check the sequence of applied signals. Start the
sequence of applied signals is  |training again.
not kept to.
4 The code could not be recreated. | Run the training again.
5 The send buffer is full because |Reduce the trigger frequency or process the
the data cannot be sent in an results more quickly on the server. A high load on
adequately short time, the network to which the processing unit is
connected can also block the transfer of the data.
If necessary, check the network connection.
6 The send buffer is full because |Reduce the trigger frequency or reduce the
the data cannot be sent in an amount of diagnostic data to be archived. Process
adequately short time or the the results on the server faster. A high load on the
server does not confirm receipt |network to which the processing unit is connected
of the data in good time can also block the transfer of the data. If
necessary, check the network connection.
7 The transfer of the last read Reduce the trigger frequency or process the
result is not yet completed, the |results more quickly.
next read result is, however, If necessary, change the transmission rate for the
already available, or the DP DP configuration or the update time for the
master or 10 controller does not [PROFINET configuration.
reply within the handshake
monitoring time (parameter
Connect >Ports >DP >Timeout
on processing unit or within the
time limit parameter in
PROFIBUS DP in Part 1/3: Ports
of the Connections dialog in the
setup support, parameter
Connect >Ports >PNIO
>Timeout on processing unit or
within the time limit parameter in
PROFINET IO in Part 1/3: Ports
in the "Connections" dialog in the
setup support).
8 The DP settings are not correct |Correct the DP settings.
9 No code was found in the image |Position the code within the image or improve the
during training. image quality.

5-52

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
A5E00475759-01




Operator Input

No. |Description Possible Remedies

10 |The trained code cannot be Adapt the match settings, or train a suitable code.
processed with the match
settings (for example
ID/separator not found)

11 | The code found during training |Use a code that complies with the standard.
does not comply with the ECC
200 standard.

12 |Error in PROFIBUS DP Make sure that the parameters for communication
communication. over PROFIBUS DP and the communication

partners are correctly configured and active. Check
the connection to the DP master.

13 |Connection error in Make sure that the connected TCP server or
communication over a TCP Ethernet RS-232 converter is correctly configured
connection or when using an and operational.

Ethernet RS-232 converter: Depending on the connected Ethernet RS-232

There is no TCP connection or  |converter, it can take up to 20 s before changes to

the data transfer cannot be the RS-232 settings or parameter changes for the

completed within the set time trigger source or the output of the result string to

limit. "TCP/RS232" take effect. During this time, the first
trigger of a processing cycle should not occur nor
should that be a change to RUN.

14  |Error in communication over the |Check the connection to the server.
archiving connection: There is no|Make sure that the data is processed by the server
TCP connection, the server does |in an adequately short time and that the protocol is
not respond within the set time |maintained.
limit or violates the archiving
protocol.

15 |The IR lighting unit is Reduce the trigger frequency or reduce the shutter
overloaded. speed.

Below you will see the maximum
trigger frequency fT for the
selected shutter speeds TB:

e TB=500ps: fT =60 Hz
e TB=1000 ps: fT =40 Hz
e TB=2000 ps: fT =20 Hz
e TB=3000ps:fT=13Hz
e TB=4000 ps: fT =10 Hz
e TB=5000ps:fT=8Hz
e TB=6000ps:fT=7Hz
e TB=7000ps:fT=6Hz
e TB=8000pus:fT=5Hz
e TB=9000ps:fT=4.5Hz
e TB=10000 ps: fT =4 Hz
Note: Trigger frequencies

> 33 Hz are not practicable.

16 |You are attempting to train code |Select a code number between 1 and 14.
number 15 over digital I/O or
PROFIBUS DP or PROFINET
10. This is, however, are
reserved for automatic learning.

18 |An error occurred in PROFINET |Make sure that the parameters for communication
I/O communication over PROFINET I/O and the communication

partners are correctly configured and active. Check
the connection to the I/O controller.

19 |An error occurred when saving |Contact Customer Support if this error occurs

to the read-only memory.

often.
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5.4.5 Known PDA problems

Two known PDA problems are described below:

e The cache is full after some time.
The Web browsers of some PDAs have the unwanted tendency to store more
and more data in the cache as time goes on without releasing the memory
again. As a result, the Web browser no longer runs.

e If you click the "Close" button, the Web browser is removed from the screen of
some PDAs but continues to run in the background. In conjunction with the first
problem explained above, this soon leads to memory overflow.

You can counter these problems with the measures described below. Follow the
order of steps below and following each step, check whether the memory used has
been released again. If it is released, the remaining steps are unnecessary.

—_

Exit the Web browser as follows: Start > Settings > "System" tab > Memory >
"Running Programs" tab, select "Internet Explorer" and click on the "Stop".

2. Internet Explorer: Tools > Options... > "Memory" tab, click on the "Delete Files"
button.

Turn the PDA off.

4. Run a soft reset on the PDA (usually by pressing a hidden button with a pen or
similar).

5. Run a hard reset on the PDA.
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6 Process Interface

6.1 Introduction

As an alternative to controlling from the operator panel or using the setup support,
you can also control SIMATIC VS 130-2/VS 130-2vcr from a programmable
controller. This makes it possible to train and work almost automatically.

Control over PROFIBUS DP and PROFINET 10 is only possible with the VS 130-2,
control over the I/O interface "DI/DQO", on the other hand, is possible with VS 130-2
and VS 130-2vcr.

Note

The automatic training and changing of codes by a programmable controller is only
possible with active setup support when in the "Options part 3/4: Security", the
check box "Take control" is not enabled for the current user.
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6.2

6-2

Integrating the DP slave VS 130-2 in HW Config

The supplied device master data file SIEM8111.GSD contains the PROFIBUS
properties of the VS 130-2 DP standard slave. If you are using a STEP 7 version
earlier than V5.3 SP1, the Vision Sensor VS 130-2 is not yet in the modules
catalog in HW Config. In this case, you must add it to the catalog with Options >
Install GSD... . Remember that the corresponding bitmap file VS1X0__ N.DIB must
be in the same folder as the GSD file.

You can download both files from the Internet at
http://support.automation.siemens.com/\WW/llisapi.dll?func=cslib.csinfo&lang=de&o
bjlID=10807086&amp;subtype=133100.

The Vision Sensor VS 130-2 then appears in the modules catalog under
PROFIBUS DP \ Additional Field Devices \ General \ Machine Vision
(see screenshot below).
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In the configuration example above, the control byte of the VS 130-2 was set to
output address 0 and the status byte of the VS 130-2 was set to input address 0 of
the CPU (DP master, slot 1). If these addresses are in the process image of OB1
(process image partition "OB1 PI"), you can work here in OB1 with process image
access (for example "A 10.6" or "S QO0.1"). If this is not the case, you must work
with direct I/O access (for example "L PIB 0").

In the configuration example above, the start of the 16 word long consistent
communication area of the Vision Sensor VS 130-2 was set to input address 1 and
output address 1 (slot 2). If these addresses are in the process image of OB1
(process image partition "OB1 PI"), you can work here in OB1 with process image
access (e.g. "L EW 2", "T AB 1"), without violating the consistency (This is only
valid for CPUs which transfer consistent user data per process image, see the note
below). If, on the other hand, these addresses are not in the process image of
OB1, you must access the communication area of the VS 130-2 using SFCs 14
"DPRD_DAT" and 15 "DPWR_DAT" to ensure consistency.
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Note

The consistent user data transfer per process image is supported by the following
S7 CPUs:

« from the CPU 318 and S7-400 CPUs as of firmware version V3.0.0
o from all S7-300 CPUs with MMC

for all other S7-300 and S7-400 CPUs, the mandatory installation of SFCs 14
"DPRD_DAT" and 15 "DPWR_DAT" is required.

The Vision Sensor VS 130 -2 detects the transmission rate on PROFIBUS
automatically. Even if the transmission rate has changed, this is detected
automatically. The following values possible:

e 9.6 Kbps

e 19.2 Kbps
e 4545 Kbps
e 93.75 Kbps
e 187.5 Kbps
e 500 Kbps

e 1.5 Mbps

e 3 Mbps

e 6 Mbps

e 12 Mbps

The PROFIBUS address of the VS 130-2 is set in the Settings > Ports > DP Addr.
menu of the processing unit. Possible values are 1, ... 125.

Changing the PROFIBUS address via PROFIBUS is not supported.

If you assign parameter values to the Vision Sensor VS 130-2 via PROFIBUS, you
can only set its default values (all zero). If you enter values other than zero here, a
slave diagnostic message is generated ("Invalid DP parameters"). If you use an S7
CPU as the DP master, a diagnostic interrupt is triggered (no OB82 start because
the CPU is in STOP): "Faulty module" is entered in the diagnostic buffer and the
"SF" LED lights up.

If you encounter problems when integrating in HW Config, you will find information
on possible causes in Product description and Important Requirements for
Installation.
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6.3

6-4

Integrating the PROFINET 1/O Device VS 130-2 in
HW Config

You will find the PROFINET properties of the I/O device VS 130-2 in the supplied
GSDML-V1.0-Siemens-VS130-2-20041021.xml (General Station Description) file. If
you are using a STEP 7 version earlier than V5.4, the Vision Sensor VS 130-2 is
not yet in the modules catalog in HW Config. In this case, you must add it to the
catalog with Options > Install GSD... . Remember that the corresponding bitmap
file VS100.bmp must be in the same folder as the GSD file.

You can download both files from the Internet at
http://support.automation.siemens.com/WW!/llisapi.dll?func=cslib.csinfo&lang=de&o
bjlID=10807086&amp;subtype=133100.

The Vision Sensor VS 130-2 is in the modules catalog under PROFINETIO \
General \ VS100 (see screenshot below).
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In the configuration example above, the control byte of the VS 130-2 was set to
output address 0 and the status byte of the VS 130-2 was set to input address 0 of
the CPU (DP master, slot 1). If these addresses are in the process image of OB1
(process image partition "OB1 PI"), you can work here in OB1 with process image
access (for example "A 10.6" or "S Q0.1"). If this is not the case, you must work
with direct I/O access (for example "L PIB 0").

In the configuration example above, the start of the 16 word long consistent
communication area of the Vision Sensor VS 130-2 was set to input address 256
and output address 256 (slot 2). If these addresses are in the process image of
OB1 (process image partition "OB1 PI"), you can work here in OB1 with process
image access (e.g. "L EW 2", "T AB 1"), without violating the consistency (This is
only valid for CPUs which transfer consistent user data per process image, see the
note below). If, on the other hand, these addresses are not in the process image of
OB1, you must access the communication area of the VS 130-2 using SFCs 14
"DPRD_DAT" and 15 "DPWR_DAT" to ensure consistency.
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Note

The consistent user data transfer per process image is supported by the following
S7 CPUs:

+ from the CPU 318 and S7-400 CPUs as of firmware version V3.0.0
« from all S7-300 CPUs with MMC

for all other S7-300 and S7-400 CPUs, the mandatory installation of SFCs 14
"DPRD_DAT" and 15 "DPWR_DAT" is required.

The Vision Sensor VS 130 -2 detects the transmission rate on PROFINET
automatically. PROFINET is operated in 100 Mbps full duplex mode.

Follow the procedures below when entering the device name for the
VS 130-2/VS 130-2vcr:

Step Activity

1 In HW Config, open the properties window of the VS 130-2 and enter the device
name there. When you are done, save and compile the hardware configuration.

2 Inform the VS 130-2 of the device name you just specified. This is done in three

ways:

e In HW Config, select PLC > Ethernet > Assign Ethernet Address... and click
the "Browse" button. Following this, all the devices connected to the PNIO
system will be displayed (Caution: VS 130-2 must be in IP mode "PNIO"
otherwise it is not displayed!). Select the VS 130-2 using its MAC address
and identify it, if need be, using the "Blink" button (The "LINK" LED will blink
at the Ethernet connector on the VS 130-2.). Enter the device name and
click on the "Assign Name" button.

e Enter the device name directly in the processing unit (Connect > Ports >
PNIO > Devname).

e Assign and transfer the device name using the applet (Connections
Part 1/3: Ports, PROFINET IO, Device name parameter).

Note

When installing a CPU 317-2 PN/DP, in the individual network in the Properties
window of the PROFINET I/O system (slot X2) on the "Options" tab, you have to
select "Transmission medium/duplex": "Automatic Settings"

Attention

VS 130-2 does not support an update time less than 4 ms and cannot be set to
lower update times. If you are setting up the configuration with STEP 7 V5.3 +
SP1, the minimum update time for all PROFINET IO devices of the affected
PROFINET system changes to 4 ms.
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6.4

6.4.1

Control Via the "DI/DO" I/O Interface

Control Signals

You will find the pin assignment of the "DI/DQO" I/O interface in Port pin Assignment
of the Processing Unit.

Input signals

Name |Function
DISA Disable: Disable manual control panel input, code selection and train via digital
I/O, error acknowledgment, start of the processing unit
SELO Select 0: Code selection bit 0
SELA1 Select 1: Code selection bit 1 (if TRN=0) / train code (if TRN=1)
SEL2 Select 2: Code selection bit 2
SEL3 |[Select 3: Code selection bit 3
TRN Train: Train new code
TRG Trigger : An evaluation is started on the positive-going edge
RES Reset: Reset error
Note
The SELO, SEL1, SEL2, SEL3, TRN and RES signals only take effect when
DISA=1.
Output signals
Name |Function LEDs
IN_OP |In operation: Group error
e 0 =error message is displayed. e SFon
e 1 =SIMATIC VS 130-2/VS 130-2vcr functional, no errors |e  SF off
TRD Trained: TRAINED
e InRun:
0 = selected code has not been trained
1 = selected code has been trained
e In Training (TRN=1):
0 = training active
1 = acknowledgment signal (RDY=0)
RDY Ready: READY
e 0= Device startup or SIMATIC VS 130-2/VS 130-2vcr in
Stop
e 1=S8SIMATIC VS130-2/VS 130-2vcr in run
READ |Evaluation result: Code was localized and decoded READ
MATCH | Evaluation result: Code matches learned code MATCH
N_OK  |Code was not legible. N_OK

6-6
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6.4.2 Selecting the Mode

You can use the following modes:
e Select Code
e Train Code

e Start Processing
You will find a description of the modes in Working with the Processing Unit.

Select Code

To select a code, apply the appropriate bit pattern to the inputs SELO to SEL3. You
can select codes 1 to 15. If you select code 0, the last selected code is retained.

SELO

SEL1

SEL 2

SEL3

DisA

RES

TRN

TRG

IN_OP

TRD

RDY

Start or change of Apply sslectsd
salactad code code

*— 150ms —H

4— 150ms - Max 158 —
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6-8

Step Input Output Description
1 DISA=1 Prepare code selection
TRN=0 DISA must have the value 1 for this. No edge
TRG=0 change is required, however.
RES=0
2 SELO=1 Select code (based on example of code 11)
SEL1=1
SEL2=0
SEL3=1
3 TRD=0 The code changeover is started
RDY=0
4 TRD=1 The code selection is confirmed after 150 ms.
RDY=0 Code 11 is selected.
5 TRD=1 The code changeover is completed after a time of
RDY=1 approximately 150 ms to 15 s.
Note

If the selected code has not been trained, TRD and RDY retain the value 0.
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Train Code

The diagram below illustrates an example of the training sequence for code 11.
Note that the trigger signal must be applied for at least 5 ms.

SELO

SEL1

SELZ

SEL 3

DIsA

RES

TRN

TRG

Ihe_op

TRD

ROY

3100 mg

Input Signals

~T Qutput signals

Start training

150 ms
Plininllllis

150 ms - 158
—

Training complated

Note

After an error has occurred, you must set the signals SELO to SEL3 and the signal
TRN to 0 and then reset the error with the RES signal. The DISA signal must have
a value of 1 (no edge change).
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The training sequence is described below.

Step Input Output Description
1 DISA=1 Disable button input. DISA must have the value 1
for this. An edge change is not required.
Apply for at least 100 ms:
SEL0=1 Select the code to be trained (based on example of
SEL1=1 code 11)
SEL2=0
SEL3=1
2 TRN=1 Start training
SELO, SEL1, SEL2, SEL3=0
TRD=0 TRD signal changes to FALSE
RDY=0 RDY signal changes to FALSE
3 Wait at least 200 ms Feed object with code
SEL1=1 Train
Apply for at least 5 ms: Trigger signal
TRG=1
4 TRD=1 Selected code has been trained
SEL1=0 Reset signals
5 TRN=0 End training
TRD=0 TRD signal changes to FALSE (for 150 ms)
TRD=1 TRD signal changes to TRUE
RDY=1 Training is ended

Start Processing

Processing is started immediately after completion of training.

Step Input Output Description
1 If required, you select a code (see above).
2 The outputs are set as follows depending on the evaluation
result:
READ Code was localized and decoded.
MATCH Code matches learned code.
N_OK Code was not legible.

6-10
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6.5

6.5.1

Control over PROFIBUS DP and PROFINET IO

File Transfer Principle over PROFIBUS DP and PROFINET IO

The following block diagram shows the relevant interfaces of the processing unit for
data transmission over PROFIBUS DP and PROFINET I/O.

DP-Master[/0-Controller Processing Unit

o[ | Contol Byte

[ status Byte

‘Sard” user
data
interface"
(32 bytes)

‘Recaive”
uger dats
¥ interface’
(32 byles)

Note

Of the "Send" user data interface, bytes 1 to 31 are relevant, of the "Receive" user
data interface, only bytes 1 and 4 are relevant.

If these two user data interfaces are not located in the process image of OB1, you
must use SFC 14 "DPRD_DAT" during the data transfer from the "Send" user data
interface of the processing unit to the DP master to ensure data consistency. In the
opposite direction, SFC 15 "DPWR_DAT" must be used for data transmission from
the DP master to the "Receive" user data interface.
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6.5.2 Assignments for PROFIBUS DP and PROFINET IO-relevant
Interfaces for the Processing Unit

Control byte

Bit No. |Corresponds to Signal |Function
0 DISA Disable: Disable manual control panel input, code selection and train,
error acknowledgment, start of the processing unit
1 SELO Select 0: Code selection bit 0
2 SEL1 Select 1: Code selection bit 1 (if TRN=0) / train code (if TRN=1)
3 SEL2 Select 2: Code selection bit 2
4 SEL3 Select 3: Code selection bit 3
5 TRN Train: Train new code
6 TRG Trigger : An evaluation is started on the positive-going edge
7 RES Reset: Reset error
Note

The SELO, SEL1, SEL2, SEL3, TRN and RES signals only take effect when

DISA=1.

Status byte

Bit No. |Corresponds to Signal |Function
0 IN_OP In operation:
e 0 =error message is displayed.
e 1 =SIMATIC VS 130-2 functional, no errors
1 TRD Trained:
e InRun:
0 = selected code has not been trained
1 = selected code has been trained
e In Training (TRN=1)
0 = training active
1 = acknowledgment signal (RDY=0)
2 RDY Ready:
e 0 =device startup or SIMATIC VS 130-2 in Stop
e 1 =S8IMATIC VS 130-2C in Run
3 READ Evaluation result: Code was localized and decoded
4 MATCH Evaluation result: Code matches learned code
5 N_OK Code was not legible.
6 - Reserved
7 - Reserved
Note

Writing the control byte and reading and evaluating the status byte must be
analogous to the time diagrams in Selecting Modes.

6-12
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"Send" User Data Interface

Byte No. |Meaning

0 Reserved

1 Consecutive number of the data packet to be sent to the DP master or I/O controller

2 Net total length of the data to be transmitted in bytes (in STEP 7 format)

3

4 Data ID of the supplied data

5 1. User data byte

31 27. User data byte
Note
The "data ID of the supplied data" defines the transferred data. The coding
corresponds to byte 4 of the "Receive" user data interface (refer to the relevant
paragraph). In a read job, the ID of the currently transferred data is entered.

"Receive" user data interface

Byte No. Meaning

0 Reserved

1 Consecutive number of the current correct data packet to be sent to the DP master.

2 Reserved

3 Reserved

4 Data ID of the requested data

5 Reserved

31 Reserved
The "data ID of the requested data" defines the data to be read. It can have the
following values:

ID (B#16#) |Meaning

09 User data byte 1: Output code number selected on VS 130-2
User data byte 2: If the DISA bit is set, you can see whether a user is logged on over the
setup support who has permission to override the DISA signal: 00H: "Take control" is
activated, 01H: "Take control" is deactivated

81 Result string

82 Quality characteristics absolute

83 Quality characteristics as absolute values and result string

84 Quality characteristics in classes

85 Quality characteristics in classes and result string

Vision Sensor
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ID (B#16#) |Meaning
86 Quality characteristics in classes and quality characteristics absolute
87 Quality characteristics in classes, quality characteristics absolute and result string
88 Position of the data matrix code
89 Position and result string
8A Position and quality characteristics absolute
8b Position, quality characteristics as absolute values and result string
8c Position and quality characteristics in classes
8D Position, quality characteristics in classes and result string
8E Position, quality characteristics in classes and quality characteristics absolute
8F Position, quality characteristics in classes, quality characteristics absolute and result string
If no data ID is entered, the code is processed but no data is transferred.
No trigger is required for the data ID B#16#09.
The following table shows which content and which data types are returned when
the data ID contains the position or the quality characteristics. The order of the
code characteristics in the table is identical to the order of code characteristics in
the data package. If applicable, the result string is shown following the code
characteristics.
Data to be read consisting of ... Data type of each
component
Position of the data matrix code |s X position INT
e Y position
e Rollangle
e View angle
Quality characteristics absolute |e Symbol contrast REAL
e  Print growth
e  Axial non-uniformity
e Unused error correction
Quality characteristic as classes |¢  Symbol contrast CHAR
e  Print growth
e Axial non-uniformity
e Unused error correction
e Overall quality

6-14

Note

If the data to be read contains the absolute quality characteristics, note the value of
the "Swap" parameter (in setup support in the task Connections Part 1/3 Interfaces
in PROFIBUS DP or PROFINET 1/O) or "Swap" (on the processing unit Connect >
Ports > DP menu or Connect Ports PNIO).
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6.5.3

Sample program for data exchange if code length <= 27 bytes

Below, you will see an example program for data exchange when the code length
is a maximum of 27 bytes.

Note
The example program is only executable on the following S7 CPUs:

« onaCPU 318 and the S7-400 CPUs as of firmware version V3.0.0
« on S7-300 CPUs with MMC

for all other S7-300 and S7-400 CPUs, you have to use the SFC 14s and 15s for
all access to both user data interfaces.

Program information

Only the pure result string is output (data ID B#16#81).

The DP master or I/O controller does not check how many bytes the processing
unit has supplied, but always reads 27 bytes without any monitoring.

The start of the "Send" user data interface is at address 4 of the process image
input table. The start of the "Receive" user data interface is at address 4 of the
process image output table.

To ensure consistency over the entire range (32 bytes) there must be no process
image update during the program shown below.

The user data are stored in data block DB17 starting at byte 4.
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STL program

//[Enter data ID (only necessary in the first cycle)
L B#16#81 // Only result string
M QB 8
/I check no. of data packet for 1
L IB5 /I no. of data package from processing unit
L 1
<> | // If no. not 1
JC m001 /I ... there is then no user data
/l read user data from processing unit
L ID9 /l read the first 4 bytes of user data
M DB17.DBD 4 // enter in DB
L ID 13 // read the next 4 bytes of user data
M DB17.DBD 8 / enter in DB
L ID 17 // read the next 4 bytes of user data
M DB17.DBD 12 /l enter in DB
L ID 21 /l read the next 4 bytes of user data
M DB17.DBD 16 // enter in DB
L ID 25 // read the next 4 bytes of user data
M DB17.DBD 20 // enter in DB
L ID 29 // read the next 4 bytes of user data
M DB17.DBD 24 // enter in DB
L IW 33 / read the last but 2 bytes of user data
M DB17.DBW 28 / enter in DB
L IB 35 /| Read the last byte of user data
M DB17.DBB 30 // enter in DB
I/l acknowledge with no, of data packet
mO001: L IB5 /I no. of data packet
M QB 5 // send as acknowledgment to the processing unit
BEU
Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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6.5.4 Programming the Data Block

Handshaking

The following section introduces a handshake mechanism that ensures the
consistency of all the data sent from the processing unit to the DP master or

I/O controller regardless of any configured PROFIBUS or PROFINET consistency
mechanisms. This mechanism must be used for every transfer, even when this is
only from one data block, for example, when reading out the code number selected
on the VS 130-2.

Please remember to enter the required data ID in byte 4 of the "Receive" user data
interface before the first transfer.

Note
Handshaking is executable in the specified form only on the following S7 CPUs:

« onaCPU 318 and the S7-400 CPUs as of firmware version V3.0.0
e« on S7-300 CPUs with MMC

for all other S7-300 and S7-400 CPUs, you have to use the SFC 14s and 15s for
all access to both user data interfaces.

Step Activity in the DP Master or I/O Controller User Program

1 Query byte 1 of the "Send" user data interface cyclically. As long as this byte has the value
0, there is no new data. If it has the value 1, go to step 2.

2 The value 1 in byte 1 of the "Send" user data interface means: VS 130-2 has started data
transfer.

Read the net total length of the data to be transferred from bytes 2 and 3 of the "Send" user
data interface and the user data of the first data packet from bytes 5 to 31.

3 Acknowledge correct receipt of the first data packet by writing the value 1 in byte 1 of the
"Receive" user data interface.

The processing unit polls byte 1 of the "Receive" user data interface. As soon as it reads the
value 1, it fills bytes 5 to 31 of the "Send" user data interface with the user data of the
second data packet and enters the number of this data package (in this case 2) in byte 1.

4 Query byte 1 of the "Send" user data interface cyclically. As long as this still contains the
number of the previously transferred data packet (1), there is no new data. As soon as byte
1 has the value 2 (number of the next data packet), go to step 5.

5 Read the user data of the second data packet from bytes 5 to 31.

6 Acknowledge correct receipt of the second data packet by writing the value 2 in byte 1 of the
"Receive" user data interface.

Last -4 Query byte 1 of the "Send" user data interface cyclically. As long as this contains the number
of the last but one data packet, the data of the last data packet is not yet available. As soon
as byte 1 has the number of the last data packet, go to next step.

Last-3 Read the user data of the last data packet from bytes 5 to 31.
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Step Activity in the DP Master or /O Controller User Program

Last-2 Acknowledge receipt of the last data packet by writing the number of the last data packet in
byte 1 of the "Receive" user data interface.
The processing unit polls byte 1 of the "Receive" user data interface. As soon as it reads the
number of the last data packet, it writes the value 0 to bytes 2 and 3 of the user data
interface and also to byte 1. The value 0 in byte 1 signals the end of the current data transfer
to the DP master.

Last - 1 Query byte 1 of the "Send" user data interface cyclically. As soon as the value 0 is read, go
to last step.

Last Acknowledge correct receipt of all data by writing the value 0 in byte 1 of the "Receive" user
data interface.

Response to Problems, Time-outs, and Errors

6-18

The processing unit monitors the following:

e The time between the arrival of two acknowledgments from the DP master is
monitored for the time-out set in the Connect > Ports > DP > Timeout or
Connect > Ports > PNIO > Timeout menu.

e The correct sequence of the acknowledged data packets of the DP master or
I/O controller is monitored.

If an error occurs, the processing unit enters B#16#FF in byte 1 of the "Send" user
data interface and so aborts the current data transmission.

It is advisable to implement the following monitoring functions in the user program
of the DP master or I/O controller:

¢ Monitoring of the time between arrival of two consecutive data packets.
e Monitor the correct order of the data packets sent by the processing unit.

o Check whether the total length of the user data actually transferred matches
the net total length of data to be transferred as specified by the processing unit
at the start of the data transfer.

If an error occurs, writing B#16#FF to byte 1 of the "Receive" user data interface
causes the current data transmission to be aborted.
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6.5.5 FB 79 "VS130-2_CONTROL"

Description

With FB 79 "VS130-2_CONTROL", you have a convenient means of
communication with SIMATIC VS 130-2. You simply specify the job and the block
handles communication over the public interfaces described in Integrating the
PROFINET IO Device VS 130-2 in HW Config.

The following bits of the control byte must be processed outside the FB.
e TRG (Trigger): Start Processing

e RES (Reset): Acknowledgment of an error (see Error Messages)

The FB monitors only the pure data traffic between VS 130-2 and the controller, in
other words, the DONE parameter does not provide any information on the actual
read result. To obtain a good/bad read evaluation, evaluate the following result bits
of the status byte:

e READ
e MATCH
¢ NOK

The following tasks are possible:

e Abort the current job

e Select Code

e Train a code

e  Output the result string

e Output the position of the code

e Output the quality characteristics of the currently read code
e Output the number of the currently selected code

e Output the current mode of the VS 130-2

¢ Reset the DISA control signal

Whether or not a job can be correctly executed depends on the current mode of the
VS 130-2 and its parameter assignment. Which job is possible in which mode of
the VS 130-2 is explained below.

For almost all tasks, FB79 sets the DISA control signal for the VS 130-2 to TRUE.
This prevents the VS 130-2 from being controlled from the keyboard or an operator
panel at the same time. The exceptions are the four following tasks:

¢ Reset the DISA control signal
e Abort the current job. The FB does not change DISA.

e Output the number of the currently selected code. The FB does not change
DISA.

e  Output the current mode of the VS 130-2. The FB does not change DISA.
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At the start of the new job, the output parameters are reset.
Caution: A multiple FB79 call with the same instance is not permitted.

Please note that with the parameters of the page "Connections Part 3/3:
Integration" (setup support) or the "Connect > Integrate" menu (processing unit),
you can influence the processing of the FB:

e If you want to use the FB to read a result string, the output of the result string
must be set on PROFIBUS DP or PROFINET IO. For the jobs "Change code"
(COMMAND =W#16#0001), "Train code" (COMMAND =W#16#0002) and
"Output the currently selected code" (COMMAND =W#16#0003, the number of
the selected code is requested by the processing unit. The output of the result
string must therefore be set on the PROFIBUS DP or PROFINET 10O for this
reason.

e The ports for the DISA, SELO to SEL3, TRN, RES, IN_OP, TRD, RDY signals
must always be set to PROFIBUS DP or PROFINET IO.

e The port setting for the result bits READ, MATCH, NOK is irrelevant for the FB.

Note

If you use the FB, only the bits RES and TRG may be affected by your program in
the control byte of the processing unit. All other bits of the control byte are affected
by the FB.

How It works

FB79 "VS130-2_CONTROL" operates asynchronously; in other words, execution
can extend over several FB calls. You start execution of the job by calling the FB
with a job number higher than 0 .

Execution of the job is completed when ACTIVE takes on the value FALSE and
either DONE or ERROR takes on the value TRUE (positive-going edge). Please
remember that various jobs are handled in one CPU cycle and therefore ACTIVE
does not take on the value TRUE. This applies to the jobs "Read out mode" and
"Reset DISA bit". In some cases, it may also not be possible to detect an edge
change at DONE or ERROR.

You should therefore evaluate the DONE and ERROR parameters at each block
call. If the job was completed without error, DONE = TRUE. You should also
evaluate ERRCODE, in this case, to be informed of warnings from the FB.

As long as ACTIVE has taken on the value TRUE, you have to call the FB with
identical assignment of the COMMAND input parameters. During this time, is also
not possible to start a new job.

Read jobs are cyclical jobs. This means that after starting a job with
COMMAND=W#16#0081 to 008F, ACTIVE takes on the value TRUE. ACTIVE
retains this value as long as the job is aborted.
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The respective read cycle (that is, the transfer of a complete result string) is
complete when ACTIVE takes on the value TRUE and either DONE or ERROR has
taken on the value TRUE (positive-going edge). If you want to start an additional
job while a read job is running, you have to abort the read job. This occurs by
calling the FB with COMMAND=W#16#0000. In this case, ACTIVE does not take
on the value FALSE. Depending on whether a result string is being transferred or
not, either DONE or ERROR takes on the value TRUE. If ERROR takes on the
value TRUE, ERRCODE does not take on the value DW#16#00010007.

Note

If an error occurs, set the processing unit to the STOP mode, correct and
acknowledge the error. You can then set the processing unit back to RUN mode
with a code change in a trained code (COMMAND = W#16#0001).

Parameters
Parameter |Declaration |Data type |Address Default Description
(instance DB) |setting
LADDR_ INPUT WORD 0.0 W#16# 0000 |Address of the control byte of
STEUER the VS 130-2
The address has to be in the
process image of the used CPU.
LADDR_ INPUT WORD 2.0 W#16# 0000 |Address of the status byte of the
STATUS VS 130-2
The address has to be in the
process image of the used CPU.
LADDR_ INPUT WORD  [4.0 W#16# 0000 | Start address of the "Send" user
SEND data interface of VS 130-2
LADDR_ INPUT WORD 6.0 W#16# 0000 | Start address of the "Receive"
RECV user data interface of VS 130-2
COMMAND | |NPUT WORD 8.0 W#16# 0000 |Job number
The permitted values are
described following the table.
PARAM1 INPUT BYTE 10.0 B#16#00 Number of the code to be
selected (relevant only for the
jobs W#16#0001 and
W#16#0002)
RESET INPUT BOOL 11.0 FALSE Reset pending errors and
initialize FB
RECV INPUT ANY 12.0 Receive area for the result
string. Only the data block area
and the BYTE data type are
allowed.
You have to switch these
parameters and the data block
has to be at least as large as
the maximum expected DMC
string.
ACTIVE OUTPUT  |BOOL 22.0 FALSE ACTIVE=TRUE: Processing of
the last job is not yet completed.
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Parameter

Declaration

Data type

Address
(instance DB)

Default
setting

Description

DONE

OUTPUT

BOOL

221

FALSE

DONE=TRUE: Job completed
without error.

This means that the transfer
between processing unit and FB
(CPU) was successfully
completed error-free for read
jobs, (COMMAND =
W#16#0081 to 008F). In order
to find out if the DMC evaluation
was successful, you have to
evaluate the bits READ (Bit 3),
MATCH (Bit 4) and N_OK (Bit 5)
in the status byte of the
processing unit.

Error

OUTPUT

BOOL

22.2

FALSE

ERROR=TRUE: An error has
occurred.

ERRCODE

OUTPUT

DWORD

24.0

DW#16#
00000000

Error information:

e  DW#16#0000 0000:
No error

o  DW#16#0000 wxyz:
Warning

o  DW#16#0001 wxyz:
FB-internal error

o  DW#16#0002 wxyz:
Processing unit error

(refer to the error information
table at the end of this section)

STATE

OUTPUT

WORD

28.0

W#16# 0000

Mode of the VS 130-2:

o  W#16#0000: Mode not up
to date

o  W#16#0001:
RUN (processing mode
with output of the result
string), in other words, bits
IN_OP and RDY are set in
the status byte.

o W#16#0002:
STORP (incl. training and
adjust mode), in other
words, bit IN_OP is set in
the status byte, bit RDY,
however, is not.

e W#16#0003:
ERROR, in other words, bit
IN_OP is not set in the
status byte

CODE_OuUT

OUTPUT

BYTE

30.0

B#16#00

No. of the code currently set on
the VS 130-2

LENGTH

OUTPUT

WORD

32.0

W#16# 0000

Length of the result string in
bytes

6-22
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Permitted values for the COMMAND parameter

Value Meaning

(W#16#...)

0000 Abort current job or no job

0001 Change code

0002 Train Code

0003 Output number of the code currently selected on the VS 130-2

0004 Qutput current mode of the VS 130-2.

0005 Reset DISA control signal

0081 Output the result string that may have been modified

0082 Output absolute quality characteristics

0083 Output absolute quality characteristics and result string

0084 Qutput quality characteristics as grades

0085 Output quality characteristics as grades and output result string

0086 Output quality characteristics as grades and absolute

0087 Qutput quality characteristics as grades and absolute and output result string

0088 Output code position

0089 Qutput code position and result string

008A Output code position and output absolute quality characteristics

008B Qutput code position and output absolute quality characteristics and output result string

008C Qutput code position and output quality characteristics as grades

008D Output code position and output quality characteristics as grades and output result
string

008E Output code position and output quality characteristics as grades and absolute

008F Output code position and output quality characteristics as grades and grades and
output result string
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Parameters not Interconnected with the Block (static local data):

Parameter

Declaration

Data type

Address
(instance DB)

Default
setting

Description

X_POSITION

STATIC

INT

34.0

0

X coordinates of the code mid
point relative to the image mid
point (normalized to image
size 640*480)

Y_POSITION

STATIC

INT

36.0

Y coordinates of the code mid
point relative to the image mid
point (normalized to image
size 640*480)

ROT_ANGLE

STATIC

INT

38.0

Roll angle of the code mid
point relative to the image mid
point (normalized to image
size 640*480)

INCLINE

STATIC

INT

40.0

View angle (angle between
sensor axis and the surface of
the code field)

CONTRAST_F

STATIC

CHAR

42.0

Symbol contrast as class
(value valid if not ' ")

GROWTH_F

STATIC

CHAR

43.0

Print growth as class (value
valid if not'")

NONUNIF_F

STATIC

CHAR

44.0

Axial non-uniformity as class
(value valid if not ' ")

ERR_CORR_F

STATIC

CHAR

45.0

Unused error correction as
class (value valid if not'")

QUALITY_F

STATIC

CHAR

46.0

Overall quality as class (value
valid if not ' ")

CONTRAST

STATIC

REAL

48.0

-1.0e+0

Symbol contrast as absolute
value (value valid if not -
1.0e+0)

GROWTH

STATIC

REAL

52.0

-1.0e+0

Print growth as absolute value
(value valid if not -1.0e+0)

NONUNIF

STATIC

REAL

56.0

-1.0e+0

Axial non-uniformity as
absolute value (value valid if
not -1.0e+0)

ERR_CORR

STATIC

REAL

60.0

-1.0e+0

Unused error correction as
absolute value (value valid if
not -1.0e+0)
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When can you execute which job?

Whether or not a job can be correctly executed depends on the current mode of the
VS 130-2. The following table shows which job is possible in which mode of the
VS 130-2. You will find the job number in the parameter table.

Mode VS 130-2 Job No. = (hexadecimal)
0000 0001 0002 0003 0004 0005 0081 to
008F
RUN (RDY=1) X X X X X X X

(processing mode with
output of the result

string)
STOP X X X X X X -
ERROR (IN_OP=0) X X - X X X -

Sequence when Aborting a Job (COMMAND = W#16#0000)
You can only abort read jobs:
¢ Read jobs (COMMAND = W#16#0081 to W#16#008F )
The block signals completion of the job abort with ACTIVE = FALSE.

If a transfer is active when the job is aborted, the transfer is aborted and the error
signaled with a suitable error message in the ERRCODE parameter. ERROR has
the value TRUE and DONE has the value FALSE. A transfer is active if DONE and
ERROR take on the value FALSE.

Is no transfer is active at the time of the abort, on completion of the job of the
ERRCODE parameter has value 0, ERROR has value FALSE, and DONE has
value TRUE.

Procedure for job change

If reading is currently selected and you want to execute a different job, you must
stop the currently active job (see above).

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
A5E00475759-01 6-25



Process Interface

Sequence When Changing Codes (COMMAND = W#16#0001)
If the VS 130-2 is currently executing a read job, follow the steps below:

1. Call FB79 with COMMAND=W#16#0000. This stops output of the result string (job
W#16#0081).

2. Make a code change by calling FB79 with COMMAND=W#16#0001 and PARAM=
new code number.
When the job is started, the parameters DONE and ERROR have the value
FALSE. The ACTIVE parameter changes to the value TRUE.
The block changes the code selected on the VS 130-2 to the value specified in the
PARAM1 parameter.
It then queries the code currently selected on the VS 130-2 and outputs this in the
CODE_OUT parameter.
If the currently selected code matches the code specified in the PARAM1
parameter, the ACTIVE parameter has the value FALSE and the DONE
parameter the value TRUE.
If the currently selected code does not match the code specified in the PARAM1
parameter, the ACTIVE parameter has the value FALSE and the ERROR
parameter the value TRUE. The ERRCODE parameter contains an appropriate
error message.
There is also a check to determine if the code change has been blocked by a
"Service" or "User1" user logged on via the setup support who has taken control of
the VS 130-2 and if the newly selected code has been trained. If an error is
detected, the ACTIVE parameter changes to the value FALSE and the ERROR
parameter changes to the value TRUE. The ERRCODE parameter contains an
appropriate error message.

3. Call FB79 again cyclically with COMMAND= W#16#0081.

If you attempt to cancel during an ongoing code change, the ERRCODE parameter
takes the value DW#16#00000002 but the job is processed until the end.

Note

When the code is changed, the processing unit is set to STOP for at least 150 ms
(see Selecting Modes "Select code"). In exceptional cases, a code change can
take up to 15 seconds.

If you specify the value 0 for the PARAM1 parameter, the previously selected code
is retained.

The value of PARAM1 cannot be changed before the job is completed.

Note

The following parameters must be set to PROFIBUS DP or PROFINET 1O to
process the job:

e Output the result string
« Port for the DISA, SELO to SEL3, TRN, RES, IN_OP, TRD, RDY signals
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Sequence When Training a Code (COMMAND = W#16#0002)

To allow the FB to trigger training a code, the Connect > Integrate > Control
parameter must either have the value "DP" or the value "PNIO" on the processing
unit.

The job can only be sent when VS 130-2 is not in ERROR mode (refer to the mode
table following the parameter table).

When the job is triggered, the parameters DONE and ERROR change to the value
FALSE. The ACTIVE parameter changes to the value TRUE.

The block trains the code specified by the PARAM1 parameter.

Note
In exceptional cases, training a code can take up to 35 seconds.

The value of PARAM1 cannot be changed before the job is completed.

It then queries the code currently selected on the VS 130-2 and outputs this in the
CODE_OUT parameter.

If the currently selected code matches the code specified in the PARAM1
parameter, the ACTIVE parameter has the value FALSE and the DONE parameter
the value TRUE.

If the currently selected code does not match the code specified in the PARAM1
parameter, the ACTIVE parameter has the value FALSE and the ERROR
parameter the value TRUE. The ERRCODE parameter contains an appropriate
error message.

There is also a check to determine if the training has been blocked by a "Service"
or "User1" user logged on via the setup support who has taken control of the

VS 130-2 and if the training has been successful. If an error is detected, the
ACTIVE parameter changes to the value FALSE and the ERROR parameter
changes to the value TRUE. The ERRCODE parameter contains an appropriate
error message.

If you attempt to cancel during an ongoing training job, the ERRCODE parameter
takes the value DW#16#00000002 but the job is processed until the end.

Note

The following parameters must be set to PROFIBUS DP or PROFINET IO to
process the job:

e Output the result string
o Port for the DISA, SELO to SEL3, TRN, RES, IN_OP, TRD, RDY signals
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Sequence When Outputting the Currently Selected Code
(COMMAND = W#16#0003)

When the job is triggered, the parameters DONE and ERROR change to the value
FALSE. The ACTIVE parameter changes to the value TRUE.

The block then queries the code currently selected on the VS 130-2 and outputs
this in the CODE_OUT parameter.

If the transfer of the code number is free of errors, the ACTIVE parameter changes
to the value FALSE and the DONE parameter changes to the value TRUE.

Note

The following parameters must be set to PROFIBUS DP or PROFINET IO to
process the job:

e Output the result string
o Port for the DISA, SELO to SEL3, TRN, RES, IN_OP, TRD, RDY signals

Sequence When Outputting the Mode of the VS 130-2 (COMMAND = W#16#0004)

6-28

The block recognizes the current mode based on the status byte of the VS 130-2
and outputs this in the STATE parameter:

o Ifthe IN_OP bit is not set, state 3 (ERROR) is output.
o Ifthe IN_OP bit is set, but the RDY bit is not set, state 2 (STOP) is output.

e Ifthe IN_OP bit is set and the RDY bit is set, state 1 (RUN) is output.

Following this, the DONE parameter changes to the value TRUE and ACTIVE
changes to the value FALSE.

Note

Since the job is completed in one CPU cycle, no edge change can be detected in
the ACTIVE parameter. If the DONE parameter already has the value TRUE from
a previous job, an edge change can also not be detected in this parameter.

Note

The following parameter must be set to PROFIBUS DP or PROFINET IO to
process the job:

Port for the DISA, SELO to SEL3, TRN, RES, IN_OP, TRD, RDY signals
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Sequence When Resetting the DISA Bit (COMMAND = W#16#0005)

The block resets the DISA bit in the control byte of the VS 130-2.

Following this, the DONE parameter changes to the value TRUE and ACTIVE
changes to the value FALSE.

Note

Since the job is completed in one CPU cycle, no edge change can be detected in
the ACTIVE parameter. If the DONE parameter already has the value TRUE from
a previous job, an edge change can also not be detected in this parameter.

Note
The following parameter must be set to PROFIBUS DP or PROFINET IO to
process the job:

o Port for the DISA, SELO to SEL3, TRN, RES, IN_OP, TRD, RDY signals

Sequence of the Read Jobs (COMMAND = W#16#0081 to W#16#008F)

Meaning of the COMMAND parameter for read jobs

Value Meaning

(W#16#...)

0081 Output result string

0082 Output absolute quality characteristics

0083 Output absolute quality characteristics and result string

0084 Output quality characteristics as grades

0085 Output quality characteristics as grades and output result string

0086 Output quality characteristics as grades and absolute

0087 Output quality characteristics as grades and absolute and output result string

0088 Output code position

0089 Output code position and result string

008A Output code position and output absolute quality characteristics

008B Output code position and output absolute quality characteristics and output result string

008C Output code position and output quality characteristics as grades

008D Output code position and output quality characteristics as grades and output result string

008E Output code position and output quality characteristics as grades and absolute

008F Output code position and output quality characteristics as grades and grades and output
result string

The read jobs can only be sent when VS 130-2 is in RUN mode (refer to the mode
table following the parameter table).

In contrast to all other jobs, the read jobs are "permanent jobs". This means that
the ACTIVE parameter has the value TRUE even after fetching the current read
results and/or the current position and/or the quality characteristics from the

VS 130-2.
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You should therefore evaluate the DONE and ERROR parameters at each block
call.

If the transfer was successful, DONE = TRUE. This only means, however, that the
transfer between processing unit and FB (CPU) has been completed error-free. In
order to find out if the DMC evaluation was successful, you have to evaluate the
bits READ (Bit 3), MATCH (Bit 4) and N_OK (Bit 5) in the status byte of the
processing unit. In this case, refer to the following table for the behavior of FB79.
You should also evaluate ERRCODE to be informed of warnings from the FB.

VS 130-2

Target Area RECV

The code could not be decoded. FB79 enters the string set in the "ReadErr" parameter.

The code was successfully decoded; |FB79 enters the result string.
however, you have not set any

specifications.

The code was successfully decoded |FB79 enters the string set in the "MatchErr" or "FilterMsg"
but does not match your parameter if the Match or Filter function is set. If both these
specifications. functions are selected, FB79 enters the string entered for

"MatchErr". For more detailed information on "MatchErr" and
"FilterMsg", please refer to Chapter 5.

The code was successfully decoded |FB79 enters the result string.
and matches the specifications.

Process the data entered in RECV before the next trigger otherwise the
consistency of this data cannot be guaranteed! You should also evaluate the
LENGTH parameter because the receive area is written only up to this length.

You can abort an active read job by calling FB79 with COMMAND = W#16#0000.

If an error occurs during execution of the job or while aborting an in-process read
job, ERROR = TRUE. In this case, the ERRCODE parameter contains a code for
the cause of the error that has occurred. FB79 writes B#16#00 to the RECV target
area.

Note

The following parameters must be set to PROFIBUS DP or PROFINET IO to
process the job:

e Output the result string
o Port for the DISA, SELO to SEL3, TRN, RES, IN_OP, TRD, RDY signals

Startup reaction

6-30

If an error occurs (ERRCODE <> DW#16#0000 0000), after calling an interrupt OB
(for example OB82) and after a STOP-RUN change on the CPU, you must initialize
the FB once with RESET=TRUE. Please enter a corresponding first call in your
user program.
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Error Information

If an error occurred, ERROR is set to TRUE. The precise cause of the error is then
displayed in ERRCODE. Apart from this, there are also warnings with which
ERROR is set to FALSE. These indicate an error situation that does not lead to the
current job being aborted.

If ERRCODE <> DW#16#0000 0000 following an FB call, call the FB again with
RESET=TRUE to reset the error information in the FB.

Note

By calling the FB with RESET=TRUE, you only acknowledge error displays of the
FB. To acknowledge errors of the VS 130-2 (for example transmit error), set the
RES bit of the control byte (see Assignments for PROFIBUS DP and PROFINET
I0-relevant interfaces for the processing unit or|Error messages).

ERRCODE |Error Explanation

(DW#16#)

0000 0000 0 No error

0000 0001 0 New job not effective as long as an old job is active

0000 0002 0 Job cannot be canceled

0001 0001 1 lllegal job number (COMMAND parameter)

0001 0002 1 The job cannot be processed in the current VS 130-2 mode.

0001 0003 1 During operation (not startup and no error has occurred), the FB was called with
RESET=TRUE or the user data interface is already being used by another FB
instance.

0001 0004 1 Send/Receive user data interface is not available or does not exist

0001 0005 1 The code number selected on the processing unit does not correspond to the
code number specified in the FB, possibly because control of the processing
unit has been taken over by the setup support.

0001 0006 1 lllegal code number (PARAM1 parameter). Code numbers 1 to 14 (training) and
0 to 15 (change codes) are permitted.

0001 0007 1 Job aborted by user

0001 0008 1 Code training not possible, possibly because control of the processing unit has
been taken over by the setup support.

0001 0009 1 Receive area not permitted. Only data blocks and the BYTE data type are
allowed.

0001 8092 1 The receive area does not exist.

0001 8323 1 The receive area is too short.

0001 8325 1 Data area not permitted

0001 8330 1 The receive area is write-protected.

0002 0003 1 The selected code number has not been trained.

0002 0004 1 Code cannot be trained. Position the code within the image or improve the
image quality.

0002 0005 1 Job aborted by processing unit

Note

If you receive error information other than that above, it originates from SFC 20
"BLKMOV" used for the entry in the result string in the receive area. This error
information can be read in the online help for system functions and function blocks.

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
A5E00475759-01 6-31




Process Interface

6.6

6.6.1

Sample Programs

Sample Program for Interfacing the VS 130-2 to a SIMATIC
Controller with the Aid of FB79

You will find the program described here on the manuals/commissioning CD in
Examples\SIMATIC.

Including FB79 in a STEP 7 Program

In the supplied STEP 7 program, the FC1 function contains a simple example for
outputting the result string. With FC2, you can bring about a code change. As
default, only FC1 is called in OB1. To activate FC2, you must either delete the first
network with the FC1 call or skip it.

Note

You may only apply the value W#16#0081 (output result string) to the COMMAND
parameter when bit 2 in the status byte (corresponds to the RDY signal) is set to
TRUE. Otherwise you receive the error "lllegal mode".

Process interfacing

The processing unit is connected over PROFIBUS DP or PROFINET IO to a
programmable controller. A light barrier or a Bero is also used to trigger and must
be read in over a digital input module. The received data is stored in data block
DB48 in bytes 0 to 500.

Adding the code change

/N

Specify the number of the required code in memory byte MB200. The code change
is then automatic. The correct order of the commands is maintained. The FB
changes to the code specified in PARAM1.

Attention

To avoid undefined statuses in the plant, you should only change codes when the
plant is stopped or in manual mode.

OB100 startup OB

6-32

Set the RESET input of FB79 in OB100 to initialize the FB. This input is reset again
when FB79 is called.
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Bits used in the control and status bytes

The following control and status bits must be processed in addition to the FB79
call:

Bit No. in an Corresponds to Signal |Function

Qx.6 Control byte |TRG An evaluation is started on the positive-going
edge.

Qx.7 Control byte  |RES Reset error on the VS 130-2

1x.0 Status byte IN OP 0: Error or startup, 1: VS 130-2 is functional

I x.2 Status byte RDY 1: VS 130-2 is in RUN, in other words, ready to
process codes.
You can use this signal to enable the feeding of
workpieces,

6.6.2 Sample Program for Outputting the Read Code to a PC or PG

You will find the program described here on the manuals/commissioning CD in
Examples\Excel.

Process interfacing

The configuration described in the section Reading codes or checking quality in a
PROFINET environment and outputting over Ethernet is used as the basis. It is
characterized by the PC or PG for outputting the read codes not being connected
to the processing unit over RS-232 but over Ethernet.

Once you have performed the activities described in the excel.wri file, the codes
read by the VS 130-2/VS 130-2vcr are entered in an Excel table.
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6.6.3

Sample Program for Archiving Diagnostic Information on a PC
ora PG

You will find the program described here on the manuals/commissioning CD in
Examples\Diagnostics.

With the "mmidiag” sample, you can archive diagnostic data records in the form of
csv files and diagnostic images as bitmaps on a PC. In addition to the diagnostic
images, a text file is transferred that contains details of the image.

Process interfacing

The configuration described in the section Reading codes or checking quality in a
PROFINET environment and outputting over Ethernet is used as the basis. It is
characterized by the PC or PG for archiving the diagnostic data records and/or
diagnostic images not being connected to the processing unit over RS-232 but over
Ethernet.

Setup support

Make the following settings on the setup support:

e Connections dialog, Ports tab:
In "Archiving/MMI", enter the IP address and the port of the PC/PG on which
you want to archive the diagnostic information.

e Connections dialog, Integration tab:
In "Diagnostic transfer", select what you want to archive. only diagnostic data
records, only diagnostic images or both

Example Program

6-34

Make sure that set the same values in the "Connection" sample as on the setup
support in the Connections dialog, Ports tab.

Enter the maximum size of a csv file in "Options". If the current csv file exceeds this
size, the sample program creates a new csv file. In the "Timeout" input box, you
can also specify the time in seconds after which the sample program stops itself if it
has not received a response from the processing unit during this time. This allows
you to check whether the connection to the processing unit is still established.

In "Output", you specify the folders in which the diagnostic images and the csv files
will be stored.

Once you have clicked the "Start" button, the program waits for the connection to
be established by the processing unit. The transfer of the diagnostic data begins
after the connection has been established.

The file names have the following structure:
e csv files: diagrecs <date> <time>.csv
e Bitmaps: diagimg_<date>_<time>.bmp

o Details of the image: diagimg_<date>_<time>.txt
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71 Introduction

With certain operator input and if an error occurs in the processing, the
VS 130-2/VS 130-2vcr provides you with adequate diagnostic information. This can
take the following form:

e Message from setup support
e Message on the display of the processing unit
e Activation of the "BF" LED

e Slave Diagnostics

7.2 Diagnostics with Messages

Overview
A distinction is made between the following message types:
e Error Messages
¢ Warnings/Notes
e Read results
All three types of message are displayed on the display of the processing unit.

Most messages of the error message type also trigger a diagnostic interrupt on the
DP master via PROFIBUS.

In "Error Messages", "Warnings/Notes" and "Read Results", you will find all the
messages, their meaning and a description of how to remedy the situation.
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7.21 Error Messages
When error messages are generated, the "IN_OP" signal (in operation) is reset and
the SF LED (group error) is lit.
With the exception of the error messages PROFIBUS DP Error and PROFINET 10
Error, you must acknowledge all errors that occur by setting the DISA and the RES
bit of the control byte.
If VS 130-2/VS 130-2vcr is connected to PROFIBUS DP or PROFINET 1/0O, all
error messages trigger a diagnostic interrupt on the respective DP master or I/O
controller, for which there is a number in the "Bit no. as of Diagnostic Byte 0 (DP)"
or "Value (PROFINET)" column in the following table. How to read out and then
analyze the diagnostic information available on the VS 130-2 is described in Slave
Diagnostics or IO Diagnostics.
No. |[Signal Bit-No. as of |Value Description Possible
Diagnostic (PROFINET) Remedies
byte 0 (DP)
1 Invalid sensor |0 W#16# 5000 |The connected sensor type is |Connect a sensor
not supported. supported by
VS 130-2/VS 130-
2vcr.
2 Sensor not 1 W#16# 5001 |No sensor connected. Connect the
found sensor to the
processing unit
correctly.
3 Disable Sig. |3 W#16# 5003 |DISA changed at an invalid Check the
Change time (during training) sequence of
applied signals.
Start the training
again.
4 Error in signal |4 W#16# 5004 |During training, the correct Check the
sequence sequence of applied signals is |sequence of
not kept to. applied signals.
Start the training
again.
5 Code corrupt |5 W#16# 5005 |The code could not be Run the training
recreated. again.
6 TCP/RS232 |7 W#16# 5007 |The send buffer is full because |Reduce the trigger
Trm. Error the data cannot be sentin an |frequency or
adequately short time, process the results
more quickly on
the server. A high
load on the
network to which
the processing unit
is connected can
also block the
transfer of the
data. If necessary,
check the network
connection.

7-2
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No. |Signal Bit-No. as of |Value Description Possible
Diagnostic (PROFINET) Remedies
byte 0 (DP)
7 ARCH/MMI 7 W#16# 5007 |The send buffer is full because |Reduce the trigger
Trm. Error the data cannot be sentin an |frequency or
adequately short time or the  |reduce the amount
server does not confirm of diagnostic data
receipt of the data in good to be archived.
time Process the results
on the server
faster. A high load
on the network to
which the
processing unit is
connected can
also block the
transfer of the
data. If necessary,
check the network
connection.
8 DP/PNIO Trm. |7 W#16# 5007 |The transfer of the last read Reduce the trigger
Error result is not yet completed, the |frequency or
next read result is, however, |process the results
already available, or the DP more quickly.
master or 10O controller does If necessary,
not reply within the handshake |change the
monitoring time (parameter transmission rate
Connect >Ports >DP >Timeout |for the DP
on processing unit or within configuration or the
the time limit parameter in update time for the
PROFIBUS DP in Part 1/3: PROFINET
Ports of the Connections configuration.
dialog in the setup support,
parameter Connect >Ports
>PNIO >Timeout on
processing unit or within the
time limit parameter in
PROFINET IO in Part 1/3:
Ports in the "Connections"
dialog in the setup support).
9 Invalid DP 8 - The DP settings are not Correct the DP
Parameters correct settings.
10 |[Cycletime too |9 W#16# 5009 |During the first code Increase the cycle
short processing following a change |[time, improved the
from STOP to RUN on the image quality, or
(Note: only processing unit, the first restart processing
with VS 130-2 processing iteration could not |mode.
up to and be completed within 90% of
including V1.5) the set upper limit of the cycle
time.
11 Error Training |10 W#16#500A |No code was found in the Position the code
Code image during training. within the image or
improve the image
quality.
12 |Match 11 W#16#500B | The trained code cannot be Adapt the match
Mismatch processed with the match settings, or train a
settings (for example suitable code.
ID/separator not found)

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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No. |Signal

Bit-No. as of
Diagnostic
byte 0 (DP)

Value
(PROFINET)

Description

Possible
Remedies

13  [No ECC 200
code

12

W#16#500C

The code found during training
does not comply with the ECC
200 standard.

Use a code that
complies with the
standard.

14 |PROFIBUS
DP Error

13

Error in PROFIBUS DP
communication.

Make sure that the
parameters for
communication
over PROFIBUS
DP and the
communication
partners are
correctly
configured and
active. Check the
connection to the
DP master.

15 |TCP/RS232
Communic.

14

W#16#500E

Connection error in
communication over a TCP
connection or when using an
Ethernet RS-232 converter:
There is no TCP connection or
the data transfer cannot be
completed within the set time
limit.

Make sure that the
connected TCP
server or Ethernet
RS-232 converter
is correctly
configured and
operational.
Depending on the
connected
Ethernet RS-232
converter, it can
takeupto 20 s
before changes to
the RS-232
settings or
parameter
changes for the
trigger source or
the output of the
result string to
"TCP/RS232" take
effect. During this
time, the first
trigger of a
processing cycle
should not occur
nor should that be
a change to RUN.

16 |ARCH/MMI
Communic.

W#16#500E

Error in communication over
the archiving connection:
There is no TCP connection,
the server does not respond
within the set time limit or
violates the archiving protocol.

Check the
connection to the
server.

Make sure that the
data is processed
by the server in an
adequately short
time and that the
protocol is
maintained.

7-4
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Error

to the read-only memory.

No. |Signal Bit-No. as of |Value Description Possible
Diagnostic (PROFINET) Remedies
byte 0 (DP)
17 |Lamp overload |15 W#16#500F | The IR lighting unit is Reduce the trigger
overloaded. frequency or
Below you will see the reduce the shutter
maximum trigger frequency fT |speed.
for the selected shutter speeds
TB:
e TB=500us:fT =60Hz
e TB=1000 ps: fT =40 Hz
e TB=2000 ps: fT =20 Hz
e TB=3000ps:fT=13Hz
e TB=4000 ps: fT =10 Hz
e TB=5000ps:fT=8Hz
e TB=6000ps:fT=7Hz
e TB=7000ps:fT=6Hz
e TB=8000ps:fT=5Hz
e TB=9000ps:fT=4.5Hz
e TB=10000 ps: fT =4 Hz
Note: Trigger frequencies >
33 Hz are not practicable.
18 |Reserved 16 W#16# 5010 |You are attempting to train Select a code
code number code number 15 over digital number between
I/O or PROFIBUS DP or 1 and 14.
PROFINET IO. This is,
however, are reserved for
automatic learning.
19 |PROFINET - W#16# 5011 |An error occurred in Make sure that the
1/0 Error PROFINET I/O communication | parameters for
communication
over
PROFINET I/O
and the
communication
partners are
correctly
configured and
active. Check the
connection to the
1/O controller.
20 |Internal File 5 W#16# 5005 |An error occurred when saving | Contact Customer

Support if this error
occurs often.

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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Occurrence of PROFIBUS DP or PROFINET IO Errors

7-6

If a "PROFIBUS DP Error" or "PROFINET IO Error" occurs, the processing unit
checks during the time the error is displayed if the cause of the error continues to
be present.

When the affected communication is reestablished, the processing unit resets the
error display and goes into the one of the following operating modes:

e If the error occurred during RUN, the processing unit goes back to RUN mode
with the corresponding code number.

e The processing unit goes to STOP mode in all other situations.

In any case, you can acknowledge the error manually (on the processing unit or in
the setup support) and thereby make changes to the configuration.

The occurrence of these two errors as well as their automatic acknowledgment are
permanently saved in the diagnostics records, i.e. the corresponding entries are
not overwritten by the occurrence of new errors. They are indicated at the following
locations if their number deviates from zero:

¢ In the Info menu of the processing unit
¢ In the setup support for the "Processing mode" job

¢ In the setup support for the "Info" job in the "Statistics" tab

Note

The occurrence of a PROFIBUS DP error or PROFINET 10 error results in the call
of OB 86 (rack failure) in a SIMATIC S7-CPU.

If you have not programmed OB 86, the CPU goes to STOP.

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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7.2.2 Warnings/Notes
No. |Signal Description Possible Remedies
1 |PROFIBUS When setting Control, Trigger, String or |You must correct the PROFIBUS DP
Connection Result on PROFIBUS DP, no connection |parameters or activate the
failed could be established. communication partner.
The settings are applied when you
acknowledge the message with OK. The
settings are not applied if you
acknowledge with ESC.
2 Cycletime Setting the Exposure to Auto is possible |If you want to use Exposure Auto, you
must be only when Cycletime is set to > 200 ms. |must first increase Cycletime to > 200
> 200 ms The setting will not be adopted. ms.
3 |For Verify The Verify task can only be selected Change the parameter assignment.
Exposure<-> |when Exposure is set to manual and
Manual Exposure cannot be changed from
Manual when the task is set to Verify.
The setting will not be adopted.
4 String=DP The string output can only be configured |Configure the Control parameter for DP.
needs for PROFIBUS DP when Control is also
Control=DP configured for PROFIBUS DP and
Control cannot be changed from
PROFIBUS DP when String is configured
for PROFIBUS DP.
The setting will not be adopted.
S |Permission The security settings prevent this value |Set the value over the Web user
denied for ... |being set in the menu of the processing |interface for changed the security
unit. settings of the Web user interface.
6 |Restart to A device name change on PROFINET Turn the power supply for the processing
Activate only becomes active after restarting the |unit of an on again.
processing unit.
7 |Please wait The exposure is being optimized during
setup. Several image captures will be
made.
If trigger is set to "Trg. Only", there must
be a trigger for this.
8  [This will delete|The change to the parameter means that
all codes all codes must be retrained. All existing
trained codes are deleted.
9 [TcPNP During the self-test, the system waits for |If the message does not disappear
Esc:Skip the activation of the TCP/IP connections |automatically after a few seconds, check
(If applicable, obtaining the IP address  |the network connection.
from the DHCP server). With ESC, you can skip connection
establishment (or it continues in the
background).
10 | Arch/MMI In the self-test, the system waits for the |If the message does not disappear
Esc:Skip TCP/IP connection to the archiving automatically after a few seconds, check
software to be established. the connection to the archiving software.
With ESC, you can skip connection
establishment (or it continues in the
background).
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No. |Signal Description Possible Remedies
11 |TCP/RS232  |In the self-test no connection to the If the message does not disappear
Esc: Skip configured Ethernet RS-232 converter or. |automatically after a few seconds, check
PC/PG with TCP server can be the connection to the Ethernet RS-232
established (yet). server or PC/PG with TCP server.
With ESC, you can skip connection
establishment (or it continues in the
background).
12 |pROFIBUS During the self-test it is still not possible |If the message does not disappear
Esc:Skip to start communication over PROFIBUS |automatically after a few seconds, check
DP. the connection to the DP master.
With ESC, you can skip connection
establishment (or it continues in the
background).
13 Factory The defaults for all parameters are used,
Settings used. |no codes have been trained. After the
self-test, the processing unit changes
immediately to the Adjust mode.
14 |code nn During training, the system is waiting for
Training... a trigger, or the triggered image is
currently being processed.
15 String=DP The string output can only be configured |Configure the Control parameter for
needs for PROFIBUS DP when Control is also |PNIO.
Control=DP configured for PROFINET 1/O and/or
Control cannot be changed from
PROFINET 1I/O when String is configured
for PROFINET 1/O.
The setting will not be adopted.
16 |PROFINET During the self-test it is still not possible | This message has its origins in the
Esc:Skip to start communication over PROFINET. |changeover of the IP address during
reconfiguration. The message exists until
the changeover procedure has ended.
If the message does not disappear
automatically after a few seconds, check
the connection to the 1/O controller.
With ESC, you can skip connection
establishment (or it continues in the
background).
17 | This will cause |IP mode is changed to PNIO oritis in
a restart. PNIO and should retain another value.
The change comes into effect only after
a restart of the processing unit.
Confirmation with "OK" leads to a restart.
If you press "ESC", the change is not
applied and no restart occurs.
18 ||nvalid You have entered an illegal value in a The subnet mask must have the
Netmask subnet mask under Ports > Ethernet. The |following structure: 255.255.xxx.yyy
value will not be used. In binary terms, xxx.yyy must be made
up of ones without a gap seen from the
left and of zeros without a gap seen from
the right.
Note also: yyy <= 254
19 Sensortype You have connected a sensor with a Confirming with OK leads to the following
changed. resolution that does not match that of the |warning.
Ok previously connected sensor.

7-8
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No. |Signal Description Possible Remedies
20 |This will reset |If you connect a sensor with a resolution |Confirming with OK causes the
settings! that does not match that of the previously | parameters to be deleted,
Ok connected sensor, the parameters will be
deleted.
21 | Hires not You cannot operate a high-resolution Use a sensor that is not high-resolution
supported sensor with this processing unit. or a processing unit with a version that
supports high-resolution sensors.
22 |Hardware not |You cannot operate this firmware on |Use the system update to install firmware
supported your processing unit. that is valid for your processing unit or
use a processing unit with a version that
supports this firmware version.
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7.2.3 Read Results
No. |Signal Description Possible Remedies
1 Read Err The code could not be read in the |For possible causes, refer to "Error
(<reason>) processing mode. Training Code" in the error messages.

Note: You can modify this text in
Connect>String>Messages
>ReadErr

2 Filter error Text for the situation when the

values for "Start position" or "Filter
ID" for the current part do not occur
in the read code.

Note: You can modify this text in
Connect>String>Messages
> FilterErr

1. Check whether the DMC currently
being read is correct.

2. Check or correct the selected settings
in Connect>String>Filter>StartPos
and ID.

Connect>String>Format>String
input box.

Note: You can modify this text in
Connect>String>Messages

> Format Err

3 Match error The parameter selected in 1. The code currently being read is

Connect>String>Filter>Option was different from the trained code (and is
not found in the code being therefore bad) or the wrong code was
compared or the string defined trained.
during tralplng does not match the 2. Check the selected parameter
current string of the code. . .
Note: You can modify this text in assignment |.n . .
Connect>String>Messages Connect>String>Filter>Option.
> MatchErr

4 Format error Error in the

Check the selected setting in
Connect>String>Format>String.

7-10

Note

When operating using the setup support, make sure you are familiar with the
comprehensive description in the user interface (User Interface of the Web
Application.).
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7.3 Diagnostics Based on the "BF" LED

7.3.1 "BF" LED with PROFIBUS DP
"BF" LED |Meaning if an Error Possible Remedies
Occurs
on VS 130-2/VS 130-2vcris |e  Check that the bus connector is correctly inserted.
not exchanging data butis |4  Check that there is no break on the bus cable to the DP
detecting the transmission master.
rate e If you use an S7 DP master: Check the diagnostic buffer of
the DP master or the slave diagnostic information in
HW Config.
flashes VS 130-2/VS 130-2vcris |e  Check the cable lengths relative to the transmission rate.
neltr(;e; e);f:ha?r?lng data |4  Check the settings of the terminating resistors.
nor detecting the e Check the configuration of the DP master (PROFIBUS
transmission rate . ' . .
address, transmission rate, configuration, bus profile).

« If you use an S7 DP master: Check the diagnostic
buffer of the DP master or the slave diagnostic
information in HW Config.

7.3.2 "BF" LED with PROFINET IO
"BF" LED |Meaning if an Error Occurs Possible Remedies
on e  Bus problem (no physical connection to a Check that the bus connector is correctly
subnet/switch) inserted.
e Wrong transmission speed
e  Full duplex transmission is not activated
flashes e  Bus communication via PROFINET is o Check if the IP address or device

interrupted.
e |P address is incorrect.
e Incorrect configuration
e Incorrect configuration
e Incorrect or missing device name

e |O controller not available/switched off but
Ethernet communication exists

name is duplicated on the network.

o Check the settings of the I/O
controller.
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7.4

7.41

7.4.2

Slave Diagnostics or I/O Device Diagnostics

Introduction

Errors such as "Sensor not found" trigger a slave or 1/0O device diagnostic
message. Slave diagnostics behaves according to the PROFIBUS standards
EN 50170 and IEC 61158 / IEC 61784. Depending on the DP master or

I/O controller, the diagnostic information can be read with STEP 7.

How to read out the slave or I/O device diagnostic information and how it is
structured is described briefly below. You will find a detailed description in the
Distributed I/0O Station ET 200M manual or in the PROFINET 10 — From
PROFIBUS DP to PROFINET IO Programming Manual.

Note
VS 130-2/VS 130-2vcr does not support the SYNC and FREEZE control
commands. If the VS 130-2/VS 130-2vcr slave nevertheless receives one of these

control commands, bit 0 in diagnostic byte 1 is set (see Diagnostics in PROFIBUS
DP).

Reading Out the Diagnostic Information with S7

If an error message such as "Sensor not found" occurs on the processing unit and
you are using an S7 CPU as the DP master or I/O controller, the diagnostic
interrupt OB (OB82) is started.

Its local variables OB_82 EV CLASS, OB 82 MDL_DEFECT, and
OB82_EXT_FAULT can have the following values:

Tag

Value Meaning

OB_82_EV_CLASS B#16#39 Event entering state

OB_82_MDL_DEFECT TRUE Module fault

OB 82 EXT FAULT TRUE External error

7-12

Unfortunately it is not possible to obtain the actual cause of the problem from the
local variables of OB82. This can be determined as follows:

o for PROFIBUS DP: by calling SFC13 "DPNRM_DG" or SFB 54 "RALRM" in
0B82

e for PROFINET IO: by calling SFB54 "RALRM" in OB82

The entry "Module fault" appears in the diagnostic buffer and the relevant text from
the GSD file is shown as the module status of the VS 130-2/VS 130-2vcr, for
example "Sensor not found".

When the error is eliminated (in the example: you have inserted the sensor again)
and acknowledged this on the processing unit, the diagnostic interrupt OB (OB 82)
is started again on the DP master or IO controller.
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Its local variables OB_82_EV_CLASS, OB_82_MDL_DEFECT, and

OB82_EXT_FAULT can have the following values:

| Tag Value Meaning
OB_82_EV_CLASS B#16#38 Event exiting state
OB_82 MDL_DEFECT FALSE No module fault
OB 82 EXT FAULT FALSE No external error

The entry "Module OK" now appears in the diagnostic buffer in PROFIBUS DP and
the error text from the GSD file is no longer shown as the module status of the

VS 130-2/VS 130-2vcr.

743 Diagnostics for PROFIBUS DP
Bytes 7 through 10 of the slave diagnostic information (diagnostic bytes 0 through
3) read with SFC13 correspond to the 32-bit long field "Unit_Diag_Bit" of the GSD
file SIEM8111.GSD or the diagnostic bits shown in the table in Error Messages.
The slave diagnostics is designed as follows:
PROFIBUS- |Meaning Range of Validity
frame
Byte 0 Station status1 (bit 3 = 1: External diagnostic information According to standard
available)
Byte 1 Station status 2 According to standard
Byte 2 Station status 3 According to standard
Byte 3 Master PROFIBUS address According to standard
Byte 4 Manufacturer ID (high byte): B#16#81 According to standard
Byte 5 Manufacturer ID (low byte): B#16#11 According to standard
Byte 6 Length of the VS 130-2/VS 130-2vcr-specific diagnostic data incl. |According to standard
byte 6: B#16#05
Byte 7 Diagnostic byte 0 (bit 1 "Sensor not found") VS 130-2/VS 130-2vcr-
specific
Byte 8 Diagnostic byte 1 VS 130-2/VS 130-2vcr-
specific
Byte 9 Diagnostic byte 2 VS 130-2/VS 130-2vcr-
specific
Byte 10 Diagnostic byte 3 VS 130-2/VS 130-2ver-
specific
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SFB54 "RALRM" returns the following diagnostic information in the TINFO
parameter (task information) for PROFIBUS DP:

BYTE Value Meaning
0to 19 See OB description | Start information of the OB in which SFB 54 is called
20to 21 |Depending on Address:
configuration e Bits 0 to 7: Station number (acc. to configuration)
e Bits 8 to 14: DP master system ID (acc. to configuration)
e Bit15:0
22 B#16#00 e Bits 0 to 3: Slave type (DP)
e Bits 4 to 7: Profile type: 0000
23 B#16#01 e Bits 0 to 3: Alarm information type (alarm of a non-DPV1 slave /
non-10 device)
e Bits 4 to 7: Structure version
24 B#16#00 / B#16#01 |Flags of the PROFIBUS DP-Master interface:
e Bit 0 = 0: Interrupt from integrated interface module
e Bit 0 = 1: Interrupt from external interface module
e Bits1to7:Ineach case0
25 B#16#01 / B#16#00 |Flags of the PROFIBUS DP-Master interface:
e Bit 0 =1 for entering alarm
e Bit 0 = 0 for exiting alarm
e Bits1to7:Ineach case 0
26 to 27 |W#16# 8111 PROFIBUS identification number (fixed)
SFB54 "RALRM" returns the following diagnostic information in the AINFO
parameter (alarm status information) for PROFIBUS DP:
BYTE Value Meaning
0 B#16#0F Length of the received alarm information in bytes: 15
1 B#16#01 ID for the alarm type: 1=diagnostic interrupt
2 B#16#00 Slot number of the alarm triggering component
3 B#16#01 / B#16#02 1: 1: event entering state, slot fault
2: 2: event exiting state, slot fault cleared
4 According to standard | Station status1 (bit 3 = 1: External diagnostic information available)
5 According to standard | Station status 2
6 According to standard | Station status 3
7 According to standard |Master PROFIBUS address
8 B#16#81 Manufacturer ID (high byte)
9 B#16#11 Manufacturer ID (low byte)
10 B#16#05 Length of the VS 130-2/VS 130-2vcr-specific diagnostic data incl. this
byte:
11 VS 130-2-specific Diagnostic byte 0 (bit 1 "Sensor not found")
12 VS 130-2-specific Diagnostic byte 1
13 VS 130-2-specific Diagnostic byte 2
14 VS 130-2-specific Diagnostic byte 3
Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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74.4 Diagnostics for PROFINET IO
SFB54 "RALRM" returns the following diagnostic information in the TINFO
parameter (task information) for PROFINET IO:
BYTE Value Meaning
0to 19 See OB description | Start information of the OB in which SFB 54 is called
20to 21 |Depending on Address:
configuration e Bits 0 to 10: Station number (acc. to configuration)
e Bits 11 to 14: 10 system ID (acc. to configuration)
e Bit15:1
22 B#16#08 e Bits 0 to 3: Slave type 1000 = PNIO
e Bits 4 to 7: Profile type: 0000
23 B#16#00 e Bits 0 to 3: Interrupt info type 0000
e Bits 4 to 7: Structure version: 0000
24 B#16#00 / B#16#01 |Flags of the PNIO controller interface:
e Bit 0 = 0: Interrupt from integrated interface module
e Bit 0 = 1: Interrupt from external interface module
e Bits 1 through 7: In each case 0
25 B#16#01 / B#16#00 |Flags of the PNIO controller interface:
e Bit 0 =1 for entering alarm
e Bit 0 = 0 for exiting alarm
e Bits 1 through 7: In each case 0
26 to 27 |W#16#0B01 PNIO device identification number (fixed)
281029 |W#16#002A Manufacturer ID (fixed)
30 to 31 |W#16# 0001 Identification number of the instance
The SFB 54 "RALRM" returns the following diagnostic information in the AINFO
parameter (alarm status information) for PROFINET 10:
Note
Only bytes 0 to 25 of the AINFO parameter are described for exiting alarms (see
also the meaning of bytes 2 and 3 of AINFO).
BYTE Value Meaning
Oto1 W#16# 0002 Block type (fixed)
2t03 W#16#0022 / W#16#0016 | Length of diagnostic data with alarm entering / exiting state
4t05 W#16# 0100 Version (fixed)
6to7 W#16#0001 / W#16#000C | ID for the alarm type: Diagnostic alarm entering state /
diagnostic alarm exiting state
8 to 11 DW#16# 00000000 API (fixed)
12to 13 |W#16# 0000 Slot (fixed)
14t0 15 |W#16# 0001 Subslot (fixed)
16 to 19 |DW#16# 00000300 Module identification (fixed)
20 t0 23 |DW#16# 00000000 Submodule identification (fixed)
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BYTE Value Meaning
24 t0 25 |WH#16#Bxxx / WH#16#0xxx Alarm specifier for entering/exiting alarms:
e Bits 0 through 10: Sequence number
e Bit 11: Channel diagnostics: 0 (fixed)
e Bit 12: Status of vendor-specific diagnostics
e Bit 13: Status of diagnostics on submodule
e Bit14: reserved: 0
e Bit 15: Application relation diagnostic status
26 to 27 |W#16# 0002 Format ID for manufacturer-specific diagnostics (fixed)
28t0 29 |W#16# 0000 Slot (fixed)
30to 31 |W#16# 0001 Subslot (fixed)
32t0 33 |W#16# 0000 Channel (fixed)
341035 |W#16# 0805 Properties (fixed)
36 to 37 |Value from the table in Error |ID for occurring error
Messages
In contrast to event-based reading of diagnostic data with the SFB 54, it is also
possible to read diagnostic data based on the status. This can be performed using
SFB 52 "RDREC".
SFB 52 is called as follows:
¢ Assign the diagnostic address of the VS 130-2/VS 130-2vcr in hexadecimal
form to the parameter ID.
e Assign the INDEX parameter the value 2.
The diagnostic data record is structured as follows:
BYTE Value Meaning
Oto1 W#16# 0010 Data record type: Diagnostic Data Record
2103 W#16# 0012 Data record length starting at byte 4: 18 bytes
4t05 W#16# 0100 Version
6to7 W#16# 0000 Slot
8to9 W#16# 0000 Subslot
10 to 11 |W#16# 0000 Channel
12 B#16#08 / B#16#10 Error detected / no error detected
13 B#16#05 Indicates that all variables are save word by word beginning at
byte 14
14t0 15 |W#16# 0002 ID for manufacturer-specific diagnostics
16 to 17 |W#16# 0000 Channel number
1810 19 |W#16#0805 / W#16#1005 |Content identical to bytes 12 and 13
20to 21 |Value from the table in Error |ID for occurring error
Messages
Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
7-16 A5E00475759-01




8 Appendix

8.1 Components of the Product

Complete packages

Order No.:

Description

6GF1 130-1BA

SIMATIC VS 130-2 for "large code areas": Complete package for acquisition of
codes, comprising:

e Sensor head (6GF2 002-8DA01) in IP65 for image size field of 75mm x 57mm,
Read interval: 100 mm, suitable for light in visible range

e Sensor cable (6GF9 002-8CD) for sensor heads SIMATIC VS 100, 2.5 m long,
connectors at both ends, capable of trailing + ferrite ring (A5SE00159706)

e Lighting unit, overhead lighting, red (6GF9 004-8BA01) in IP65, with diffuser

e Lighting cable (6GF9 002-8CE) for SIMATIC VS 100, 2.5 m long, connectors
at both ends, capable of trailing

e Processing unit (6GF1 018-3BA) SIMATIC VS 130-2 in IP40
o Power supply cable (6GF9 002-8CA) SIMATIC VS 100, 10 m long
¢ Digital communication patch cord (6GF9 002-8CB) SIMATIC VS 100, 10 m

o Documentation package (6GF7 031-1BA) SIMATIC VS 130-2 containing
manuals/commissioning CD and installation instructions

6GF1 130-1BA01

SIMATIC VS 130-2 for "large code areas": Complete package for acquisition of
codes, comprising:

e Sensor head (6GF2 002-8DA01) in IP65 for image size field of 75mm x 57mm,
Read interval: 100 mm, suitable for light in visible range

e Sensor cable (6GF9 002-8CF) for sensor heads SIMATIC VS 100, 10 m long,
connectors at both ends, capable of trailing + ferrite ring (ASE00159706)

e Lighting unit, overhead lighting, red (6GF9 004-8BA01) in IP65, with diffuser

e Lighting cable (6GF9 002-8CG) for SIMATIC VS 100, 10 m long, connectors at
both ends, capable of trailing

e Processing unit (6GF1 018-3BA) SIMATIC VS 130-2 in IP40
e Power supply cable (6GF9 002-8CA) SIMATIC VS 100, 10 m long
o Digital communication patch cord (6GF9 002-8CB) SIMATIC VS 100, 10 m

o Documentation package (6GF7 031-1BA) SIMATIC VS 130-2 containing
manuals/commissioning CD and installation instructions
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Order No.:

Description

6GF1 130-2BA

SIMATIC VS 130-2 for "small code areas": Complete package for acquisition of
codes, comprising:

Sensor head (6GF2 002-8EAO01) in IP65 for image size field of 45mm x 34mm,
Read interval: 90 mm, suitable for light in visible range

Sensor cable (6GF9 002-8CD) for sensor heads SIMATIC VS 100, 2.5 m long,
connectors at both ends, capable of trailing + ferrite ring (A5SE00159706)

Lighting unit, overhead lighting, red (6GF9 004-8BA01) in IP65, with diffuser

Lighting cable (6GF9 002-8CE) for SIMATIC VS 100, 2.5 m long, connectors
at both ends, capable of trailing

Processing unit (6GF1 018-3BA) SIMATIC VS 130-2 in IP40
Power supply cable (6GF9 002-8CA) SIMATIC VS 100, 10 m long
Digital communication patch cord (6GF9 002-8CB) SIMATIC VS 100, 10 m

Documentation package (6GF7 031-1BA) SIMATIC VS 130-2 containing
manuals/commissioning CD and installation instructions

6GF1 130-2BA01

SIMATIC VS 130-2 for "small code areas": Complete package for acquisition of
codes, comprising:

Sensor head (6GF2 002-8EA01) in IP65 for image size field of 45mm x 34mm,
Read interval: 90 mm, suitable for light in visible range

Sensor cable (6GF9 002-8CF) for sensor heads SIMATIC VS 100, 10 m long,
connectors at both ends, capable of trailing + ferrite ring (ASE00159706)

Lighting unit, overhead lighting, red (6GF9 004-8BA01) in IP65, with diffuser

Lighting cable (6GF9 002-8CG) for SIMATIC VS 100, 10 m long, connectors at
both ends, capable of trailing

Processing unit (6GF1 018-3BA) SIMATIC VS 130-2 in IP40
Power supply cable (6GF9 002-8CA) SIMATIC VS 100, 10 m long
Digital communication patch cord (6GF9 002-8CB) SIMATIC VS 100, 10 m

Documentation package (6GF7 031-1BA) SIMATIC VS 130-2 containing
manuals/commissioning CD and installation instructions

6GF1 130-3BB

SIMATIC VS 130-2: Basic package for acquisition of codes, comprising:

Sensor head (6GF2 002-8CB) in IP40 for variable image field size for C/CS-
mount lenses prepared for lens protective housing IP65

Sensor cable (6GF9 002-8CD) for sensor heads SIMATIC VS 100, 2.5 m long,
connectors at both ends, capable of trailing + ferrite ring (ASE00159706)

Processing unit (6GF1 018-3BA) SIMATIC VS 130-2 in IP40
Power supply cable (6GF9 002-8CA) SIMATIC VS 100, 10 m long
Digital communication patch cord (6GF9 002-8CB) SIMATIC VS 100, 10 m

Documentation package (6GF7 031-1BA) SIMATIC VS 130-2 containing
manuals/commissioning CD and installation instructions

Here, you must also provide suitable illumination, a lighting cable and a lens.
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Order No.: Description

6GF1 130-3BB01 |SIMATIC VS 130-2: Basic package for acquisition of codes, comprising:

Sensor head (6GF2 002-8CB) in IP40 for variable image field size for C/CS-
mount lenses prepared for lens protective housing IP65

Sensor cable (6GF9 002-8CF) for sensor heads SIMATIC VS 100, 10 m long,
connectors at both ends, capable of trailing + ferrite ring (A5E00159706)

Processing unit (6GF1 018-3BA) SIMATIC VS 130-2 in IP40
Power supply cable (6GF9 002-8CA) SIMATIC VS 100, 10 m long
Digital communication patch cord (6GF9 002-8CB) SIMATIC VS 100, 10 m

Documentation package (6GF7 031-1BA) SIMATIC VS 130-2 containing
manuals/commissioning CD and installation instructions

Here, you must also provide suitable illumination, a lighting cable and a lens.

6GF1 130-4BA SIMATIC VS 130-2 for "very small code areas": Complete package for acquisition
of codes, comprising:

Sensor head (6GF2 002-8FA01) in IP65 for image size field of 20 mm x 15
mm, Read interval: 75 mm, suitable for light in visible range

Sensor cable (6GF9 002-8CD) for sensor heads SIMATIC VS 100, 2.5 m long,
connectors at both ends, capable of trailing + ferrite ring (ASE00159706)

Lighting unit, overhead lighting, red (6GF9 004-8CAO01) in IP65, with clear view
disc

Lighting cable (6GF9 002-8CE) for SIMATIC VS 100, 2.5 m long, connectors
at both ends, capable of trailing

Processing unit (6GF1 018-3BA) SIMATIC VS 130-2 in IP40

Power supply cable (6GF9 002-8CA) SIMATIC VS 100, 10 m long

Digital communication patch cord (6GF9 002-8CB) SIMATIC VS 100, 10 m

Documentation package (6GF7 031-1BA) SIMATIC VS 130-2 containing
manuals/commissioning CD and installation instructions

6GF1 130-4BA01 |SIMATIC VS 130-2 for "very small code areas": Complete package for acquisition
of codes, comprising:

Sensor head (6GF2 002-8FA01) in IP65 for image size field of 20 mm x 15
mm, Read interval: 75 mm, suitable for light in visible range

Sensor cable (6GF9 002-8CF) for sensor heads SIMATIC VS 100, 10 m long,
connectors at both ends, capable of trailing + ferrite ring (ASE00159706)

Lighting unit, overhead lighting, red (6GF9 004-8CAO01) in IP65, with clear view
disc

Lighting cable (6GF9 002-8CG) for SIMATIC VS 100, 10 m long, connectors at
both ends, capable of trailing

Processing unit (6GF1 018-3BA) SIMATIC VS 130-2 in IP40

Power supply cable (6GF9 002-8CA) SIMATIC VS 100, 10 m long

Digital communication patch cord (6GF9 002-8CB) SIMATIC VS 100, 10 m

Documentation package (6GF7 031-1BA) SIMATIC VS 130-2 containing
manuals/commissioning CD and installation instructions

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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Order No.:

Description

6GF1 130-3BC

SIMATIC VS 130-2 with high-resolution sensor: Basic package for acquisition of
codes, comprising:

e Sensor head (6GF2 002-8GB) in IP40 for variable image field size for C/CS-
mount lenses prepared for lens protective housing IP65

e Sensor cable (6GF9 002-8CD) for sensor heads SIMATIC VS 100, 2.5 m long,
connectors at both ends, capable of trailing + ferrite ring (A5SE00159706)

e Processing unit (6GF1 018-3BA) SIMATIC VS 130-2 in IP40
e  Power supply cable (6GF9 002-8CA) SIMATIC VS 100, 10 m long
+ Digital communication patch cord (6GF9 002-8CB) SIMATIC VS 100, 10 m

o Documentation package (6GF7 031-1BA) SIMATIC VS 130-2 containing
manuals/commissioning CD and installation instructions

Here, you must also provide suitable illumination, a lighting cable and
alens.

6GF1 130-3BC01

SIMATIC VS 130-2 with high-resolution sensor: Basic package for acquisition of
codes, comprising:

e Sensor head (6GF2 002-8GB) in P40 for variable image field size for C/CS-
mount lenses prepared for lens protective housing IP65

e Sensor cable (6GF9 002-8CF) for sensor heads SIMATIC VS 100, 10m long,
connectors at both ends, capable of trailing + ferrite ring (ASE00159706)

e Processing unit (6GF1 018-3BA) SIMATIC VS 130-2 in IP40
o Power supply cable (6GF9 002-8CA) SIMATIC VS 100, 10 m long
e Digital communication patch cord (6GF9 002-8CB) SIMATIC VS 100, 10 m

e Documentation package (6GF7 031-1BA) SIMATIC VS 130-2 containing
manuals/commissioning CD and installation instructions

Here, you must also provide suitable illumination, a lighting cable and
alens.

6GF1 130-3BB 02

SIMATIC VS 130-2vcr: Basic package for acquisition of Vericodes, comprising:

e Sensor head (6GF2 002-8CB) in IP40 for variable image field size for C/CS-
mount lenses prepared for lens protective housing IP65

e Sensor cable (6GF9 002-8CF) for sensor heads SIMATIC VS 100, 10 m long,
connectors at both ends, capable of trailing + ferrite ring (ASE00159706)

e Processing unit (6GF1 018-3BA 01) SIMATIC VS 130-2vcr in IP40
o Power supply cable (6GF9 002-8CA) SIMATIC VS 100, 10 m long
e Digital communication patch cord (6GF9 002-8CB) SIMATIC VS 100, 10 m

e Documentation package (6GF7 031-1BA 01) SIMATIC VS 130-2vcr
containing manuals/commissioning CD and installation instructions

Here, you must also provide suitable illumination, a lighting cable and a lens.
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Components, Accessories

Order No.:

Description

6GF7 031-1BA

Documentation package SIMATIC VS 130-2, containing manuals/commissioning
CD and installation instructions (included in full and basic package)

6GF7 031-1BA01

Documentation package SIMATIC VS 130-2vcr, containing manuals/commissioning
CD and installation instructions (included in full and basic package)

6GF9 002-8CF

Sensor cable for sensor heads VS 100, 10 m long, connectors at both ends,
capable of trailing

6GF9 002-8CG

Lighting cable for SIMATIC VS 100, 10 m long, connectors at both ends, capable of
trailing

6XV1 850-2HH20

6XV1 850-2GH20
6XV1 850-2GH60
6XV1 850-2GN10

Ethernet cable

Digital communication cable ETHERNET RJ-45 x RJ-45 (send and
receive lines crossed over), 2 m long

Digital communication cable ETHERNET RJ-45 = RJ-45, 2 m long

Digital communication cable ETHERNET RJ-45 = RJ-45, 6 m long

Digital communication cable ETHERNET RJ-45 = RJ-45, 10 m long

6GF9 004-8BA01

Lighting unit, near-field ring light, red, diffuser, 70 mm..1000 mm

6GF9 004-7AA01

Lighting unit, near-field ring light, infrared in IP65, diffuser, 70 mm..1250 mm

6GF9 004-8CA01

Lighting unit, near-field ring light, red, clear view, 150 mm..2000 mm

6GF9 004-8DA01

Lighting unit, far-field ring light, red, clear view, 500 mm..3000 mm

6GF9004-7BA01

Lighting unit, far-field ring light, infrared, clear view, 500 mm..3000 mm

6GF9002-7AB

Ring light bracket coaxial, solid, long

6GF9002-7AB01

Ring light bracket coaxial, single, short

6GF9002-7AC

Sensor head/ring light bracket, solid

6GF9002-7AD

Sensor head holder, triple-angle plate

6GF9 002-7AA01

Lens protective housing in IP65, suitable for sensor head 6GF2 002-8CB with front
disc of PMMA

6GF9 002-9AA

Lens protective housing in IP65, suitable for sensor head 6GF2 002-8CB with front
disc of glass

6GF9 002-7BA

Lamp Multiplexer

6GF9 002-7CA

Protective housing for processing unit in IP65

6GF9 002-7DA

Mounting rail adapter
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Appendix

8.2 Standards and Approvals

IEC 61131-2

SIMATIC VS 130-2/VS 130-2vcr meets the requirements and criteria of the
standard IEC 61131-2.

CE marking

SIMATIC VS 130-2/VS 130-2vcr meets the requirements and aims of the EU
directive listed below.

89/336/EEC "Electromagnetic Compatibility" (EMC Directive)

ce The EU conformity certificates are available for the relevant authorities and are
kept at the following address:

Siemens corporation

Automation and Drives

Factory Automation Sensors

P.O. Box 4848, D-90327 Nuremberg, Germany
http://www.siemens.com/fas

EMC Guidelines
SIMATIC VS 130-2/VS 130-2vcr is intended for use in an industrial environment.

Area of Application Requirements
Emitted interference Immunity to interference
Industry EN 61000-6-4 : 2001 EN 61000-6-2 : 2001

Marks for Australia and New Zealand

SIMATIC VS 130-2/VS 130-2vcr meets the requirements of the standard
AS/NZS 2064 (Class A).

Note the installation guidelines

SIMATIC VS 130-2/VS 130-2vcr is "enclosed equipment" complying with
IEC 61131-2".

The installation guidelines and safety notices specified in the documentation must
be adhered to during commissioning and operation.

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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8.3 Installation Dimensions

Processing Unit (control unit)
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759 170
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Parmitbed, stalic bending radius: 10 cable approx. RS0

Sensor Head
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Illumination Unit
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8.4

Interface Assignment of the Processing Unit

Power supply of "IN 24 V DC" (pin)

Connector Name Function Direction Wire Color
1 +24V 24 V power supply - red

2 +24V 24 V power supply - orange
3 M Ground - black

4 M Ground - brown
Interface to the Lighting Unit "LAMP" (socket)

Connector Name Function Direction
1 +16V 16.5 V power supply -

2 LIGHT Pulse to start a light flash (24 V) Output

3 M Ground -

4 M Ground -
Interface to Sensor Head "SENSOR" (socket)

Connector Name Function Direction
Casing Screening -

9 M -

10 M -

14 +16V -

20 TxDP Image data + Input

21 TxDN Image data - Input

22 CLK P Image synchronization + Output
23 CLK_N Image synchronization - Output
24 RxD P Sensor parameter + Output
25 RxD_N Sensor parameter - Output
26 M -

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
A5E00475759-01
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I/0 interface "DI/DO" (socket)

Connector [Name Function Direction Wire Color

1 DISA Disable: Disable manual control panel input, code |Input black
selection and train via digital I/O, error
acknowledgement

2 SELO Select 0: Code selection: Bit 0 (only for DISA=1) Input brown

3 SELA1 Select 1: Code selection: Bit 1 / Train code (only Input green
when DISA=1)

4 SEL2 Select 2: Code selection: Bit 2 (only for DISA=1) Input orange

5 SEL3 Select 3: Code selection: Bit 3 (only for DISA=1) Input yellow

6 TRN Train: Train new code (only when DISA=1) Input red

7 TRG Trigger : An evaluation is started on the positive- Input blue
going edge

8 RES Reset: Reset error (only when DISA=1) Input violet

9 |N_OP In Operation: Output white-black

e 0 =error message is displayed.
e 1 =SIMATIC VS130-2/VS 130-2vcr functional,

no errors
10 TRD Trained: Output white-brown
e InRun:

0 = selected code has not been trained
1 = selected code has been trained

e InTraining (TRN=1)

0 = training active

1 = acknowledgment signal (RDY=0)

11 RDY Ready: Output white-green

e 0 =device startup or SIMATIC VS 130-
2/VS 130-2vcr in Stop

e 1 =SIMATIC VS 130-2/VS 130-2vcr in run

12 READ Evaluation result: Code was localized and decoded |Output white-orange
13 MATCH |Evaluation result: Code matches learned code Output white-yellow
14 N_OK In the "RUN" mode (evaluation): Code was not Output white-red
legible.
In the "STOP" mode: to 0
15 M Ground - gray

PROFIBUS DP Interface (socket)

Connector |Name Function

- Not used

M Chassis, non-floating

LTG B |Data line (1/0)

RTSAS |Turn on PLC transmitter (O)

GND Chassis, floating

P5V + 5V (fused) floating

24V Non-floating

LTG_A |Data line (1/O)

OO |N|O ||~ W [N (=

- Not used

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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Ethernet interface "ETHERNET" (socket)

Connector |[Name Function

1 TxD+ Send data +

2 TxD- Send data -

3 RxD+ Receive data +

4 - Not used

5 - Not used

6 RxD- Receive data -

7 - Not used

8 GND Chassis, non-floating

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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8.5

Calculating the C-mount Lens and the Size of the Field

of View for Data Matrix Codes at a Given Distance

The following table shows the suitable lens and the corresponding field of view for
the sensor head 6GF2 002-8CB (resolution 640 * 480) for a data matrix code of the
size 44 mm x 44 mm and a dot size of 1 mm.

Distance lens Lens Field of View
front edge —
object in m

MLFB Focal distance in Image width in Image height in

mm. Light intensity |mm mm

0,30 6GF9 001-1BLO1 12,1:1,4 91 68
0,40 6GF9 001-1BLO1 12,114 121 90
0,40 6GF9 001-1BFO01 16, 1:1,4 92 69
0,50 6GF9 001-1BFO01 16, 1:1,4 115 85
0,50 6GF9 001-1BGO1 25,114 72 54
0,60 6GF9 001-1BGO01 25,1:114 87 65
0,70 6GF9 001-1BGO01 25,1:114 101 75
0,80 6GF9 001-1BGO01 25,114 115 86
0,80 6GF9 001-1BHO1 35,1:1,6 85 63
0,90 6GF9 001-1BHO1 35, 1:1,6 95 71
1,00 6GF9 001-1BHO1 35,1:1,6 105 79
1,10 6GF9 001-1BHO1 35,1:1,6 116 86
1,20 6GF9 001-1BHO1 35,1:1,6 126 94
1,20 6GF9 001-1BJO1 50, 1:2,8 81 60
1,30 6GF9 001-1BJO1 50, 1:2,8 88 65
1,40 6GF9 001-1BJO1 50, 1:2,8 95 71
1,50 6GF9 001-1BJO1 50, 1:2,8 102 76
1,60 6GF9 001-1BJO1 50, 1:2,8 109 81
1,70 6GF9 001-1BJO1 50, 1:2,8 116 87
1,70 6GF9 001-1BKO1 75,1:2,8 79 59
1,80 6GF9 001-1BKO1 75,1:2,8 84 63
1,90 6GF9 001-1BKO1 75,1:2,8 89 66
2,00 6GF9 001-1BK01 75,1:2,8 94 70
2,10 6GF9 001-1BKO1 75,1:2,8 99 73
2,20 6GF9 001-1BKO1 75,1:2,8 103 77
2,30 6GF9 001-1BKO1 75,1:2,8 108 81
2,40 6GF9 001-1BK01 75,1:2,8 113 84
2,50 6GF9 001-1BK01 75,1:2,8 118 88
2,60 6GF9 001-1BKO1 75,1:2,8 122 91
2,60 6GF9 001-1BJ01 and |50 and extender 88 66

6GF9 001-1BV
2,70 6GF9 001-1BJ01 and |50 and extender 92 69

6GF9 001-1BV
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Distance lens Lens Field of View

front edge -

object in m

2,80 6GF9 001-1BJ01 and |50 and extender 96 71
6GF9 001-1BV

2,90 6GF9 001-1BJ01 and |50 and extender 99 74
6GF9 001-1BV

3,00 6GF9 001-1BJ01 and |50 and extender 103 77
6GF9 001-1BV

The following table shows the suitable lens and the corresponding field of view for
the sensor head 6GF2 002-8GB (resolution 1024 * 768) for a data matrix code of
the size 44 mm x 44 mm and a dot size of 1 mm.

Distance lens Lens Field of View
front edge -
object in m
MLFB Focal distance in Image width in Image height in
mm. Light intensity |mm mm
0,30 6GF9 001-1BLO1 12,1114 121 90
0,40 6GF9 001-1BLO1 12,1114 161 120
0,40 6GF9 001-1BF01 16, 1:1,4 123 91
0,50 6GF9 001-1BF01 16, 1:1,4 152 114
0,60 6GF9 001-1BF01 16, 1:1,4 182 136
0,60 6GF9 001-1BG01 25,114 115 86
0,70 6GF9 001-1BGO1 25,114 134 100
0,80 6GF9 001-1BGO1 25,114 153 115
0,90 6GF9 001-1BGO1 25,114 173 129
1,00 6GF9 001-1BGO1 25,114 192 143
0,90 6GF9 001-1BHO1 35,1:1,6 126 94
1,00 6GF9 001-1BHO1 35, 1:1,6 140 105
1,10 6GF9 001-1BHO1 35, 1:1,6 154 115
1,20 6GF9 001-1BHO1 35, 1:1,6 167 125
1,30 6GF9 001-1BHO1 35, 1:1,6 181 135
1,40 6GF9 001-1BHO1 35,1:1,6 194 145
1,30 6GF9 001-1BJO1 50, 1:2,8 117 87
1,40 6GF9 001-1BJO1 50, 1:2,8 126 94
1,50 6GF9 001-1BJO1 50, 1:2,8 136 101
1,60 6GF9 001-1BJO1 50, 1:2,8 145 108
1,70 6GF9 001-1BJO1 50, 1:2,8 155 116
1,80 6GF9 001-1BJO1 50, 1:2,8 164 123
1,90 6GF9 001-1BJO1 50, 1:2,8 174 130
2,00 6GF9 001-1BJO1 50, 1:2,8 183 137
1,80 6GF9 001-1BKO01 75,1:2,8 112 84
1,90 6GF9 001-1BKO01 75,1:2,8 118 88
2,00 6GF9 001-1BKO01 75,1:2,8 125 93
2,10 6GF9 001-1BKO1 75,1:2,8 131 98
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Distance lens Lens Field of View
front edge -

object in m

2,20 6GF9 001-1BK01 75,1:2,8 137 103
2,30 6GF9 001-1BK01 75,1:2,8 144 107
2,40 6GF9 001-1BKO01 75,1:2,8 150 112
2,50 6GF9 001-1BKO1 75,1:2,8 156 117
2,60 6GF9 001-1BKO1 75,1:2,8 163 122
2,70 6GF9 001-1BKO1 75,1:2,8 169 126
2,80 6GF9 001-1BKO1 75,1:2,8 175 131
2,90 6GF9 001-1BKO1 75,1:2,8 182 136
3,00 6GF9 001-1BKO1 75,1:2,8 188 141

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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8.6

8.6.1

Technical Specifications

Vision Sensor SIMATIC® VS 130-2/VS 130-2vcr

Illumination Unit

LED ring flash

e LEDs, wavelength 630 nm (red)
o Constructed as ring flash with flash duration of 20 us
e DIN EN 60825-1:1994+A11:1996+A2:2001

... 10 ms, diffuse

Casing Plastic
Dimensions (W x H x D) [102*102 * 26,5
in mm

Weight Approx. 0,13 kg
Rated voltage 16.5V

Degree of protection IP 65

Sensor Head

Image capture

CCD chip 4", 640 x 480 or1024x768 with sensor head 6GF2 002-8GB quadratic
pixels, full frame shutter

image data transfer

Triggered image capture

Casing Aluminium profile casing, anodized black
Dimensions (W x H x {42 x42 x 110

D) in mm

Weight Approx. 0,24 kg

Rated voltage

16.5V

Sensor head

Sensor head

Sensor head

Sensor head

Sensor head

for large code |for small code |for very small |for variable (for variable
areas areas code areas code areas |code areas
(6GF2 002- (6GF2 002- (6GF2 002- (C-ICS- high-
8DA01) 8EA01) 8FA01) mount) resolution
(6GF2 002- |(C-/CS-
8CB) mount)
(6GF2 002-
8GB)
Distance sensor front 100 mm 90 mm 75 mm Depending on | Depending on
edge — test piece lens lens
Screen resolution 640 * 480 640 * 480 640 * 480 640 * 480 1024 * 768
Image field 75 mm * 57 mm [ 45 mm * 34 mm |20 mm * 15 mm | depending on | depending on
lens lens

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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Sensor Head

dimension (rows *
columns)

Degree of protection IP 65 to IEC 60529 IP 40 to IEC 60529

CCD resolution 0,11 mm 0,06 mm 0,032 mm Image width / | Image width /
640 1024

Minimum dot size 0,6 mm 0,35 mm 0,16 mm Image width / | Image width /

(edge length) 120 200

Maximum dot size 3,5 mm 2mm 1 mm Image width / | Image width /

(edge length) 22 35

Minimum code 10 *10

dimension (rows *

columns)

Maximum code 48 *48 7272 Y

1)

distortion at the edges.

With large code dimensions such as 72*72, make sure that the lens used does not cause any

Processing unit

Operator controls

4-row text display and 6 control buttons

Training new codes

Codes are trained automatically at the push of a button

Number of storable codes

14 different codes, can be selected with setup support, buttons, or
digital inputs, non-volatile storage

Triggering tests

External (over digital input or over PROFIBUS or over PROFINET 10
or over Ethernet RS-232 converter or over PC/PG with TCP server)

Setup Software

PC software for displaying the sensor image during installation and
adjustment of the sensor head and illumination on supplied CD

Casing

Plastic, all cables can be plugged in, suitable for installation without
cubicle

Dimensions (W x H x D) in mm

170 x 140 x 76

Weight

Approx. 0,5 kg

Rated voltage

16.5V

Degree of protection

IP 40 to IEC 60529

Interfaces on the processing unit

Interface for load current supply

4-pin circular connector (male) for load current supply
e Cable length: 10 m (4 x 0.56 mm?)

e Rated input voltage: 24 V

e Rated input current: 2.2 A.

e Input voltage range: 20,4 ... 28.8 V

Illumination control

e 4-pin circular connector (female) for power supply and triggering
the flasher lamp

e Power consumption at 16.5 V: Max. 0.3 A
e Cable length: 2.5 m (4 x 0.23 mm?)

Sensor head interface

¢ Digital interface (26-pin D-sub female connector) for connecting
the SIMATIC VS 130-2/VS 130-2vcr sensor head

e  Power consumption at 16.5 V: Max. 0.16 A
e Cable length: 2.5 m (26 x 0.09 mm?)

Digital inputs for 24 V d.c.

e 8; one being a trigger input with interrupt capability for standard
binary sensors,

e 7 further PLC-compliant control inputs
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Processing unit

Digital outputs for 24 V d.c.

e 6; max. load 0.5 A each, however in total a maximum of 1.5 A
(15-pin D-sub female for inputs/outputs)

e Cable length: 10 m (15 x 0.14 mm?)

DP interface

9-pin D-sub socket; programmable;

e Isolated: Data lines A, B; control lines RTS; 5-V power supply
(max. 90 mA)

e Grounded Shield of the DP12 connecting cable; RS 485; floating
¢ Non-floating 24 V/150 mA

Ethernet interface

8-pin RJ-45 jack, 10/100 Mbps

Limit data for evaluation of parts with data matrix code and Vericode

Permitted part rates Depends on the dot size and code dimensions, however maximum 20/s

Vision Sensor SIMATIC VS 130-2/VS 130-2vcr
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8.6.2

General Specifications

Power supply

Supply voltage (UN)

Input voltage protected against polarity

DC24 V; (DC20.4...DC28.8 V, safety extra-low voltage
SELV). SIMATIC VS 130-2/VS 130-2vcr does not have
integrated protection against surge in the us range (surge
pulse). For external measures, see EMC.

Yes

reversal
Power down (bridgeable)

>20ms

Current consumption (IN)

inputs/outputs)

Typical: | =2 A (maximum load of 1.5 A over the digital

Fuse

Max. 10 A

Making current

11 max. 10 A; <1 ms

Safety requirements complying with

IEC 61131-2 corresponds to DIN EN 61131-2

Electromagnetic compatibility (EMC)

Pulse-shaped interference

complying with IEC 61000-4-4

e 2KV (signal line)

Interference Test voltage Corr. to severity
Electrostatic discharge according |e  Air discharge: 8 kV 3
to IEC 61000-4-2 e Contact discharge: +6 kV
Burst pulse (fast transients) e 2 kV (power supply cable) 3

Surge complying with IEC 61000-4-5

with protective elements

Coupling Test voltage Corr. to severity
Asymmetrical 2 kV (power supply cable) direct voltage 3
with protective elements
Symmetrical 1 kV (power supply cable) direct voltage 3

Sine-shaped disturbance

Radio frequency
electromagnetic fields

Test values

Corr. to severity

MHz

complying with IEC 61000-4-3 10 V/m at 80 % amplitude modulation of 1 3
kHz in the range from 80 MHz to 1000
MHz

complying with IEC 61000-4-3 10 V/m at 50 % pulse modulation at 900 3

RF interference on cable/cable
shields

Test values

Corr. to severity

complying with IEC 61000-4-6

Test voltage 10 V at 80 % amplitude
modulation of 1 kHz in the range from 9
kHz to 80 MHz

Emitted interference

Limit class

o Emitted interference of electromagnetic fields in accordance

with EN §5011: Limit class A, group 1

o Emitted interference via the AC input power supply in
accordance with EN 55011: Limit class A, group 1

e Sensor head and lighting system compliant with limits to

EN 55022 Class B
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Transport and Storage of Modules

In terms of shipping and storage conditions, the SIMATIC VS 130-2/VS 130-2vcr exceeds the
requirements of IEC 61131-2. The following information applies to modules shipped or stored in their
original packing.

The climatic conditions correspond to IEC 60721-3-3, Class 3K7 for storage and IEC 60721-3-2,
Class 2K4 for transport.

The mechanical conditions correspond to IEC 60721-3-2, Class 2M2.

Conditions Permitted Range

Free fall <1 m (up to 10 kg)

Temperature -30°Cto+70°C

Atmospheric pressure 1080 to 660 hPa (corresponds to a height of -1000 to 3500 m)
Relative humidity (at +25 °C) 5 to 95 %, no condensation

Sine-shaped oscillations complying |5 -9 Hz: 3,5 mm

with IEC 60068-2-6 9 -500 Hz: 9,8 m/s2

Shock complying with 250 m/s?, 6 ms, 1000 shocks

IEC 60068-2-29

Mechanical Environmental Conditions for Operation

SIMATIC VS 130-2/VS 130-2vcr is intended for stationary use in weather-protected locations.
SIMATIC VS 130-2/VS 130-2vcr complies with the conditions for use according to DIN IEC 60721-3-3:

e Class 3M3 (mechanical requirements)
e Class 3K3 (climatic environmental conditions)

Mechanical environmental conditions, sine-shaped oscillations

Frequency range in Hz Test values
10<f<58 0,075 mm amplitude
58 <f< 500 1 g constant acceleration

Test for mechanical environmental conditions

Test for / Test standard Remarks

Oscillations e Type of vibration: Frequency cycles with a rate of change of 1
Oscillation test complying with octave/minute.

IEC 60068-2-6 (sine) 10 Hz < f < 58 Hz, constant amplitude 0.075 mm

58 Hz < f < 500 Hz, constant acceleration 1 g
10 Hz < f < 55 Hz, amplitude 1 mm (only sensor head and lighting unit)

e Duration of vibration: 10 frequency cycles per axis in each of the 3
perpendicular axes

Test for / Test standard Remarks

Shock Shock test e  Type of shock: half sine
complying with 14 strength of the shock:
IEC 60068-2-29 Processing unit 10 g peak value / 16 ms duration

Sensor head, illumination: 10 g peak value / 16 ms duration

o Direction of shock: 100 shocks in each of the 3 perpendicular axes

Shock test Sensor head, illumination:

complying with |, 70 g peak value / 6 ms duration 3 times in each direction
IEC 60068-2-27

30 g peak value / 11 ms duration 3 times in each direction

Ambient climatic conditions for operation
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Ambient climatic conditions for operation

Environmental Conditions |Permitted Range Comments
Temperature 0 to +50 °C
Temperature change Max. 10 °C/h

Relative atmospheric humidity

Max. 95 % at +25 °C

No condensation, corresponds to
relative humidity degree 2 to IEC
61131-2

Atmospheric pressure

1080 to 795 hPa (corresponds to a
height of

-1000 to 2000 m)

Contaminant concentration

S02: < 0.5 ppm;
RH < 60 %, no condensation

e H2S:<0.1ppm;

RH < 60 %, no condensation

e Test: 10 ppm; 4 days
e Test: 1 ppm; 4 days

Note

The mechanical and climatic environmental conditions for operation specified
above apply only to the sensor heads with order numbers 6GF2 002-8DA01,
6GF2 002-8EA01 and 6GF2 002-8FA01.
For the sensor heads with order numbers 6GF2 002-8CB and 6GF2 002-8GB, the
mechanical and climatic environmental conditions depend on the lens used.

Test voltag_;es to IEC 61131-2

and to ground

Circuits with rated voltage Uin between circuits

Test voltage

0V<Ue<b0V 350 V
50V <Uin<100V 700V
100V <Ue<150V 1300 V
150 V < Uin <300 V 2200V
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8.6.3

Interface Digital Inputs/Outputs

Module-Specific Data

Number of inputs 8
Number of outputs 6

Cable length, unshielded 10m
Voltage, Currents, Potentials

Rated voltage load current supply L+ 24V DC

Permitted rated voltage load current supply L+

204Vito28.8V

Current consumption L+

Dependent on configuration

Number of simultaneously controllable inputs 8

Number of simultaneously controllable outputs 6

Total current of the outputs Max. 1.5 A with max. 0.5 A/output
Electrical isolation No

Data for Selecting a Sensor

Input voltage

¢ Rated value 24V DC

e For signal "1" From 13 to 30 V
e Forsignal "0" -30Vto+5V
Input current

e with "1" signal Typically 7 mA

Input signal characteristics

"Trigger" input to IEC61131-2 type 2
Other inputs; IEC61131-2 type 1

Connection of two-wire BERO Max. 1.5 mA
Data for Selecting an Actuator

Output voltage

e with "1" signal Min. L+ (-1.3 V)

Output current
e with "1" signal

e with "0" signal

Rated value: 0.5 A.
Permissible range: 5 mAto 0,5 A
Residual current: max. 0.5 mA

Off delay (with resistive load)

e from"0"to"1" max. 100 ps

Load resistor max. 48 Q to 4 KQ
Lamp load max. 5 W

Parallel wiring of 2 outputs No

Operating frequency:

e  With resistive load Max. 100 Hz

e  With inductive load to IEC 947-5-1, DC 13 Max. 0.5 Hzat0.5 A
e With lamp load Max. 10 Hz

Limit on inductive cutoff voltage Typically L+ (-53 V)
Short-circuit protection of the output Solid-state

e Operating threshold Typically 1A
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Accessories | 8-5

Adjust Sensor | 5-31

Adjustment of the sensor |4-5

Applications | 1-6

Approvals | 8-6

Assignments for PROFIBUS DP and PROFINET
I/O-relevant interfaces for the Processing Unit
6-12

Cc

CE mark  8-6

Commissioning | 4-1

Components | 1-4

Components of the product |8-1

Connection between PDA and processing unit
5-49

Connections | 5-34

Control over I/O interface |6-6

Control over PROFIBUS DP | 6-11

Control over PROFINET 10 |6-11

Control panel |4-3

D

Diagnostics | 7-1, 7-13, 7-16
by messages | 7-1
in PROFIBUS DP | 7-13
in PROFIBUS 10 7-15

DISA | 6-6,8-10

Display field 14-3

DP slave | 6-2

E

EMC guideline |8-6

Environmental conditions ' 8-19,|8-20
climatic conditions | 8-19, 8-20

Error messages | 7-2

Ethernet interface | 8-11

Evaluating | 5-39
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FB 79| 6-19
Error information | 6-22, 6-31
Parameter 6-19/|6-21, 6-23,|6-24, 6-25,|6-26,
6-27,|6-28,|6-29, 6-30
Field of View| 8-12,|8-13

G

Guidelines | 3-5
Guidelines for Installing PROFIBUS DP or
PROFINET /O |3-5

I/0 8-10

I/O device |6-4

IEC 61131-2 |8-6

Image data transfer | 8-15

Image field| 8-15

IN DC 24V |8-9

IN_OP 6-6, 7-2, 8-10

Info| 5-44

Input signals | 6-6

installation | 1-6

Installation | 3-1

Installation dimensions |8-7

Installation guidelines | 3-5

Installation guidelines for preventing electrical
interference | 3-5

Integrating the DP slave VS130-2 in HW Config
6-2

Integrating the PROFINET IO Device VS130-2 in
HW Config 6-4

Interface assignment of the processing unit |8-9

Interface Digital Inputs/Outputs | 8-21

10 device diagnostics | 7-12
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Known PDA problems | 5-54
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LAMP | 8-9
Lamp Multiplexer | 1-9, 1-10
LEDs | 4-3, 6-6

Maintain| 5-48

MATCH | 6-6, 8-10

Menu level | 5-2, 5-4
ADJUST | 5-1, 54, 5-15
CONNECT| 54, 5-5, 5-9, 5-12
STOP| 51, 5-2, 5-4

Menu level run |5-1

Mixed operation | 2-6

N
N_OK 6-6,8-10

(o)

Operating over the processing unit |5-1
Operating using the setup support |5-26
Operator control | 5-1
Options | 5-40
Order numbers | 8-1
Output | 2-6
over Ethernet 2-2,2-6
over PROFIBUS DP |2-4
over RS-232 |2-3
Output over PROFINET 2-5
Output signals |6-6

P

PDA| 5-49

prerequisites | 5-49
Process interfacing | 6-1
Processing arrangement | 1-5
PROFIBUS DP | 8-10

interfce | 8-9
Programmable controller |6-1,/6-2
Programming the Data Block | 6-17
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RDY| 6-6, 8-10
READ  6-6, 8-10
Reading Out the Diagnostic Information with S7
7-12
Requirements| 1-11,1-15//1-16,|1-17,/1-18
for PDF417 codes| 1-17,1-18
for QR codes| 1-15,1-16
of data matrix codes| 1-13,/1-14
RES 6-6, 8-10

S

Sample program| 6-32, 6-33,|6-34

archiving diagnostic information on PC/PG 6-
34

outputting on PC/PG | 6-33
SIMATIC interfacing | 6-32

Sample program for interfacing the
VS130-2 to a SIMATIC controller with the aid
of FB79 | 6-32

SELO 6-6,8-10

SEL1 6-6,8-10

SEL2 6-6,8-10

SEL3 6-6,8-10

Select code  6-7, 6-8

Select modes | 6-7

Sensor | 8-9

Setting numeric values |4-3

Setup support | 4-5, 5-26,|5-28

Slave diagnostics | 7-12

Stand-alone mode |2-2, 2-3

Standards | 8-6

Start evaluation | 6-7

Starting setup support
starting| 5-28

Starting setup support from the PDA | 5-50

Steps in installation | 3-1

Stop| 5-48

System Integration |2-1
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Train| 5-37

Train code 6-7, 6-9

TRD| 6-6, 8-10

TRG 6-6, 8-10

Triggering | 1-5

TRN| 6-6, 8-10

Turning on the Device 4-1
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User interface | 5-29, 5-30
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VS130-2_CONTROL | 6-19
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Wiring | 3-3
Wiring components | 3-3
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